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Software License Agreement

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY. IF YOU DOWNLOAD THE SOFTWARE, BREAK THE SEAL OF ANY PACKAGING OF THE
SOFTWARE, OR INSTALL ANY COMPONENT OF THE SOFTWARE, YOU THEREBY AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.

This Mulligan Software (“Mulligan”) Software License Agreement accompanies the Mulligan’s Eagle™ product and associated files, documentation and
other materials (together or individually “Software”). The term “Software” also shall include any upgrades, modified versions or updates of the Software
licensed to you by Mulligan.

1. License — The Software is licensed, not sold, to you by Mulligan for use under the terms of this Agreement. Mulligan grants you a nonexclusive, nontrans-
ferable license to install one copy of the Software onto one computer, and you may copy the software into any machine-readable or printed form for backup
purposes supporting your use of the Software on that single computer. If purchased from Apple on the Mac App Store, you may use the Software on any
capable computer authorized under a single Apple ID.

2. Restrictions — You may NOT distribute copies of the Software to others or electronically transfer the Software from one computer to another by any
means under any circumstances. The Software is owned by Mulligan and contains valuable trade secrets of Mulligan. To protect them you may NOT
decompile, reverse engineer, disassemble, or otherwise reduce the Software to a human perceivable form. YOU MAY NOT MODIFY, ADAPT, TRANSLATE,
RENT, LEASE, LOAN, RESELL, DISTRIBUTE, NETWORK, OR CREATE DERIVATIVE WORKS BASED UPON THE SOFTWARE OR ANY PART
THEREOF.

3. Termination — This License is effective until terminated. This License will terminate immediately without notice from Mulligan if you fail to comply with any
of its provisions or you may terminate this License at any time. Upon termination you must destroy the Software and all copies thereof.

4. Export Law Assurances — As required by United States export regulations, you shall not permit export of the Software or any direct products thereof to
any country to which export is controlled by the United States Office of Export Administration, unless you have that agency’s prior written approval.

5. Warranty Disclaimer, Limitation of Remedies and Damages — The Software is being delivered to you AS IS and Mulligan makes no warranty as to its
use or performance. MULLIGAN MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTY
OF MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL MULLIGAN SOFTWARE OR ITS OFFICERS OR
EMPLOYEES BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF, OR
INABILITY TO USE, SOFTWARE OR ANY ACCOMPANYING WRITTEN MATERIALS, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
Because some states do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you.
MULLIGAN SOFTWARE'S LIABILITY TO YOU FOR ACTUAL DAMAGES FOR ANY CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF
THE ACTION, WILL BE LIMITED TO THE PURCHASE PRICE OF THE SOFTWARE.

6. Copyright — The Software, accompanying written materials, product design, and design concepts are copyrighted, with all rights reserved to Mulligan.
Your rights are subject to the limitations and restrictions imposed by the copyright laws of the United States of America. Note that you may not use, copy,
modify, or transfer the Software or accompanying written materials or any copy, except as expressly provided by this License. The preceding is not an inclu-
sive statement of the restrictions imposed on you under the Copyright Act. For a complete statement of the restrictions imposed on you under the copyright
laws of the United States of America see Title 17, United States Code.

7. Trademarks — Mulligan Software and Mulligan’s Eagle are trademarks of Mulligan. You may use trademarks of Mulligan only insofar as required to com-
ply with this Agreement and to identify printed output produced by the Software, in accordance with accepted trademark practice, including identification

of trademark owner’s name. The Software and documentation may refer to trademarks and service marks of third parties. Those trademarks and service
marks are credited to their owners here, in the Software and in associated documentation. Use of any trademark does not give you or Mulligan any rights of
ownership in that trademark. This Agreement does not grant you any intellectual property rights in the Software. In the event that the Software or your pos-
session and use of the Software infringes the rights of a third party, Mulligan is solely responsible for the investigation, defense, settlement and discharge of
any such claim.

8. Apple — You and Mulligan acknowledge that this Agreement is concluded only between you and Mulligan; that Mulligan is solely responsible for the
Software and any support, maintenance, warranty and resolution of product claims; that, if purchased from the Mac App Store, Apple Inc. (“Apple”) and its
subsidiaries are third party beneficiaries of this Agreement, and upon acceptance of its terms and conditions, Apple will have the right (and will be deemed to
have accepted the right) to enforce this Agreement as a beneficiary thereof. Apple, iTunes and Mac App Store are trademarks and service marks of Apple.

9. Golf Authorities — The United States Golf Association (‘USGA”), the Royal Canadian Golf Association (“RCGA”) in association with Golf Canada, Golf
Australia, the European Golf Association (‘EGA”), the Congress of National Golf Unions (“CONGU”) and The R&A are the major authorities governing the
sport of golf around the world. Each of these authorities or their authorized clubs and associations provide personal, portable golf handicap ratings to their
members which must, by a published algorithm, be adjusted for play and scorekeeping on golf courses of varying difficulty. The Software may retrieve,
calculate or use that adjustment. It does NOT calculate a personal handicap rating, which a player receives from their authorized golf club or associa-

tion. The terms “Course Handicap”, “Course Rating”, “Handicap Index”, “Slope Rating”, “Bogey Rating”, “Score Differential”, “World Handicap System” and
“WHS” are trademarks or service marks of the USGA and The R&A. “Handicap Factor” is a trademark of the RCGA. “CONGU Handicap” is a trademark
of CONGU. “EGA Handicap” is a trademark of the EGA. “GA Handicap” is a trademark of Golf Australia. Other terms like “Exact Handicap” or “Playing
Handicap” may be marks of these and other golf authorities. To the extent necessary for licensed users to comply with the requirements of their golf author-
ity, the Software may present trademarks and service marks appropriate for calculation, presentation and identification of data derived from published
algorithms. All such marks are identified and remain the property of their owners.

10. Governing Law and General Provisions — This Agreement will be governed by the laws of the State of Texas, U.S.A., excluding the application of

its conflicts of law rules. If any part of this Agreement is found void and unenforceable, it will not affect the validity of the balance of the Agreement, which
shall remain valid and enforceable according to its terms. If you are a U.S. Government end-user, this license of the Software conveys only “RESTRICTED
RIGHTS,” and its use, disclosure and duplication are subject to Federal Acquisition Regulations, 52.277-7013. You acknowledge that you have read this
Agreement, understand it and agree to be bound by its terms and conditions. You further agree that it is the complete and exclusive statement of the agree-
ment between us.

All rights reserved under the copyright laws of the United States
Mulligan Software, Bullard, TX 75757
support@mulligansoftware.com
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Chapter 1

Getting Started

'This chapter will help you get started with information on installing, regis-
tering, and configuring Mulligan’s Eagle for use on your Mac.

In this Chapter...
Introduction
What’s Mulligan’s Eagle?. . .......... . ... o o o L 2
Using thisGuide ......... ... .o i i 2
Installing Mulligan’s Eagle
System Requirements. . ......... ... ... . 2
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Scoring. ... 13
APPEATANCE . vttt et 14
Other. ..o 16
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2 Introduction

Mac

# Available on the
¢ App Store

Introduction

What's Mulligan’s Eagle?

Mulligan’s Eagle is the premier golf stats, scorekeeping and handicapping
application for the Mac. Developed exclusively on the Mac, for the Mac, it
is the latest software from Mulligan Software, the pre-eminent developers of
software for golfers since 1995.

You can record, report and analyze information about rounds played by one
or hundreds of golfers playing one or hundreds of golf courses. You can plan,
administer and score golf events for your foursome, your team or your club.
There is no more capable software for golfers on any computer.

Using this Guide

Each of the chapters of this Users’ Guide addresses a particular category of
instruction and information, approximately in the order youll use it, but
Mulligan’s Eagle is a big application and this guide isn't fireside reading. You'll
probably need to refer to the Contents at the front or the Index at the back
to get help about some detail of Eagle’s operation. If you use this guide fre-
quently, we encourage you to download the full Eagle Users Guide.pdf file
from Mulligan Software’s web site to your hard drive to improve speed and
to provide you with high-quality output if you decide to print a page or two.

Like the software, if you find (or can’t find) something in the Users’ Guide
that needs correction or clarification, send your comments, suggestions or
complaints to: support@mulligansoftware.com.

Installing Mulligan’s Eagle

System Requirements

Mulligan’s Eagle requires a Mac running macOS version 10.12 (“Sierra”) or
later on a 64-bit capable Intel-based processor. It works best when you are
using Apple’s latest version of the macOS operating system. It requires
about 20 mb of disk storage for the application and at least that much for
data storage.

Earlier releases of Mulligan’s Eagle are available from Mulligan Software’s
website https://www.mulligansoftware.com for older Macs that can’t sup-
port the required operating system.

Installing from the Mac App Store

If you purchased your copy of Mulligan’s Eagle from the Mac App Store
using App Store software on your Mac, no serial number or registration is
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required to use your software. The first time you use the software, continue

as described at “Your First Club” on page 7.

Installing from a CD

If you received your copy of Mulligan’s Eagle on a CD, just insert the CD
into your Mac or an attached CD drive. When the CD is mounted (appears
on your desktop), double-click to open it.

Installing from a Disk Image
You may have downloaded your copy of Mulligan’s Eagle during your

purchase on the internet, or you downloaded the software to try in demon-
stration mode. The file that you downloaded is a disk image file (with a .dmg
extension). By opening the file, its contents are “mounted” on your desktop
just like an attached disk, or an installation CD.

If the file you downloaded has a .zip extension, it’s a compressed version of
the disk image file you need. Just double-click it to de-compress it into its
.dmg form, then double-click sa# to mount it on your desktop. You can
throw the .zip file in the trash after expanding it. Keep the .dmg file for
backup.

When you open the disk or CD that’s on your desktop, you'll see a window
like this:

( XN [7| Mulligan's Eagle™

Installing

Mulligan’s Eagle™

1 ]2]3]4

afafa] at the left onto the
9 (13| 7 15 -

380/200| 37339 |5 Drag the Eagle icon
1

Applications folder
to the right.

Eagle Applications

Installation CD or Disk Image Window
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Startup

Install the software on your computer by dragging the Eagle icon (at the
left) onto the Applications folder alias (at the right) in this window. Your
Mac will copy the Mulligan’s Eagle application into the Applications folder
on your hard drive. If you have an older copy of Eagle in your Applications
folder, you'll be asked if you want to replace it.

Note: 'This procedure for installing from a disk image is exactly the same procedure
you will follow if you later update your software to a newer version.

'The disk image or CD contains other data that may be of interest, including
this Users’ Guide and release notes with any last minute information about
installation. Scroll the window down to see the rest of the contents.

Startup

You start Mulligan’s Eagle by double-clicking its icon in the Applications
folder, clicking the Eagle icon in Launchpad, or clicking the Eagle icon if
you've placed it in the dock. (To place Mulligan’s Eagle in the dock, use the
Finder to locate its icon in your Applications folder, then drag that icon onto

the dock.)
If you purchased your copy of Mulligan’s Eagle from the Mac App Store

using App Store software on your Mac, no serial number or registration is
required to use your software. The first time you start the application, begin

as described at “Your First Club” on page 7.

Initial Registration

When you first start Eagle after installing it, you'll see a dialog for you to
register the software:

Registration

Licensed Owner: | Sandy McFiddish

Serial Number: DEMO

£5) Anunlicensed copy of this application will operate for 30
/ days in "demo” or evaluation mode.

Cancel

Owner Registration
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Make sure the name shown is the name of the registered owner of the soft-
ware license. If you have a software serial number, enter it. Click OK to
proceed.

If you are using the software in demonstration mode, make sure the Serial
Number is entered as “DEMO?, then click OK to proceed.
Demonstration Mode

Any time that you start Mulligan’s Eagle in demonstration mode, you will
see the Demonstration dialog:

Thank You

Mulligan’s Eagle

This software is available in demonstration mode so you can try Eagle
before purchasing it.

During the evaluation period, Eagle is fully functional. After the evaluation
period, you will need to purchase Eagle or provide a serial number to
continue using the software. This evaluation period has 30 days
remaining.

To purchase Eagle from the Mac App Store, click the “Purchase” button. If
you have a serial number for this version of Eagle, click the “Enter” button.
Otherwise, click “Continue” to use Mulligan’s Eagle in demonstration
mode.

Enter Purchase

Demonstration Mode

If you have a serial number for the software, click Enter to provide that
number. To purchase a serial number for the software, click the Purchase
button. Once a serial number has been provided, you will no longer see the
Demonstration dialog when starting up. If you wish to continue using the
software in demonstration mode, click the Continue button. If the demon-
stration period has expired, you may enter a serial number or purchase the
software, but you may not continue using the software - the Continue button
now says Quit.

Note: If you have entered data while in demonstration mode and the demonstra-
tion period expires, your data will again be accessible if you subsequently activate
the software by providing a serial number or purchasing Eagle from the Mac App
Store.

Note: If your initial 30-day trial has recently expired, you can re-enable the trial
Jfor an additional 30 days (twice) by holding down the OPTION key while clicking
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the Quit or Continue button. The next time you start Eagle, your trial will be
extended.

Purchasing

If you decide to purchase Mulligan’s Eagle, you will be directed to a secure
Apple web page with the option to open the App Store application on your
Mac to continue. From the App Store application, you can purchase the
software, download and install it on your Mac. You will receive notification
of future software updates to Eagle in the App Store application. When
delivered by Apple, Mulligan’s Eagle software is cryptographically “signed”

and “sandboxed” on your Mac. No serial number is required.

Software License Agreement

To make Eagle ready for use, you must indicate your agreement with the
Software License Agreement that accompanies the software:

Software License Agreement

Mulligan’s Eagle

Software License Agreement

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY. IF YOU
DOWNLOAD THE SOFTWARE, BREAK THE SEAL OF ANY PACKAGING OF THE
SOFTWARE, OR INSTALL ANY COMPONENT OF THE SOFTWARE, YOU THEREBY AGREE
TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.

This Mulligan Software (“Mulligan”) Software License Agreement accompanies the Mulligan’s
Eagle™ product and associated files, documentation and other materials (together or
individually “Software”). The term “Software” also shall include any upgrades, modified
versions or updates of the Software licensed to you by Mulligan.

1. License - The Software is licensed, not sold, to you by Mulligan for use under the terms of
I've read, understood, and agree to the terms of this Software License.

\“

Software License Agreement

After reading the terms of the Software License Agreement, if you agree
with its terms, click the check-box in the window, then click the OK button
to continue.
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Your First Club

When you first use the application, with no data on file, it’s convenient to
begin by setting up your first club - the one you play regularly. Eagle gets
you started by displaying a dialog:

Cetting Started

How would you like to get started?

A
@ “’ Set up a golf club and call it: |bu5hwogd Country Club
starting information that you can edit to describe your own course

i ’ Import club information from Mulligan Software *

via the internet from Mulligan Software’s archives

O Install Samples
) \ deletable data to familiarize yourself with Mulligan's Eagle™
—

|®| * always available in the File / Import menu | None of These | [-’—OE—}
Your First Club

To start with a single club, choose the “Set up a golf club and call it:”
option, type the name of your golf club, then click OK. You'll be able to
edit the temporary placeholder information that’s provided until the club
data represents the course, nines, tees and holes on your home course. See
“Editing Club Information” on page 26.

If youd like to start with data about one or more clubs imported via the
internet from archives kept by Mulligan Software, select that option and
click OK. You'll be able to import clubs as described on page 38. You
must be connected to the internet to use this feature.

Or, select the “Install Samples” item to install illustrative clubs, players,
scorecards and events that you can review to become familiar with Eagle and
how things are built. When you’re ready, you can delete these temporary
items.

Or, if you decide you'll set up your first golf club and players using the regu-
lar features of the software, just click None of These to proceed.
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The Main Window
Any time you start Eagle, you see the application’s main window or browser:
[ NN ) Mulligan's Eagle™
A [ ; =
R T—
Clubs Players Scorecards Events Search Print
Player - Home Club Index
r‘ Doctor Beeper Bushwood Country Clulp 8.4
’ Al Czervik Bushwood Country Clulb 15.0
E Mary Czervik Bushwood Country Clulp 255
a Earl Havercamp Bushwood Country Clul 12.4
E Frieda Havercamp Bushwood Country Clul 179
a Maggie O'Hocligan
» Chuck Schick
E Agnes Smails Bushwood Country Clul 3338
» Judge Elihu Smails Bushwood Country Clul 1386
a Carl Spackler
E Lacy Underall Bushwood Country Clul 11.0N
a Ty Webb Bushwood Country Clul +2.2
12 of 57 players
& |+ / = [ <[>
Eagle’s Main Window
'The window includes a toolbar that lets you select whether you want to see
the list of golf clubs, players, scorecards or events that are available on your
Mac. You can also move from list to list by clicking the directional buttons,
or by choosing Previous or Next from the Window menu or by typing $8 ¢
(COMMAND-LEFT-ARROW) or $-> (COMMAND-RIGHT-ARROW). Closing the
main window closes any other application windows and quits the appli-
cation. The last list displayed and the last location for the window on the
screen are restored next time the application is started.
Like any Mac application, you can close the main window when it is front-
most by clicking its close button, choosing Close from the File menu or
typing W (COMMAND-W).
You can also quit Mulligan’s Eagle at any time by choosing Quit Eagle from
the Eagle menu or typing 3$Q (COMMAND-Q).
Saving Data
Mulligan’s Eagle keeps all of its data about golf clubs and players in database
— files located on your computer. There are no individual files that you need to
S Y p y
V= e keep track of. The database files, kept in a folder in your user directory at

~/Library/Application Support/Eagle/, contain all the information that the
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software knows about. The entire Eagle folder should be included in your
regular periodic backup to make sure you don't lose your work. These
database files are unique to Eagle. They have .EAGD extensions.

Note: When Eagle is purchased from the Mac App Store, the data managed by
the application is kept in a private and secure sandbox” on your Mac inaccessible
to other users or applications. Should you need direct access to Eagle’s stored data,
contact Mulligan Software for assistance.

Because there are no individual files or “documents,” data is changed in the
application’s database when you close the editing window for the data. No
“Save” action required. So, when you close a player window, for example,
with limited or incomplete information, there is a player on file represented
by the data in that window. To delete inadvertently created clubs, players,
scorecards or events, simply select and delete them from the main window.
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Preferences

Preferences

You can control certain preferred settings used in Mulligan’s Eagle’s oper-
ation. You can open a dialog to adjust those preferences by choosing
Preferences... from the Eagle menu or by typing 38, (coMMAND-comma).

Click the window’s toolbar items to select a panel. You can reset some of the
application’s preferences by clicking the Factory Settings button. Close the
Preferences dialog by clicking OK at the bottom right of the window.

Authorization

Settings for handling your product licensing and serial number, certification
for handicapping, and protection of data are set in the Authorization panel:

Preferences

=/ @ 1 o 43

Authorization Scorecards Si:oring Appegrance Other Handicapping Advanced Remote

Licensed to Sandy McFiddish

Serial number: Edit...
Local Country: United States
Handicapping Certification: ~World Handicap System
Certify Changes?
Data Protection: Lock Players
Lock Clubs

Lock Scorecards
Lock Events

Factory Settings “

Preferences - Authorization
Licensed to — indicates the name of the software license holder.

Serial Number — when not purchased from the Mac App Store, displays the
product serial number (‘DEMO” in demonstration mode). Click the Edit...
button if you need to change either the licensee’s name or the serial number.

Local Country — If the country in which you're using this software is not
identified correctly, choose the proper country. This information may be used
for certain default handicapping and configuration calculations.
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Handicapping Certification — Mulligan’s Eagle requires, for certain types
of handicapping, that you provide an explicit acknowledgement that you are
authorized to compute official handicaps for members of a golf club or asso-
ciation. First, identify the handicapping system that you are authorized to
use from the popup menu, then click the Certify button to display a certifi-
cation dialog:

[ ] Handicapping Certification L
o i Pt ILERIE HaTwl B
Oy pcirowicdera & i corsicyse, L e regieered ke o frea Waslger b IC gl

iy e (el Ml | st o) oo (aly peteely B el B e s LRI, Hjpradeup
Sl ™ LA T L O e LG PR el Ciats

ks o W ™ ettt Wl e e s
| e e celieeics o g o

* ey By baraloag vwaeo kb ek dn @ s o secioacien
Rdhs ol e S e s

+ ledieen ey IS0, Herdiowp Sywtere ™ n o eiewiy

+ Wl P " P il i T ek

| pchroeisges T Fa UELE m e v o e radermsin

Golf Club or Association: | Bushwood Caddie's League

I've read, understood, and agree to the terms of this certification.

Handicapping Certification

Type the name of the league, club or association of golfers for whom you are
computing handicaps using the selected method, check the box to confirm
your understanding of the statement, then click OK to close the dialog.

Some types of handicapping do not require certification. You may also pro-
vide certification for the use of more than one handicapping system at a golf
club or association.

Changes? — Visible only if the selected handicapping system is certified and
there are players on file using another handicapping system, click this but-
ton to list those players and select those to have their handicapping method
updated.

Data Protection — You can lock any of the lists shown in Eagle’s main win-
dow to protect them from additions or deletions. Check a box to lock a
particular list (see also “Locking Lists” on page 187).
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Preferences

Scorecards

You may indicate preferences for a favorite or default player, how scorecards
and teams are named, and certain options for display of scorecards and lists:

Preferences

S B o0 o g

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

,0 Favorite Player: Al Czervik '
Show scores at startup

Name Scorecards: loosely alphabetic

Al Czervik / Elihu & Vivian Smails / Beeper, Czervik, Smails

Name Teams: by player position (A, B, C, ...)
Czervik, Al / A Player & B Player / A Player, B Player & C Player

Show club member numbers on Scorecards

Rounds Highlight: = Blue lines - handicap updates

Factory Settings “

Preferences - Scorecards

Favorite Player — Type a name, choose a player from the drop-down list, or
drag a player from the main window to the image well at the left to identify a
favorite player — one the software might use as a “default” for some activities.

Show Scores at Startup — If you use Mulligan’s Eagle to manage the golf
history of just a single player (the Favorite Player above), check this box

to have the application automatically open a window for that player, set to
the Scores panel, when it starts up. If you hold down the opTION key dur-
ing startup, it will override this setting - not opening the player’s window.
Conversely, if you have provided a favorite player but not checked this box,
holding down just the opTION key during startup will open the player’s win-
dow to the Scores panel.

Name Scorecards — Choose your preferred style for constructing names by
which scorecards are identified — in Eagle’s main window, in window titles
and elsewhere. An illustration of the chosen style is shown below the popup
menu.
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Name Teams — Choose your preferred style for constructing names by which
teams of players are identified — on scorecards, in events and elsewhere. An
illustration of the chosen style is shown below the popup menu.

Show club member numbers on Scorecards — Indicate if a player’s club
membership number (if available) should be shown on scorecards when dis-
played on the screen or printed. By default, this option is unchecked (off),
but some clubs use their members’ numbers for posting scores for handicap-
ping and it may be convenient to show the number on scorecards.

Rounds Highlight — Choose any special style of highlighting the list of
rounds in a player’s editing window.
Scoring

You may indicate preferences for colors and shorthand keys used in scoring:

Preferences

Z / & oo

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

Scoring Colors Scoring Shorthand
Eagles & better - Fairway Hit = F | (fairway)
Birdies - Greenside Bunker Hit | S | (sand)
Pars - Up & Down | U
Bogeys & worse - Penalty Stroke | P

@

Green in Regulation
WHS Maximum Score Incomplete Hole = X | (with score)
Net Double-Bogey Maximum Score = M | (ESC limit)

Clear C | (everything)

Factory Settings “

Preferences - Scoring

Scoring Colors — Click in the color well to display a color picker for you to
choose a color that you prefer for the display of scores. The Birdies color is
generally used for scores under par or the equivalent (a Stableford score of 3,
for example). The Bogeys color is generally used for scores over par or the
equivalent (a Stableford score of 0, for example).
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WHS Maximum Score — For competition using the “Maximum Score”
method specified in the World Handicap System, you may designate, from
the popup menu, an appropriate technique for calculating hole score limits.

Scoring Shorthand — You may configure the shorthand keys used for enter-
ing special data during entry of scores and putts. Each shorthand key should
be one character, and there should be no duplicates. For details on the use
and meaning of scoring shorthand keys, see “Scoring Shorthand” on page
180 in the Shortcuts chapter.

Appearance

You can change various parameters about how Eagle’s windows and features
are displayed on your screen or printed:

Preferences

y 2 /B0 o g F

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

Theme:

° Light Dark System
Light - Eagle always uses classic Aqua appearance

Dark - Eagle always uses Dark Mode appearance
System - Eagle uses the appearance selected in System Preferences

Tips:

none normal training

Graphing Colors: Primary - Secondary -
Matches:  Competitor ‘A’ - Competitor ‘B’ -

Factory Settings “

Preferences - Appearance

Theme — Click to specify the appearance you prefer for Eagle’s windows and
on-screen presentation. This theme will be used consistently throughout the
application. Select System to use the system-wide appearance indicated

in System Preferences - Light (standard Aqua appearance) or Dark. Select
Light or Dark to use an appearance in Eagle regardless of the system setting.

System-wide Dark Mode was first available on macOS 10.14 Mojave.
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Preferences

FE/ =l " B

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

Light ® Dark System

Light - Eagle always uses classic Aqua appearance
Dark - Eagle always uses Dark Mode appearance
System - Eagle uses the appearance selected in System Preferences

normal training

Graphing Colors: Primary Secondary

Matches:  Competitor ‘A’ Competitor ‘B’

Factory Settings

Preferences - Appearance (Dark Mode)

Tips — Control the display of help tips (commonly called Tool Tips) within
the application with this slider. “Training” means extra descriptive text while
learning how to use Mulligan’s Eagle. “None” suppresses tips except in cer-
tain special uses.

Graphing Colors — You can change the colors that are used to plot lines and
graphs of statistical information in various reports produced by Eagle. Just
click in the color wells to adjust those colors

Matches — A match window uses a color key to identify players and match
results. These color wells allow you to change the basic color scheme of
match windows. The colors are lightened for use in the window, so indicate
tull-intensity colors here.
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Other

You may indicate a preference for the display of dates, the number of items
remembered in the Recent menu, text describing event registration options
and drag and drop data characteristics:

Preferences
/J & 0 |
Authorization Scorecards Scoring Appearance  Other Handicapping Advanced Remote
Abbreviated Dates: © 20 Aug 2021 Aug 20 21
8/20/2021 2021-08-20
08/20/21 21-08-20
08-20-21 20/8/2021

Keep E Recent Players, Clubs, Scorecards, etc.

Event Registration: Registered Paid Verified
private private private
Event registration categories identified as “private” are generally not printed
or displayed.
Drag & Drop
data delimiters: © tab () comma (,) semicolon (;)

Preferences - Other

Abbreviated Dates — Click the style you prefer for the presentation of dates
in short or abbreviated form. This style will be used consistently throughout
the application. The options shown are based on your personal Language &
Text settings in your Mac’s System Preferences.

Keep — Indicate the number of items for Players, Clubs, Scorecards and
Events that should be “remembered” in the Recent menu within the File
menu. The Recent menu is used to quickly re-open windows for items
recently added or edited.

Event Registration — You can configure the names of the 3 status categories
available when registering a player for an event. 'The settings — by default
“Registered”, “Paid” and “Verified” — are used in the Registration panel of an
event window and on printed reports. You can change the names to fit your
usual requirements for player registration.

To suppress the printing or display of status in player-facing reports and
screens for a particular category, check its “private” checkbox.
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Drag & Drop data delimiters — You can specify the delimiting charac-
ter used to separate data elements or table columns in the Player, Club,
Scorecard, Event or rounds data dragged from Eagle to the desktop or to
another application on your Mac.

Tabular data, delivered as tab-delimited strings of information, is commonly
used by spreadsheet applications (like Microsoft Excel). Apple’s Numbers
application prefers data delivered as CSV - comma-separated values. In
regions where a comma is used as a decimal separator, complicating the
transfer of numerical data (like scores), some applications may prefer data
separated by semicolons.

Handicapping
Mulligan’s Eagle supports “Personal handicapping”, the ability for you to

define a handicapping method based on your own specifications:

Preferences

/@

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

Personal Handicapping

Use last scores Combine and use 9-hole scores
lgnore best 0 | scores Flag Tournament scores

Ignore worst | 12 | scores

Hole score adjustment: Net Double-Bogey

Differential type: = Relative to Par

Playing Handicap determination: = Fully Adjusted
Maximum standard handicap for men: 54.0 women: = 54.0 code: L

Skill Adjustment: 100 %

The Personal Handicapping settings above are not changed with a “Factory Settings” reset.

Factory Settings “

Preferences - Handicapping

Use last — Indicate how many scores from the player’s scoring record are to
be considered for handicap calculation.

Ignore best — Indicate how many of the best eligible scores are to be
excluded when performing the handicap calculations.
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Ignore worst — Indicate how many of the worst eligible scores are to be
excluded when performing the handicap calculations.

Combine and use 9-hole scores — If checked, 9-hole rounds will be con-
solidated as 18-hole rounds for handicap calculation. If unchecked, 9-hole
rounds will be ignored.

Flag Tournament scores — For rounds identified as “tournament” rounds,
include that identification in handicapping reports.

Hole score adjustment — If you wish to limit or adjust hole-by-hole scores
used for calculating a handicap, choose the technique to do so.

Differential type — Indicate the method of determining the “value” of a score
for handicapping purposes. That is, how is the number used in the handicap
calculation related to the round’s score?

Playing handicap determination — Indicate how a player’s playing handicap
is determined from a calculated handicap.

Maximum standard handicap for men, women, code — If there is a limit
that represents a standard “maximum” handicap value for men and women,
enter that limit. Also provide an alphabetic code to append to handicaps
beyond that limit.

Skill adjustment — If a calculated handicap is to be multiplied by a factor to
adjust its bias toward more skillful golfers, enter a percentage. Otherwise,
just enter 100%.

NOTE: 'This “Personal Handicapping” option is not a standard, nor
approved, method of handicapping when an appropriate standard or “offi-
cial” handicapping system is available to you. In Eagle, certify and use that
standard method for handicapping, even if those players already person-
ally maintain or receive a similar “official” handicap from their golf club or
association. Mulligan Software will not support, diagnose, review, or debug
configuration or operational issues with the use of this Personal Handicapping
feature. It is provided “as-is” for users with appropriate expertise to configure
and administer its use.
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Advanced

You may enforce certain rules for editing club information, restrict certain
kinds of match presses, or directly review and remove handicapping records

in the Advanced panel:

Preferences

P B / Q@ o

Prohibit duplicate hole handicaps

On courses with more than one nine, don’t allow hole handicaps that duplicate any of the hole
handicaps on another nine unless the nines use 9-hole handicaps).

Require 9-hole handicaps

On courses with 3 or more nines, require that hole handicaps on each nine be unique values from
1 through 9.

Prohibit multiple presses

In a match, if a bet has been previously pressed (manually or automatically), prohibit the addition
of a manual press to that bet.

Allow rating “Reference” Tees

When adjusting Playing Handicaps for differences in Course Ratings, allow specification of
“reference” tees to be used for calculation of adjustments for men and/or women.

Review  Handicap Records

Examine previously calculated handicap records in tabular form with capabilities to remove
selected data.

Factory Settings “

Preferences - Advanced

Prohibit Duplicate Hole Handicaps — Check the box to prohibit entering
non-unique hole handicaps on a golf course.

Require 9-hole Handicaps — Check the box to prohibit entry of any hole
handicaps other than 1 through 9 on golf courses with 3 or more nines.

Prohibit Multiple Presses — Check the box to prohibit adding a manual
press to any match in a match window that has already been pressed manu-
ally or automatically.

Allow Rating “Reference” Tees — Check the box to allow the specification
of specific tees when adjusting Handicap Allowances for differences in tee
ratings for men and women.

Review — Click the Review button to display a report listing handicap
records in tabular form. You may select and delete records from that list.
'This is an advanced feature for those cognizant of the importance of handi-
cap records. Deletions performed here are permanent.
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Remote

You may indicate that you wish to import scoring data from remote devices
providing scores via files synchronized with your Mac using Dropbox or
iCloud or export Session Lists containing information about Events..

Preferences

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

:: Use Dropbox Unlink Dropbox
0y Check for scores at startup Check for Scores Now
Scores can be imported or updated from scoring data files synchronized to the

“Dropbox/Apps/Mulligan Scoring” folder on this computer. Choose “Scores from
Dropbox...” in the File / Import menu to review incoming scores.

‘ use iCloud
Check for scores at startup Check for Scores Now

Scores can be imported or updated from scoring data files sent to iCloud by remote
devices logged in using the same Apple ID used for iCloud on this computer. Choose
“Scores from iCloud...” in the File/Import menu to review incoming scores.

Factory Settings “

Preferences - Remote

Use Dropbox — Check to indicate that you will use an active Dropbox sub-
scription (see www.dropbox.com) to synchronize scoring information from
one or more remote devices using the same Dropbox account.

Link / Unlink Dropbox — If Dropbox is available on your computer, .click the
button to link (authorize access) to Dropbox. You will be directed by your
web browser to the Dropbox web site to authenticate your use of a restricted
“Mulligan Scoring” folder in your Dropbox Apps directory. Eagle has no
other access to files in your Dropbox. To unlink from Dropbox, click the
button to disconnect from your Dropbox account.

Check for scores at startup — If you wish to have Eagle examine and
import incoming scoring data from Dropbox when Eagle starts up, check the
box. Incorrect, incomplete or ambiguous data will remain in your Dropbox
for your review and correction.


https://www.dropbox.com
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Check for Scores Now — Click the button to review and import complete
unambiguous scoring data from your Dropbox. This activity will take place
in the background.

Use iCloud — Check to indicate that you will use your current logged-in
iCloud account to synchronize and import scoring data from one or more
remote devices logged in with the same Apple ID. Synchronized data
appears in the Eagle/Mulligan Scoring folder in iCloud Drive and is avail-

able to Eagle or for your use from that location.

Note: iCloud synchronization is available only in copies of Mulligan’s Eagle
purchased from the Mac App Store.

Check for scores at startup — If you wish to have Eagle examine and
import incoming scoring data from iCloud when Eagle starts up, check the
box. Incorrect, incomplete or ambiguous data will remain in iCloud for your
review and correction.

Check for Scores Now — Click the button to review and import complete
unambiguous scoring data from iCloud. This activity will take place in the

background.
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Chapter 2

Clubs

Clubs are the golf clubs at which you play. Mulligan’s Eagle needs to know

enough about each club and its courses, nines and tees so that it can keep

score and analyze your play. You will usually have to set up information for

any club just one time.

Mulligan’s Eagle uses the symbol at the left to represent information related

to a club.

Clubs are not your golf league, organization or playing group. Don't cre-

ate a Club in Eagle called “The Saturday League” or “Ladies Club” - those
are organizations of people who play golf. In Eagle, a “Club”is a facility at

which one or more golf courses are available for play.

In this Chapter...

Finding Course Information

Creating New Clubs

Editing Club Information
Opening an EditingWindow ..................... ... ... 26
Club Demographics. . .............o i 27
Courses . ... 28
Tees ..o 29
NInes . ..ot 31
Holes . ... 32
Courses withOne Nine................. .. ... .o ... 33
Courses with More Than Two Nines . .. .................... 34
Junior Par. . ... . 35

Importing Club Information
From Mulligan’s Eagle™ Club Files ....................... 37
From Mulligan Software Club Archives .................... 38

Exporting Club Information
ExportingtoaClub File ......... .. ... . ... ..o ..., 40
Exporting a List of Clubs to a Spreadsheet . . ................ 41
Exporting Club Data to a Spreadsheet ..................... 42

Reports About Clubs
Course Handicap Tables . ........ ... .. ..., 43

Deleting Clubs
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Finding Course Information

Finding Course Information

'The best way to find the information you need is from the printed scorecards
for the club’s courses. The scorecard should include the length, par and hole
handicaps for all the holes from each tee. It should also include a Course
Rating and, in most countries, a Slope Rating for each tee.

BACK 483|368 399|152 578|427 | 449 | 186|378 |3420) | 167 | 446 | 440[363 | 348519 (220385 |395[3283][ 6703 |  USGA COURSE AND
MIDDLE 450| 345|361 | 136| 562|402 | 432 165 | 368[3221) | 127 | 396| 413|344 | 316|497 [ 195 366 | 375|3029] 6250 SLOPE RATINGS
FORWARD 359]316[ 312 88 [485 292347 110/ 268|257 [110] 351|384 300 | 254 | 428|156 [343 [ 329]2655)[ 5232 | BACK:  72.4/131
STROKES 3lBjufizf1|s5]7]15[(9 18] 6| 4|14(12(2[16/10|8 MIDDLE:  69.9/123
PAR s|4la[3[sal4a[34]36][ 3] 4[4[ 4] 453 44]35] 7] rorwarn: 71.7124
1
|
|

| T

|
20400 e [ 7 8 o Jlour] [aolu iz w314 [15 |16 [ 17 ]38 v |[Tot [[Hep | Ner
T

| BT
<1
&

SCORER | ATTESTED:

Printed Scorecard - Brook Hollow Golf Club
(Note USGA Course and Slope Ratings for each tee.)

If the course is a nine-hole course or it has three or more nines, you'll need
Course and Slope Ratings for each of the nines. If they’re not printed on
the scorecard, ask the pro or visit the National Course Rating Database at
http://ncrdb.usga.org/NCRDB/ on the internet to look them up. If you're
entering club information that is likely to be used by several players who play
from different tees, be sure to enter the information for each of those tees.

Creating New Clubs

You can create and keep information on file about as many golf clubs as you
wish. There are several ways to start:

From Eagle’s Main Window

With Eagle’s main window front-most, show the list of clubs, then click the
Add button at the lower left corner to open a window for a new club.

Note: If the Add button is not available (the button is dim), the club list has been
locked to prevent the addition or removal of clubs (see ” on page 11).


http://ncrdb.usga.org/NCRDB/
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From the New Menu

Or, choose New... in the File menu or type $N (COMMAND-N) to see a dia-
log allowing you to make a new item:

o MNew

Create a new...
O b Player - a golfer for whom you want to keep
information, like scores, statistics or a handicap.

A
e “ Club - a golf club, with one or more 9 or 18-hole
golf courses, where you and your friends play golf.

(MG ’
O ] Scorecard - a scoring record for you or a group of

golfers, on a particular golf course.

O % Event - a golf event, with multiple players or teams
and special scoring and handicapping requirements.

@ (Cancal) o)

New Dialog
Select the option to make a new club, then click the New button.

Note: If the new club option is not available (the button is dim), the club list has
been locked to prevent the addition or removal of clubs (see ” on page 11).

From the New... Submenu

® Eagle G0N Edit Golf Reports Window Help

New... BN
Open %0
Recent > & Player 9P
mport y
Export #E = Scorecard S
Close e % Event CHE
Page Setup... {r3P & Match... CHM
Print... P |

New Submenu

Or, choose Club in the New... submenu in the File menu, or type X3C
(OPTION-COMMAND-C) to create a new club and open a window for editing
it.

Note: If the menu option is not available (the Club item is dim and disabled), the
club list has been locked to prevent the addition or removal of clubs (see ” on page
11).
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Editing Club Information

The Empty New Club Window

In all cases, a new empty club window is opened, ready for you to edit infor-
mation about the club.

4 Club Name Web Site

@& [Newcub | [ure (" visit )
Address Phone Mail
street
city, state posta |cc-.|nt|"_.-' H
{ New Course | + |

Course Name Phone Measured in...

New Course 8 Yards O Meters

Designer [ Architect Head Pro

] walking Permitted Photo ¥
(@7 +)
Tee Name Color
Black Tees
Nines [ Front Nine Lﬂ [ Back Nine Lé‘ ] Use s55
Hole | 1|2 |3 |4 ([5|6|7 |89 |0ut|l0|11|12(13]|14|15(16|17|18| In [Total Ratings
Ydg Course Slope
Par
l Handicap
ﬁ Par | |
L Handicap
["] Show 9-hole Ratings

New Empty Club Window

'The window for a new club is already configured with a name of “New Club,”
and a single golf course with two nines and one tee. Continue entering club
information as you would when you make changes at “Club Demographics”

on page 27.

Editing Club Information

Opening an Editing Window

Show the list of clubs in Eagle’s main window and select the club for which
data is to be edited. Click the Edit button at the lower left corner and a club
window will open for you to review information and make changes.

Or, open an editing window by selecting one or more clubs in the list and
choosing Open from the File menu or typing 30 (COMMAND-O).

Or, just double-click the name of the club in the club list.

Note: If the Edit button is not available (the button is dim), there are no clubs
selected in the list. Club informaz‘ian can be edited even when the club list is locked.
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Club Demographics

800 Club - Bushwood Country Club
4 Club Name Web Site
lBu;hwond Country Club I URL
Address Phone Mail
3243 Country Club Drive (374) 555-1233
Bushwood, NJ 10123 | country j
[ Bushwood Golf Course | + |
Course Name Phone Measured in...
Bushwood Golf Course @ vards ) Meters
Designer [ Architect Head Pro
j ] walking Permitted Photo ¥
O @ + -
Tee Name Color
Champicnship Tees e "_v]‘
Nines [ Front Nine I-H [ Back Nine I-H ] Use 55§

Hole [1]2|3(/4|5|6|7|8
Ydg |412[183|522|385(394(195)493|379|4

S (e

Out |10]11|12]13)1415|16|17 (18| In [Total Ratings
3364 |499|370[414[392|164]401|388(175[502| 3305 | 6663 | Course Slope

Par[a[3[s5[afaa[s[afa[3e[5]a[aa[3][afaa][5]36]72] 715 132
B Handicap [5 [17[1 [11]o [15]3 [13]7 6 [14] 2 [10[18] 8 [12]16] 4
E par[4]3]s5[afa[3[s5[afa[36[5]a]afa[3]a]a]a]5]36 [72] 774 140
% Handicap | 5 [15] 3 [13[11[17]1 e |7 4 [14] 6 [10[16] 8 [12]18] 2

["] Show 9-hole Ratings

Completed Club Window

Club Name — Enter the name of the golf club, like “Bushwood Country
Club” or “Mulligan Falls Golf Course.” When you first enter a name, it will
be used to fill in the first Course Name. If a club has only one course, it’s
common, but not required, that the club and course use the same name.

Web Site — If the club has a web site address (URL), enter it in a form your
web browser will recognize (like “www.bushwoodcc.com” or “http://www.
bushwood.com”).

Visit — If you have provided a web site address, clicking this button will open
your web browser to that address.

Address — You have 2 lines to provide a street address and the city, state or
province, and zip or postal code.

Phone — Enter a phone number for the club, which may be different than
the phone number for the golf course itself.

eMail — If the club has an email address, you can enter it.

Country — If the club is in another country, indicate that country. If the club
is in your home country, you don’t need to provide data here.
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Courses
Wohen first created, a club has one course for which you need to provide
information:
[ Bushwood Golf Course | + |

Course Name Phone Measured in...

Bushwood Golf Course ® vards ) Meters

Designer [ Architect Head Pro

[] walking Permitted Photo ¥
[ QO @ + -
Tee Mame Color

Club Window - Courses Section

Each of the courses on file for the club has its own tabbed section in the win-
dow. Click the tab of the course you want to edit.

Course Name — If it’s different than the name of the golf club, enter the
name of the golf course.

Phone — Enter a phone number, perhaps the number you call to reserve a tee
time.

Measure in... — Indicate whether the course is measured (and you will enter
the length of holes) in yards or meters.

Designer / Architect — If you know it, either type the name of the golf
course designer or architect or select one from the drop-down menu.

Head Pro —The name of the head golf professional.
Walking Permitted — Check if the course allows golfers to walk the course.

Photo — Click the disclosure triangle to slide out a drawer into which you
can drag a picture of the golf course. Click again to close the drawer.

| |cuuntr\r i
~—————f EastCourse | WestCourse + -}
Phone . Measur_ed_-:ltr, s
™ '@ vards ) Meters

Adding a Course

If the golf club has more than one golf course, you can click the Add Course
button to add another course to the golf club and to the window. Continue
by entering the appropriate information for each course.
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] |countr\r B
—m West Course ~ + - |}
Phone Measured in...
1M | @ vards ) Meters

Removing a Course

You can delete a course by selecting the course (clicking its tab), then click-
ing the Remove Course button. You'll be asked to confirm that you wish to
delete the course.

You can’t delete the last course. A club has at least one course.

Tees

Each golf course has at least one set of tees. Using the course’s printed score-
card you should be able to easily enter the appropriate information about

each tee:
oL @ + -
Tee Name Color
Championship Tees @ "_"]‘
Nines | Front Nine I+] [ Back Nine = [] use 555
Hole | 1|2 (3[4 ([5|6|7 (8|9 |0ut|l0|11|12(13]|14(15[16|17 18| In [Total Ratings
Ydg [412|183|522|385|394| 195483 |378[401] 3364 |[493370{414|392] 164|401 [388|175|502| 3305 | 6669 | Course Slope
m Par (4 |3 |5(4 (4|3 |54 (4|36 [5|4|4(4[3)|4)4[3 5|36 ([72] 715 132
Handicap [ § (171 [11] 8 [15] 3 |13[7 6 [14] 2 |[10[18]| & |[12]16] 4
§ par (4 [3]5]afa[3[5[aa36|5]a]a[a[a]a]a]a]5]3s6 [72] 772 [140
Handicap | 5 |[15]3 [13 (11171 [9 |7 4 [14] 6 |10[16| & |[12]|18] 2

"] Show 9-hole Ratings

Club Window - Tee Section

You switch to enter information for a tee by clicking the tab which contains
its tee marker. In the example above, the focus is on the Championship Tees
- which apparently have blue tee markers.

Tee Name — By default, the name of the tee identifies the color of the tee (ie:
the tees with the red tee markers are named “Red Tees”). If you have some-
thing better, enter the name by which they’re identified at the golf course.

Color — Choose a tee marker that best identifies the tee. If none of those
shown are suitable, choose Custom... to open the color picker so you can
pick a better color. If you change the tee’s color, the tee marker in its tab

changes too.

Nines — Select the nines for which youre entering yardages, pars or hole
handicaps from the selected tee. Most of the time, these popup menus will

say “Front Nine” and “Back Nine.”

Use SSS — Check if the course ratings for this tee use a Standard Scratch
Score (SSS) or Standard Course Rating (SCR) as sometimes provided in
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Editing Club Information

some parts of the world. Leave it unchecked to use American-style Course

and Slope Ratings.

Note: Most golf authorities in Europe and Australia are adopting Course Rating
methods similar to those used in the United States — ratings for scratch (expert)
Players determined to a tenth of a stroke. In those jurisdictions, leave the Use SSS
box unchecked.

Course Rating — Enter the Course Rating (or Standard Scratch Score if the
box is checked) for men, women, or both, from this tee. These are 18-hole
ratings.

Slope Rating — Enter the Slope Rating for men, women, or both from this
tee. These are 18-hole ratings.

Note: If you enter Course or Slope ratings for one gender, but not for the other,
Eagle can sometimes estimate the missing ratings. If so, they are displayed as gray
(dim) text. These estimates are only used if a player of the missing gender appears
on a scorecard playing from this tee.

Show 9-hole Ratings — If you have 9-hole Course and Slope ratings avail-
able for this course from this tee, check this box to enter the ratings for each
nine.

If the course (and tee) have just one nine or more than two nines, 9-hole
Course and Slope ratings are required and the 18-hole rating fields are not
shown in the window.

Adding a Tee

If the golf course has more tees, you can click the Add Tee (4) button to
add another tee to the course and to the window. Continue by entering the
appropriate information for each tee.

Removing a Tee

You can delete a tee by selecting the tee (clicking its tab), then clicking the
Remove Tee (=) button. You'll be asked to confirm that you wish to delete
the tee.
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You can’t delete the last tee. A course has at least one tee.

Nines

Usually, a golf course has just two nines - frequently called the “Front
Nine” and the “Back Nine,” which is how Eagle first sets up a newly added
course. If the course has just one nine (ie: a nine-hole course) or more than
two nines, or simply has different names for its nines, you can handle those

changes.

'The club editing window has two popup menus used for changing informa-
tion about its nines:

lee Name Calo

Championship Tees e "_v']‘
Nines [ Front Mine I-H [ Back Nine l-ﬂ 7] Use 555
Hole [1]2[3]4[5[6[7]8 ]9 [ou]10]11]12]13]14]15[16]17[18] In [Total]  Ratings
S s o iy ey e e P P e e R e e T 1 - -

To change the name, or the first hole of either nine, or to add or remove a
nine, choose Edit Nines... from one of the Nines popup menus. A sheet
appears below the menu:

-hip Tees ' :

Nines [ Front Nine ¢] Back N
Hole Nines on Bushwood Golf Course... | 10(11
Ydg | |498|a70

J s Name | lst Hole -(Eg
il 514
ndicap | Back Nine lD| 6 14|
Par 54
ndicap
Double-click to edit name or first hole

L

_

Editing a Course’s Nines

Name —To change the name of any nine in the list, double-click the name
and type another name.

1st Hole —To change the number of the first hole on a nine, double-click the
number, then type 1, 10, etc.

To add a nine, click the Add (4) button, then provide a name and first hole
for the newly created nine (see “Courses with More Than Two Nines” on

page 34).
To remove a nine, select the nine by clicking its row to highlight it, then
click the Remove (=) button. You will be asked to confirm that you want to

delete the nine. Answer OK to delete (see “Courses with One Nine” on page
33). You cannot delete the last nine - a course requires at least one.
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Holes

You need to provide the length (in yards or meters as the course indicates),
par and hole handicap for each hole on each nine from every tee for men
and/or women. If you're entering information for tees that women don't
usually play, just enter the men’s data. If you're entering information for tees
that men don't usually play, you only need to enter the women’s information.

0 ® @ - )
Tee Name Color

Championship Tees 0 "_'!‘

Nines [ Front Nine I-H [ Back Nine I-G-] ] Use s55

Hole [1 2|3 (4|5|6|7|8 Out [10)11]12|13|14|15|16(17[18| In [Total Ratings
Ydg |412|183|522|385394(195|493|379|401| 3364 [499|370|414|392(164|401|388(175|502| 3305 | 6669 | Course Slope

=g -]

Y Par[4[3[5[4aa]a[s5[4]a]36[5[4a[aa[a3[a]a]a]5]36]72] 715 132

Handicap | 5 [17[ 1 [11] 9 [15[3 [13] 7 6 [14] 2 [10[18] 8 [12]16] 4

E par[4[3]s5]afafa[s5[a[a36[5]a]afa[a]a]a]a]5]36 [72] 774 140
Handicap | 5 [15] 3 [13[11]17[1 9 |7 4 [14] 6 [10[16] 8 [12]18] 2

[l Show 9-hole Ratings

Editing a Tee
Length (Ydg or M) — Enter the length of the hole in yards or meters.
Par — Enter par (3 through 5, sometimes 6) for the hole.

Handicap — Enter the hole handicap, or “handicap stroke allocation” for each
hole. Hole handicaps must be unique within nines, and should be unique
within 18 holes if the numbers range from 1 through 18.

Note: When you enter a valid value for any of the numbers above, the software
automatically inserts a TAB key to proceed to the next field. .. except when you enter
“1” for a hole handicap, for which you must type the 14B key yourself.

If your course names its holes, or you have a signature hole photo, you can
enter that data by double-clicking on the hole number for a hole. A sheet
appears below the hole numbers:

Ip Tees r

Mines [ Front Nine o ] [ Back Nine o ]
Hole [1]2 ]3[4 [5[6]7[8]9 [ouf10]11[12[13[14]15]16]17[18] In [
Yd

d Back Nine Name: Fin Me Oot
Par Hole S |

1dicap 13 Length: 392 ydg @

Par Men's Women's
di
1_|cap EI EI Par: 4 4
Handicap: |10 10
ﬁ

Editing Hole Information

Name — If the hole has one, enter its name.
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Length — If it’s not already provided enter the length of the hole from this
tee (indicated by the little tee marker).

Par — Enter par for men, women, or both.

Handicap — Enter the hole handicaps (“handicap stroke allocations”) for
men, women, or both.

You can save a photo by dragging an image into the area at the right of the
sheet. Remove that photo by clicking reset.

Click the left () or right () triangles, or choose Previous or Next from
the Window menu, or type ¢ (COMMAND-LEFT-ARROW) or ¥$-> (COM-
MAND-RIGHT-ARROW) to proceed to other holes on this course. Click Done
to dismiss the sheet.

When you are done changing information about a club, close the window by
clicking its close button, by choosing Close from the File menu, or by typing
HEW (COMMAND-W). There is no “Save” requirement for club information.
It is committed to the application’s database when the window is closed.

Courses with One Nine

You've probably played courses with just a single nine. If you want to set up
such a golf course in Mulligan’s Eagle, first decide how it will be played. If
the tees, tee colors, pars, or hole handicaps vary when you play the “front”
and “back” sides of an 18-hole round, set up the course like any course with
two nines and provide the hole numbers, pars and hole handicaps as indi-
cated on the scorecard. Select a “combination” tee color or name for the tee
as appropriate.

If, however, you would play an 18-hole round by touring the same nine from
the same tees with the same pars and hole handicaps, set up the course with
a single nine:

Nines [ The Muni Nine ¢] none
Hole Nines on Little Muni Golf Club. . 1)2
Ydg | |

. Name | 1st Hole
Par | 1
1dicap
Par
idicap
i
Double-click to edit name or first hole

- oo ]

Creating a 9-Hole Course
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In the Club editing window, a course with a single nine has no information

for the back side, and a 9-hole Course Rating and Slope Rating is required
for the nine:

Tee Name Color
White Tees Q) l-_v-]‘
Nines | The Muni Nine %] [ none 3] 7] use 555
Hole [1|2|3|4|S5|6|7|8|9|0ut|l|2|3[4|5/6[7[8|9 9-hole ratings
Ydg |410[126[302[315|315(304|1258)|246|148| 2294 are required
D Par [5 [3 |4 (4[4 |43 (4334
Handicap (9 [4 |1 |5 |2 |8|6|7[3
5 Par [5[3[alalala3[a]3]34 [ ]
L Handicap | 9 |4 |1 |5 |2 |8[6 (7|3
& (03 13| & Tms| [ » s ! Show 9-hole Ratings

Editing 9-Hole Tee Information

'The hole handicaps for a 9-hole course should be set to values from 1
through 9. Course ratings for a 9-hole course are about half of those for an
18-hole course. Slope ratings are numbers between 55 and 155 on both 9
and 18-hole courses. For additional information about 9-hole ratings, see

“9-Hole Ratings” on page 190.

Courses with More Than Two Nines

If a course has more than two nines, you can set up the separate nines by
adding additional nines:

Q3

Nines | Robert 3| [ Tremt

Hole | nines on Famous Country Club... 12
Ydg | Jass[sag]

Name | 1st Hole

Par Jones 1154
2K (28

par | Trent 1754
dicap 18|
F Y 34

Double-click to edit name or first hole

o I

)

Creating a Multi-Nine Course

Provide a unique name for each nine, and indicate the number of the first
hole on each nine (1, 10, etc.). You will need 9-hole Course and Slope rat-

ings for each of the nines for every tee. If that information isn't available on
the printed scorecard, ask the pro.

If you have 18-hole Course and Slope ratings for combinations of the nines
(in the example above, Jones & Robert, Robert & Trent, Jones & Trent), the
Golf Calculator (type $G) has a feature to estimate 9-hole ratings from the
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18-hole combinations. For additional information about 9-hole ratings, see

“9-Hole Ratings” on page 190.

When you have set up a course with 3 or more nines, you'll need to use the

Nines popup menus to select the nine for which you're entering lengths, pars
or hole handicaps:

Tee Name Color
_While Tees | O 5‘
Nines | Robert 5] [Trent 2] [ use 55§
Hole | 1|23 |4|5|6|7 (8|9 /0ut|{l|[2|3|4[5|6]|7[8)|9|0utTotall 3-hale ratings
¥dg |s38[s00[358]169]3s6]119[as0lszel441] su1s]sss]aas]ezs|ie1]sas]sus]seu]153[ac0] svav | susa|  are required
b Far [5 (4 )43 (4|34 (|4(5)36(5|4(5(3[4/4])4[3[4]36 72 67.9/113
Handicap (3 [9 |1 |8 |4 |6]|2]|7 (5 2|83 |7T[6]1]|4]9]5
& Par[5]4]4|3]4]3[a]a]5]36|5]4[5[3[a[a[4[3[4]36]72]
Handicap |3 |9 |1 (B |4 |6 (2|7 |5 1[B8|3|7|6]2|4]9]5
I RERIREN & [32z][1z] & [ 1 | & show 9-hole Ratings

Editing Multi-Nine Tee Information

Note in the illustration that Course and Slope ratings are entered for each
nine, from the tee selected and the total of those ratings for the two nines
being displayed is shown to the right of par values. Hole handicaps for each
nine are usually assigned values from 1 through 9, but that is not a require-
ment. The printed scorecard should indicate how to enter those numbers.

Junior Par

You can set up special tees for juniors that conform to the USGA’s Junior Par
specification. Before you start, have the yardages and course ratings available
that you intend to use for the special tees.

Adding a New Tee for Juniors

Create a new tee for the juniors by clicking the Add Tee button, then give
the tee a name, a tee marker and enter yardages for each hole.
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Importing Club Information

Choose Junior Par... from the Clubs section of the Golf menu, or type
{>3J (SHIFT-COMMAND-J) to display the Junior Par sheet:

Club - Bushwood Countm E;Iub

ountry € Install Junior Par Visit
From Junior Tees... O pa—
v Club [
S For: @ Boys (O Girls
4 1012

Level: () Beginner - Playing handicap over 40
® Intermediate - Playing handicap 25 to 40
() Advanced - Playing handicap under 25

Course

itect

| G (Gonee) (o)

185 [ Front Nine +) [ Back Nine +)

ole[1]2[3]4]s[6[7]8]9 [ou[10]11]12][13]14]15]16[17][18] In [Totall

‘dg [388|155[495[340(384|177|470|355|375| 3139 [470|360|400|342|135|380|360|154[455| 3056 | 6195 | C

Par |5 |4 |6|5|5|4|6([5|5(45 |6 (56|53 |5|5(4|6)45 )90 ¢
cap | 5 [17]1 (119 (1513 13| 7 61142 |10[{18] 8 [12]|16] 4

Par |6 |4 |7 |5|6|4|6[5|6 (49 |6[(6|6|5|3|6|6|4|6)48 |97
cap [ 5 [15[3 13|11 |17 )1 |9 |7 4 (14| 6 [10|16) 8 |12]|18] 2

Install Junior Par Sheet

Note: If the Junior Par... option is not available in the Golf menu (the item is
dim and inactive), you have not provided lengths (yardages) for each of the holes

from the junior tees. Junior Par calculations are based on hole length.
For — Select whether you want to calculate Junior Pars for boys or girls.
Level — Select the skill level for the junior players from these tees.

Click the Apply button to insert the appropriate Junior Pars into the holes
(boys or girls) that you've indicated. This change will not be permanent until
you click the Set button. If you wish to set pars for the other gender on the
same tees, select Boys or Girls again, then click the Apply button to insert
the appropriate pars.

When you have set the par values as you wish, click Set to make the changes
permanent and close the sheet. If you decide you don’t want to make the
changes, click Cancel and the pars will be restored to the values on file at the
time you started.

Importing Club Information

Transcribing all that information about golf clubs and their courses can be
a tedious activity — although you generally only have to do it once for any
course that you use. Mulligan’s Eagle has features to import data about clubs
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— from Club files produced by other users of the software or from an internet
archive of club information maintained by Mulligan Software.

From Mulligan’s Eagle™ Club Files

N Club files are Mac documents on your (or someone else’s) disk that contain
all the detailed information about a golf club. Club files are exported by
Mulligan’s Eagle and make the information portable. You can share the data
with other users of the software or with Mulligan Software, who uses such
shared data to build its archive of club information.

(2]
-
c
w

Begin importing Club files by choosing Mulligan’s Eagle™ Club Files...
from the Import submenu in the File menu.

(4 EagiemEdit Golf Reports Window Help

New... >
Open #O
Recent >

Import > B Mulligan's Eagle™ Club Files...

Export #E
P Mulligan Software Club Archives...
Close BW -
; |2 Scores from Mulligan Scoring Data Files...
Print... ®P . & Scores from Dropbox...
Club File Import Menu

Note: If the menu option is unavailable (the item is dim and inactive), the club
list has been locked to prevent the addition or removal of clubs.

Use the displayed dialog to locate the Club files to be imported:

Sl 0000 000 wpoe
[“|“'][55|-i-|”ﬂ] ( 3 My Club Files H'l'rQsear'ch D)
—— L NEEe| Date Modified |

I iDisk |# Bushwood Country Club.CLUE  Today, 9:19 AM
| Backup - B Cowboys Golf Club.CLUB Today, 9:16 AM

@ My Disk

¥ SHARED
@ All..

I

|

|

|

|

|

|

¥ PLACES :

g Desktop

|

%} me |

ﬁ Applicaticns '

@ Documents :

ﬁ Movies '
ﬂ Music -
[ Pictures b

(Cancel) Cimpore)
A

Choosing Club Documents to Import
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Navigate until you have found the files, then select those you want to import.
Click the Import button when you are ready to continue.

'The application will display a dialog that will show your progress importing
each of the selected Club files:

M

S Importing Eagle Club files_..

1 file selected - click Import to continue

Older Club files may not include the same complete
information as more recently created and saved club
information. If necessary, review the results of this import
for accuracy. Golf clubs are not checked for duplication
when importing.

® (Cancel) Gimpor)

Club File Import Progress

Click the Import button to import the data. The progress dialog will close
automatically when the process is complete. The clubs will appear in the club
list in Eagle’s main window, and are available for use wherever club informa-
tion is required.

Note: Importing Club files does not check for duplication. If you find yourself with
duplicate clubs, review them, keep the best and delete the others.

From Mulligan Software Club Archives

Mulligan Software maintains a web-based archive of data about golf clubs
that is accessible from Mulligan’s Eagle. You can use this archive to import
information about clubs you may have played. The archive is the handiwork
of software users who have donated their completed Club files to the cause.
You can benefit from their generosity.
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Your computer must be connected to the internet to retrieve club data from
Mulligan Software. Start by choosing Mulligan Software Club Archives...
from the Import submenu in the File menu.

(4 EagiemEdit Colf Reports Window Help

New... 4
Open #}O
Recent 13

|# Mulligan’s Eagle™ Club Files...

Export HE
€ Mulligan Software Club Archives...
Close BW
|21 Scores from Mulligan Scoring Data Files...

Print... #®P | %7 Scores from Dropbox...

Club Archives Import Menu

Note: If the menu option is unavailable (the item is dim and inactive), the club
list has been locked to prevent the addition or removal of clubs.

'The application will try to connect to the Mulligan Software web site. You
will see a list of folders, organized by country, that you can expand by click-
ing the triangle next to their folder. The data within these folders may be
further organized (alphabetically) by state, province, etc.

8 00 Import

’ Select Golf Clubs from the Mulligan Software archive...

Club Location
[ Spain

> [:j Thailand

> [:j United Arab Emirates

> [:j United Kingdom

¥ (7 United States

"I.I.‘j Alabama
@ Arab Country Club Arab, AL
@ Auburn Links Auburn, AL
" Cedar Ridge Golf Course Decatur, AL
" Colonial Golf Club Meridianville, AL

Select clubs to import, then click Impert te continue

@/l | cancel | [ Import |

Selection from Club Archives

To import information about one or more clubs, select (by clicking) those
clubs of interest, then click the Import button. The club information will be
retrieved and the dialog will remain on the screen for you to repeat the pro-
cess until you click the Cancel (or Done) button.
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Exporting Club Information

Note: Importing Club files does not check for duplication. If you find yourself with
duplicate clubs, review them, keep the best and delete the others.

Exporting Club Information

Exporting to a Club File

You can export, or “save,” information about a golf club that you have created
or modified to a Mac file. This file, or “document,” can then be provided to
someone who wants to import the information into their copy of Mulligan’s
Eagle. The resulting file can also be attached to an email and sent to
Mulligan Software to be included in their growing archive of club data.

To export all the information about a club, start by opening an editing win-
dow for the club (see “Editing Club Information” on page 26). Choose
Export from the File menu or type 3$E (COMMAND-E) to open a standard
macOS Save sheet in the window:

b Name
“hwood Save As: [Bushwocd Country Club.CLUB ] B
dress
13 Coun
[« »][2[=]m) (2 Eagle User Data B (Qsearch )
-hwood,
| v pEvices 4 Name & Date Modified |
B ipisk % Cowboys Golf Club.CLUB Today, 9:16 AM
= Name .
s
ood Goll @ BaCkLIIp -
er | ArJ “é 1 o7lelets
¥ SHARED Pho
@ Al
“lame ¥ PLACES
npienshi g Desktop
N (3 me Use 55¢
ﬁ Applications - Rating:
[T Documents 1 urse Sle
"] Hide extension New Folder -Cancel -‘m; 15 1[13
' Hand y
Par |4 3|5 |4|4]3|5|a]a|36 |54 a(4a]3]a]a|3][5]36 ] 72] 774 1
Handicap | 5 115] 3 [13[11[17]1 [a [ 7] [aT1al 6 [10l16] 8 T12[18] 2 |

Club File Export

Decide on the name for your file, navigate to the location where youd like
to save the file, then click Export. Unless you indicate otherwise, Eagle will
save the file in the Eagle User Data folder inside the Documents folder
inside your user directory.

Eagle Club documents are stored with, and identified by, a .CLUB extension.
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Exporting a List of Clubs to a Spreadsheet

From Eagle’s main window, you can export data for selected clubs to an open
spreadsheet application. With Eagle frontmost, select the clubs of interest
and drag the selection to the spreadsheet:

@ Bountiful Golf Club Bountiful, UT

6' The Buccaneer Christiansted, V1
“ Bushfield Golf Course Mt. Holly, VA
@ Bushwood Country Club Nutley, NJ

il il I B Ealaans: AR Cansd

Dragging a selected list of clubs to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
each selected club:

* Club name

» City, State

* Phone number

'The data is organized in a tabular array, one club per row, when inserted into
the spreadsheet:

Heverica v 10 |+

< A T B e I D T E T F I G I H
1 | Araostock Valley Gountry Glub FL Fairfield, ME 207 476-8083

2 |Bear Creek Goll & Racquel Club | DFW Airport, TX 972 456.3200 |

3| Birdwaod Golf Course Charlattesville, VA (434) 293-GOLF

4 |Bogey Hills Country Club |St. Charles, MO 636 946-6250

5

[

4

)08

Spreadsheet Clubs List



42 Exporting Club Information
S S ———

Exporting Club Data to a Spreadsheet

You can also export detailed information about a single club to an open
spreadsheet application by opening an editing window for the club, then
dragging the icon at the top left of the window onto the spreadsheet:

""" - Web Site

‘ [PGA West I |hrrp:”www.pgawesr.com
Address Phone eMa
[55-955 PGA Boulevard | [760 564-7100 1T
__ _ [La Quinta, CA 92253 | [country
[-Wnald'-hlmerﬁ—| Greg Morman Course  Jack Nicklaus Course  Tom |
Course Name Phone Me:
[Arnold Palmer Course ® Yards

Dragging detailed club information to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
the club:

* Club name

* Web site

* Street address

» City, State & postal code

* Phone number

* eMail address

+ Country

and for each course at the club:
* Course name
* Phone number
* How measured (yards or meters)
* Designer/Architect
* Head Pro
+ Allows walking (yes or no)

< [

1 [Club 'Web Sita | Addrass City, ST Pastal Phone aMail 'Country
2 |PGAWast | http fiwww_pgawesl.con 55-855 PGA Boulevard La Quinta, CA 92253 760 564-7100 | |

3 |Course | Phone Measured | Designer/Architect Head Pro | Walking

4 | Amold Palmer Course | Yards | Arnold Palmer | Yes

5 |GregMorman Course | | Yards | Grag Norman | |

6 |Jack Micklaus Course | Yards | Jack Nicklaus | Yes

7 |Tom Weiskopf Course | | Yards | Tom Weiskopf | |

8 |TPC Stadium Gourse | | Yards | Pete Dye | Yes

9
e

Spreadsheet Club Data
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If your spreadsheet application has difficulty importing data dragged from
Eagle (no columnar results, improperly interpreted numbers or spacing, etc.),
you may need to change the format of the dragged information. See “Drag
& Drop data delimiters” on page 17 for more information.

Reports About Clubs

Course Handicap Tables

You can produce, on the screen and ready for printing, Course Handicap
Tables (sometimes called “Slope Charts”) for a golf club. Start with either
an open editing window for a club, or with the club list displayed in Eagle’s
main window and one or more clubs selected (highlighted). In the Reports
menu, choose Course Handicap Tables...

A dialog or sheet will be displayed for you to refine the selection of tables

you want to see:

Caountry ¢ Course Handicap Tables Visit )
For Bushwood Country Club...
try Club [ (
Course: | g Bushwood Golf Course %

M) 1012 — H

Tees: | All Tees I-ﬂ

For: gMen gWemen
f Course & Tabl P
ables selecte
“hitect
( Cancel ) E—Shuwﬁbfes—)

Colar
) Tees @ 3

Creating Course Handicap Tables

If you've chosen just one golf club, you can narrow your selection down to
tables for a specific course or tee at that club by choosing them from the
popup menus. Decide whether you want tables for men or women or both
and check the boxes accordingly. Click the Show Tables button when you've
made your selections.
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Mulligan’s Eagle will display a window containing the Course Handicap
Tables for each of the tees you've chosen (for which Course and Slope
Ratings are available):

(o N Né)] Course Handicap Table
'y
)
Course Handicap Table
Bushwood Country Club
Championship Tees (Men)
Slope Rating - 132 Course Rating - 71.5
Handicap Index® Course Handicap Index® Course
Handicap Handicap
+3.8 to +3.0 +4 16.7 to 17.5 20
+2.9 to +2.2 +3 17.6 to 18.4 21
+2.1 1o +1.3 +2 18.5 to 19.2 22
+1.2 to +0.5 +1 19.3 to 20.1 23
+0.4 to 0.4 1] 20.2 to 20.9 24 W
0.5 to 1.2 1 21.0 to 21.8 25
1.3 o 2.1 2 21.9 to 22,6 26
2.2 o 2.9 3 22.7 to 23.5 27
3.0 to 3.8 4 23.6 to 24.3 28
3.9 to 4.7 5 24.4 to 25.2 29
4.8 to 5.5 [ 25.3 to 26.1 30
5.6 to 6.4 7 26.2 to 26.9 31
6.5 to 7.2 8 27.0 to 27.8 32
7.3 to 8.1 9 27.9 to 28.6 33
8.2 to 8.9 10 28.7 to 29.5 34
9.0 to 9.8 11 29.6 to 30.3 35
9.9 to 10.7 12 30.4 to 31.2 36
10.8 to 11.5 13 31.3 to 32.1 37
11.6 to 12.4 14 32.2 to 32.9 38
12.5 to 13.2 15 33.0 to 33.8 39
13.3 to 14.1 16 33.9 to 34.6 40
14.2 to 14.9 17 34.7 to 35.5 41
15.0 to 15.8 18 35.6 to 36.3 42
15.9 to 16.6 19 36.4 43
Course Handicap = Handican Index® x Slope Rating | 113 (raunded)

P
N —

A Course Handicap Table

You can use the tables as shown on your screen, or you can send the tables
to your printer (one table per page) for a hardcopy. To print, choose Print...
from the File menu or type P (COMMAND-P).
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Deleting Clubs

With Eagle’s main window front-most, show the list of clubs, select (CLICK,
SHIFT-CLICK or COMMAND-CLICK) the clubs to be deleted, then click the
Remove button at the lower left corner. Or, choose Delete from the Edit
menu, or type <&J (DELETE). You will be asked to confirm that you really
want to delete the club(s). Click OK to delete or Cancel to continue without
deleting.

Deletion is permanent and cannot be undone. The names and other infor-
mation about deleted clubs may still appear on scorecards. When a club is
deleted, all its courses, nines, tees and holes are deleted too.

Note: If the Remove button is not available (the button is dim), either there are no
clubs in the list selected for deletion, or the club list has been locked to prevent the
addition or removal of clubs (see ” on page 11).
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Chapter 3

Players

e
o

Players are golfers - like you. Mulligan’s Eagle needs to know some basic
information about each of the players it is expected to keep score for. You
can enter as much information as you think will assist you in keeping statis-
tics or event scoring for each player.

Mulligan’s Eagle uses one of the symbols at the left to represent information
about a player.

In this Chapter...
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Creating New Players

You can create and keep on file information about as many players as you
wish. There are several ways to start:

From Eagle’s Main Window

With Eagle’s main window front-most, show the list of players, then click
the Add button at the lower left corner to open a window for a new player.

Note: If the Add button is not available (the button is dim), the player list has been
locked to prevent the addition or removal of players (see ” on page 11).

From the New Menu

Or, choose New... in the File menu or type B to see a dialog allowing you to
make a new item:

New

Create a new...
° a Player - a golfer for whom you want to keep
information, like scores, statistics or a handicap.

— A
J “’ Club - a golf club, with one or more 8 or 18-hole golf
courses, where you and your friends play golf.

PN )
| 77 Scorecard - a scoring record for you or a group of

golfers, on a particular golf course.

_ ‘b Event - a golf event, with multiple players or teams and
special scoring and handicapping requirements.

? Cancel New

New Dialog
Select the option to make a new player, then click the New button.

Note: If the new player option is not available (the button is dim), the player list
has been locked to prevent the addition or removal of players (see ” on page 11).
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From the New... Submenu

8 Eagle AN Edit Golf Reports Window Help

New... N

Open #O

Recent » * Player P
Import > @ Club NEEC
Export 3E = Scorecard T3S
Close W ‘; Event ¥E
Page Setup... {+%P & Match... EM
Print... #P f

New Submenu

Or, choose Player in the New... submenu in the File menu, or type \_$P
(OPTION-COMMAND-P) to create a new player and open a window for editing

1t.

The Empty New Player Window

In all cases, a new empty player window is opened, ready for you to edit
information about the player.

Player - New Player

@ @
& £=3 =

Setup Preferences Handicapping Scores Print

E\ PlayerName: | - |

Gender: @ male ( female

Street Address:

City, State Postal:

Phone:

eMail:

Home Club:

Member no.:

New Empty Player Window
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'The window for a new player is ready for you to provide the information
you'll need to use for scoring, analysis and handicapping. You'll continue
editing information about the player as described beginning on page 50.

Editing Player Information

Opening an Editing Window

Show the list of players in Eagle’s main window and select the player for
which data is to be edited. Click the Edit button at the lower left corner and
a player window will open for you to review information and make changes.

Or, open an editing window by selecting one or more players and choosing
Open from the File menu or typing 30 (COMMAND-O).

Or, just double-click the name of the player in the player list.

Nofte: If the Edit button is not available (the button is dim), there are no players

selected in the list. Player information can be edited even when the player list is
locked.

'The player window will open to the panel that was last used for editing a
player. New player windows start in the Setup panel.
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Setup

Click the Setup item in the toolbar at the top of the player window to start
by entering or modifying information about the player:

Player - Al Czervik

LMo
u il

iD

Setup Preferences Handicapping Scores Print
E\ PlayerNeme: (Al |
reset. Czervik
Gender: @ male [ female

Street Address: 3244 Industrial Hwy.

City, State Postal: Mutley, NJ 10233

Phone: 555-5454 555-5444

eMail:

Home Club: |Bushwood Country Club
Member no.: 234

Player Window - Setup

Player Name — Enter at least the player’s first and last names in the space
provided. If you prefer to see a suffix like “Jr.” or “MD” appended to the play-

er’'s name in lists, reports, and on a scoreboard, enter one.

Gender — Indicate the sex of the player. Mulligan’s Eagle identifies men and
women differently in most lists and uses different criteria for scoring and
handicapping is some cases.

Street Address — Provide an address for the player.

City, State Postal — Enter the city, state or province and postal code for the
player. This information appears in some lists and reports.

Phone — Enter the phone number(s) to reach this player.

eMail — Enter the player’s email address if they have one. If the field con-
tains an email address and you click the Send button, Eagle will open your
mail client, ready to send a message to the indicated address.

Home Club — Indicate the player’s home club - the club at which they keep
their handicap records.
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Member no. — If it’s available, enter the player’s membership number or ID
at their home club. Eagle can put this information on a scorecard for clubs
that require the number for posting scores.

Picture — If you drag a picture of the player onto the photo frame at the
upper left of this panel, Eagle will use that picture in places where the gg or
* symbols normally appear.

Player Preferences

Click Preferences in the toolbar to enter or update certain preferred settings
for the player:

Player - Al Czervik

1D

0@
) hid

Setup Preferences Handicapping Scores Print |
|I| Preferred settings for Al Czervik...
Eact Preferred Club: = Bushwood Country Club

Course: = @ Bushwood Country Club

Sides: | Front Nine B Back Nine

Tee: | (U Men's Tees

| Guest- One-time-cnly, nen-member, or single
event player. Mo handicap calculation.

Player Window - Preferences

Preferred Club — From the golf clubs on file, select the club usually played
by the player - the one to be used on a new scorecard if no other club is spec-
ified. You can also set this preference (and the preferred course, sides and
tee) from any scorecard that contains a round for this player.

Course — Select, if the club has more than one course, the player’s preferred
course - the one they usually play or their favorite.

Sides — Usually, these are set to “Front Nine” and “Back Nine,” but if the
course has more than two nines or has nines with unique names, you may
wish to indicate which nine is preferred as the front side and which is pre-
ferred as the back side.
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Tee — Select the tee this player usually plays on this course. This preference
will serve as the default for the preferred course and a tee of the same color
on another course. So, if this player prefers the red tees, it will be the tee
selected by default for this player on any course that has red tees.

Guest — You can keep information on file for occasional or one-time play-
ers for whom you don’t plan to keep extensive records or compute handicaps
(like event invitees, members of other clubs, etc.). If the player fits this
description, check the box. Eagle can include or exclude guests from certain
lists of players. For more information, see “Guests” on page 73.

Handicapping

Click Handicapping in the toolbar to enter or update handicapping infor-
mation for the player:

[ oW ] Player - Al Czervik
tad =
o] —
Setup Preferences Handicapping Scores Print
Handicapping settings for Al Czervik...
reset -
Method: USGA Handicap System a
National Golf Association: = United States Golf Association B Wisit
Handicapping no.: | 45667890 |
Beginning Handicap Index®: 18.1 1 9-Hole | Don't Calculate
Handicap Index®: 15.0 effective 1 Aug 2012
80 = 9 80 80 a0 80 BG = B6 * 80 80 =A
B4 A a0 A a0 a9 A Ba * BB * 92 Ba * BB * 91 *
Make Adjustment Post Supplementary Score Lookup Handicap using GHIN

Player Window - Handicapping

Note: The use of the Make Adjustment, Post Supplementary Score, and
Lookup Handicap buttons near the bottom of the window is explained on pages
55, 56, and 57.

Method — Normally set to represent the handicap system in use in your

country, select the handicap method that represents how this player’s handi-
cap was computed. This does not assure that Mulligan’s Eagle will compute
a handicap for this player by this method - you may not be authorized to do
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so - but it identifies any handicap for this player as having been determined

by this method.

National Golf Association — This is normally set properly, but if this player’s
handicap is governed by the authority of another national golf association,
select that association from the menu.

Handicapping no. — If it’s available, provide the number used to identify the
player in his club’s handicapping system. In the United States, this is fre-
quently his GHIN (Golf Handicapping Information Network) number. In
Canada, it may be their RCGA Network member number. In Australia, it’s
usually their GolfLink number.

Beginning Handicap — For players with few (or no) rounds on file, or guests
and one-time players, enter their Handicap Index (in the U.S.) or handicap
to be used until better data is available.

9-Hole — Check this box if the player is a 9-hole-only golfer and their hand-

icap, whether provided as data or calculated, is for nine hole rounds.

Don’t Calculate — If the handicapping information here is sufficient to auto-
matically calculate and update a handicap for this player, but you don’t want
Mulligan’s Eagle to update that handicap, check this box. Note that this box
is pre-checked and unavailable for players who are identified as a guest (see

“Guests” on page 73).
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Make Adjustment — Handicap committees can make manual adjustments
to a player’s scoring record to account for various situations. You can do the
same by clicking the Make Adjustment button. You can enter and save an
adjusting item in a player’s handicapping record:

[oN ] Player - Al Czervik

& s Bt

Setup Preferences Handicapping Scores Print

@ ’K Handicap Adjustment for Al Czervik

Effective Date: | Sunday, February 28, 2106 -

D

- sit
Handicap Index®: 195 9 Hole Handicap

Reason: Committee Review
late

2016

o oo T o oo o o o oo =

80 =A B4 A a0 A a0 89 A B9 ~ BB * 92 B9 ~ BB *

Make Adjustment Post Supplementary Score Lockup Handicap using GHIN

Handicap Adjustment

Effective Date — Enter the date on which this adjustment becomes effec-
tive. It will remain in effect until a subsequently dated handicapping record
or adjustment is made.

Handicap (Index or other) — Enter the override value for the player’s handi-
cap due to this adjustment.

Reason — Enter a short description of the reason for the adjustment.

Click the Save button to add this adjustment to the player’s handicapping
record.
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Post Supplementary Score — If you wish to include a score in the player’s
scoring record that was not entered by the normal use of Mulligan’s Eagle
(an away score without a scorecard, for example), you can enter a single
round in the player’s scoring record to be included in the next handicap cal-
culation for this player. Click the Post Supplementary Score button to
enter that score:

[oN ] Player - Al Czervik

& s Bt

Setup Preferences Handicapping Scores Print

B ILL
@ = Posta Supplementary Score for Al Czervik

Date: Wednesday, June 30, 2106 "

I

Club: East Overshoe Country Club

sit
Course: East Overshoe Country Club
Tee: @ Blue Tees late
Rating: 68.9 Slope: 121
2016
Adjusted Score:
|9 Holes | via the Internet

| Penalty Round

Post Supplementary Score

Note: If the course on which this round was played is available in your list of clubs,
it may be much simpler, and perhaps more accurate, to just enter the round on a
scorecard.

Date — Enter the date of the round. A date is required.

Club — Type the name of the golf club at which this round was played. This
field is required.

Course — If the name of the golf course played is different than the name of
the club, enter the name of the course.

Tee — Select the tee from the menu and/or type the name of the tees.

Rating — Enter the Course Rating (or Standard or Calculated Scratch Score)
for the course from the tees played. This value is required.

Slope — Enter the Slope Rating of the tees played. This value is required.
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Adjusted Score — Enter the player’s adjusted gross score for the round
which is the player’s gross score adjusted for incomplete holes, stroke control
procedures, etc. A score is required.

9 Holes — Check the box if the round was a 9-hole round.

via the Internet — Check the box if this round was reported by the player via
the internet.

Penalty Round — Check the box if this round represents a penalty round.
Click the Post button to save this information in the player’s scoring record.

Lookup Handicap — If the Lookup Handicap button is available (when
the player’s handicapping method and handicapping number are appropri-
ately set), Eagle can retrieve the latest updated handicapping record from
the handicapping service’s web site. Click the Lookup Handicap button to
retrieve the information:

BN ) Player - Al Czervik
» e ‘g L j =¥
Setup Preferences Handicapping Scores Print
GHIN Looking up Handicap Index® for Al Czervik from GHIN web site
R (www.GHIN.com)...
Complete |
it
Handicap F
Player GHIN Index® Effective Date
Found: | Al Czervik 4567890 13.2 7/1/2016
Found information formatted as shown on web site ate
2016
Make Adjustment Post Supplementary Score Lockup Handicap using GHIN

Lookup Handicap

If the downloaded data appears correct, click the Save button to enter the
data in the player’s handicapping record. If the data is incorrect, incomplete,
or the handicapping service’s web site is not available, just click Cancel to
continue.
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If the player’s handicapping records are available, online or otherwise, from a
service not supported by Mulligan’s Eagle, you can still retrieve the effective
date and handicap information yourself and use Make Adjustment to enter

that data into the player’s handicapping record.

Scores

'The final section of the player’s window represents a list of the scorecards on
which the player’s rounds are recorded:

[ NoN ] Player - Al Czervik
I _
s k=3 =
Setup Preferences Handicapping Scores Print
Date v Club Course Tee Score Hep Met
22 Aug 2015 | Innisbrook Golf Resort Copperhead Course “_
20 Jul 2012 Bushwood Country Club Bushwood Country Club ™ a0 17 73
7 Jul 2012 | Bushwood Country Club Bushwood Country Club & 9 17 74
6 Jul 2012  Bushwood Country Club Bushwood Country Club (™) 90 15 75
3 Jul 2012 | Bushwood Country Club Bushwood Country Club (™ a0 17 73
29 Jun 2012 Bushwood Country Club Bushwood Country Club & 90 17 73
24 Jun 2012  Bushwoed Country Club Bushwood Country Club (™) 90 15 75
23 Jun 2012 Bushwood Country Club Bushwood Country Club ™ B3 15 74
18 Jun 2012  Bushwood Country Club Bushwood Country Club & BB 15 71
10 Jun 2012 Bushwoed Country Club Bushwood Country Club (™) 90 15 75
9 Jun 2012 Pebble Beach Golf Links Pebble Beach Golf Links (™ a0 16 74
9 Jun 2012  Harbour Town Golf Links Harbour Town Golf Links & B4 16 B8
9 Jun 2012 | Eagle's Bluff Country Club Eagle's Bluff Country Club (™) 90 14 76
8 Jun 2012 Bushwood Country Club Bushwood Country Club ™ a0 15 75
8 Apr 2012 Eastlake Golf Club Eastlake Golf Club & a9 2B 68
4 Jul 2009 Bushwoed Country Club Bushwood Country Club . B9 16 73
5 May 2008 Bushwood Country Club Bushwood Country Club (™) BB 16 72
1 Apr 2009 Bushwood Country Club Bushwood Country Club & 92 16 76
28 Eah 2008 | Rushwnnd Canntos Cluh Rushwnad Caontr Pl | RO 1R 72
— 52 rounds on fila
s = Pd

Player Window - Scores

To open any of the listed scorecards, select one or more from the list, then
click the Edit button or type $0O (COMMAND-O) to open the scorecards for
review or modification. You can also open a single scorecard by double-
clicking it in the list.

Note: The scorecards listed include the player’s scores, but they may also include
rounds for other players. If you modify anything on the scorecard that changes those
other rounds, you are modifying the playing history of those players.

You can add a round to the player’s scoring history by adding a scorecard for
the player. Click the Add button to create a scorecard window and bring it
to the front for editing. You can also open a scorecard for the player by
choosing Scorecard for Player from the Players section of the Golf menu
or by typing $S (COMMAND-S). You can then proceed as described at
“Editing Scorecards” on page 79.
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You can delete a round from the player’s scoring history. Select the round’s
scorecard from the list and click the Remove button to delete it. Or delete a
round by selecting its scorecard and choosing Delete from the Edit menu or
typing & (DELETE). You will be asked to confirm that the player’s round
should be deleted. If that round is the only round on the scorecard, the
scorecard is deleted too.

16 Apr 2008  Bushwoed Cou
) ou

Tournament scores are identified in the player’s list of rounds by a score
shown in bold text. Scores to be ignored for use in handicapping are identi-
fied by a score shown in italic text.

Exporting Player Information

Exporting a List of Players to a Spreadsheet

From Eagle’s main window, you can export data for selected players to an
open spreadsheet application. With Eagle frontmost, select the players of
interest and drag the selection to the spreadsheet:

] .O (@) - . M.ulligan's ﬁgle“

}e Club
J Slfstf'lwond Country Club
Bushwood C y Club

Drag Bushwood C. ¢ Club

Bushwood Country Club
Bushwood Country Club

a Earl Havercamp
ﬁ Frieda Havercamp Bushwood Country Club

Dragging a selected list of players to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
each selected player:

* Player name

* Home club

* Member number

* Current handicap (as a text string)

* Handicapping account number

* Phone number

* Fax/Cell number

* Gender (“M” or “F”)

* Alphabetic version of player name

“«w »

* Numeric current handicap (“+” handicaps negative)
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The data is organized in a tabular array, one player per row, when inserted
into the spreadsheet:

@00 = Workbook1

Smartart Graphics |

< A B [ € [ o | E F G | H ] 1 ] [ K [

1 Al Czervik Bushweod Country Club 234 141 4567890 555-5454 555-5444 M Czervik, Al 141

2 | Mary Czervix Bushwood Country Glub 2341 34.6 F Czervik, Mary 34.6

3
KN
5 |
| 6 |

7

8

Spreadsheet Player List

Exporting Player Data to a Spreadsheet

You can also export detailed information about a single player to an open
spreadsheet application by opening an editing window for the player, then
dragging the icon or picture representing the player onto the spreadsheet:

OOB -Player-ﬁ-\IC;

Player Name: Al

|Czervik

Gender: ® male (O fem

Dragging detailed player information to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
the player:

* Player name

* Gender

* Street address

» City, State & postal code

* Phone number

* Fax/Cell number

* eMail address

* Home club

* Member number

* Preferred club

* Preferred course

* Guest (yes or no)

* Handicapping method

* Handicapping account number (GHIN, etc.)

* Beginning handicap
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* 9-Hole player (yes or no)
* Calculate handicap (yes or no)
* Current handicap (Handicap Index®, etc.)

If you hold down the ConTRroL key while dragging the player to the spread-
sheet, information about the last 20 rounds on file will also be exported - for
each round:

Date
Club

Course

+ Tee

* Score

* Adjusted score

* Playing handicap (Course Handicap, etc.)
* Net score

* Tournament score (yes or no)

* Ignored for handicapping (yes or no)

* Scoring complete (yes or no)

* Trend handicap

Spreadsheet Player Information

< A | 3 [ C [ D [ E [ F [ G [ H [ I
1 |Name Gander | Street Address City, ST | Phone Call/Fax abdail Home Club Membe
| 2 |AlCzarvik M 3244 Industrial Hwy. Mutley, NJ 10233  555-5454 555-5444 Bushwood Cou

3 Date Club Course (Tee | Score | Adjustad Hdep Net| Tournam
4 1-Apr-0% Gountry Glub Golf Course | Men's Teas az az 21 71 No
5 | 20-Dec-08 Country Club | Golf Course Men's Teas | 23 23 15| 78 Yes
6 | 23-Mov-08 Gauniry Glub Golf Course Championship Tees 8z 8z 16 76 No
7 | 15-Nov-08 Country Club | Golf Course | Championship Tees | o1 o1 16 75 No
8 S-Nov-08 Gountry Glub Golf Course | Men's Teas az az 16 TE No
9 | 4-Nov-08 Counlry Club | Golf Course | Men's Teas B9 B9 18 73 No
10 | 3-MNov-08 Gountry Glub Golf Course | Men's Teas ] ] 16 73 No
11 1-Mav-02 | Bushwooed Cauntry Club | Bushwood Golf Course Men's Teas Ll Ll 16 & No
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Exporting Data About a Player’s Rounds to a Spreadsheet

You can export detailed information about one or more selected rounds for
a player to an open spreadsheet. Open an editing window for the player and
select the Scores panel. With Eagle frontmost, select the rounds of interest
and drag the selection to the spreadsheet:

oL Course ~
Bushwood GolFCourse (@]
31 Oct 2008 Bushwood Country Club Bushwood Golf Course ':\
4 Jul 2008 Bushwood Country Club Bushwood Golf Course \_\.-
22 Jun 2008 Bushwood Country Club Bushwood Golf Course &)
8 Jun 2008 Bushwood Country Club Bushwood Golf Course C
7 Jun 2008 | Bushwood Country Club Bushwood Golf Course '.’__\

Dragging a selected list of rounds to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
each selected round:

* Player name

* Date

+ Club

+ Course

* Tee

* Gross score

* Playing Handicap (Course Handicap, etc.)

* Net score

* Adjusted gross score

* Trend handicap
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The data is organized in a tabular array, one round per row, when inserted
into the spreadsheet:

80

Helvetica -m B I U

Spreadsheet Rounds List

< A | [ C [ D | E | | |
1 |Al Czarvik | Saturday. Movember 15, 2008 Bushwood Cauntry Club Goll Coursa  Cl a1 16 75
2 | Al Czenvik 5, 2008 Gaountry Glub Bushwood Golf Course  Men's Teas 82 16 76
3 | Al Czarvik Tuesday, Novernber 4, 2008 Bushwood Cauntry Club Bushwood Golf Course  Men's Teas 89 16 73
4 | Al Czarvik Monday, Movember 3, 2008 Bushwood Gountry Glub Bushwood Golf Course  Men's Teas &9 16 73
5 |Al Czarvik Saturday, Movernber 1, 2008 Bushwood Country Club Bushwood Goll Course  Men's Teas a1 16 75
6
7
8
| 9
10

If your spreadsheet application has difficulty importing data dragged from
Eagle (no columnar results, improperly interpreted numbers or spacing, etc.),
you may need to change the format of the dragged information. See “Drag
& Drop data delimiters” on page 17 for more information.

Reports About Players

Stats & Records Report

With an open editing window for a player front-most, or one or more players
selected in Eagle’s main window, choose Stats & Records Report... from the
Reports menu. A sheet will be displayed:

rer
Doctal
Al Cze
Mary
Tony
Earl H
Frieda
Danny
Judge
Spaul
Ty Wel

[+
L |

Stats & Records Report
For Al Czervik...

elast rounds

(O rounds from |Tue5day, January 1, 2008 @
through |Wednesday, December 31, 2008 @
rounds at | Bushwi ount u
ds at [ Bushwood Country Club
on [_. Bushwood Golf Course H

O selected rounds

(O all rounds

20 rounds selected

( Cancel ) E—Shun-hpuﬂ—a

1
1
1
[
1
3
5

(]

LIS

Stats & Records - Player
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Choose the rounds to be analyzed, which includes a particular number of
rounds, rounds between two dates, rounds at a particular club or course,
selected rounds (when the Scores panel of the player editing window is
front-most) or all rounds on file. When you've decided which rounds should
be included on the report, click the Show Report button.

If you've selected more than one player for whom you want to perform the

analysis, the sheet is slightly different:

Jer |

I
Docta Stats & Records Report 1
Al Czq 1
Mary ( For selected Players... 6
Tony ™ Combine: lCzervik Family 1
Earl H 3
Frieda lize 5
Danny f —
judge @ last 20 rounds )

Spaul
Ty we (O rounds from | Thursday, January 1, 2009

through Tuesday, February 3, 2009
1 E an | . ry

‘ (O rounds at [ Bushwood Country Club

HE oo
L

on | " Bushwood Golf Course

M
(_) selected rounds

(O all rounds

1 report requested

(cancel ) ( Show Report )

Stats & Records - Multiple

In addition to the selection of rounds as previously described, you can elect
to consolidate the stats and records of a group. To do so, just check the
Combine box, and if you wish, provide a name for the group (like “Varsity,”
or “A Team,” or “Family Records”) to appear on the report. When the box
isn't checked, a separate report is produced for each selected player, using
the same criteria for selecting the rounds. Click the Show Report button to
continue.

Note: When you specify a large number (many hundreds) of rounds to be evaluated,

there may be a delay until the report appears on your screen.
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Eagle will process information from the selected rounds and open a report of
the statistics and records for that data:

800

Stats & Records Report

Scoring
Gross

Birdies &
better

Pars

Bogies

Double
Bogies
&worse

3's

5's

Holes

% holes
18 holes
Average
% holes
18 holes
Average
5 hales
18 holes
Consec.
% holes
18 holes
Consec.
% holes
18 holes
Cansec.
5 hales
18 holes
Consec.
% holes
18 holes
Consec.
% holes
18 holes
Cansec.
5 hales
18 holes
Consec.

Average

42
81

10
64

No. times

2

Stats & Records Report

Date
4 Jul 2008
20 May 2008

45.3 /9 holes

2}

4 Jul 2009
20 May 2008

55.0 /% holes

3

4 Mov 2008
8 Jun 2008
4 Nov 2008
4 Jul 2008
4 Jul 2009
4 Jul 2009
1 Apr 2009
1 Apr 2009
1 Apr 2009
5 Mov 2008
20 Dec 2008
1 Apr 2009
4 Jul 2009
4 Jul 2008
4 Jul 2009
4 Jul 2009
8 Jun 2008
4 Jul 2009
28 Feb 2009
5 Nov 2008
1 Apr 2009
Par 3's

Al Czervik

All rounds

(38 rounds)
Bushwood Country Club {(Bushwood Golf Course}, Back Nine
Bushwood Country Club (Bushwood Golf Course)
90.8 /18 holes 45.7 /Frant 44.8 [Back

Bushwood Country Club, Back Nine
Bushwood Country Club (Bushwood Golf Course)
73.3 /18 holes 76.0 /Frant 32.1 /Back

Bushwood Country Club (Bushwood Golf Course), Front Nine
Bushwood Country Club (Bushwood Golf Course}
Bushwood Country Club (Bushwood Golf Course), No. 3

Bushwood Country Club {(Bushwood Golf Course}, Back Nine
Bushwood Country Club
Bushwood Country Club, No. 2-4

Bushwood Country Club, Front Nine

Bushwood Country Club

Bushwood Country Club, No. 6-10

Bushwood Country Club (Bushwood Golf Course), Back Nine
Bushwood Country Club

Bushwood Country Club, No. 11-12

Bushwood Country Club, Back Nine

Bushwood Country Club (Bushwood Golf Course)
Bushwood Country Club, No. 17

Bushwood Country Club, Back Nine

Bushwood Country Club (Bushwood Golf Course)
Bushwood Country Club, No. 11-12

Bushwood Country Club, Back Nine

Bushwood Country Club (Bushwood Golf Course}
Bushwood Country Club, No. 13-16

4.3 Far4’s 5.1 Par5's 5.6

Stats & Records Report

You can review the reports as shown on your screen, or you can send them to
your printer for a hardcopy. To print, choose Print... from the File menu or

type P (commanD-P).

Ringer Card

A ringer scorecard (also called an “eclectic” scorecard) is a scorecard for
a particular course or tee that includes the best gross score the player has

accomplished on each hole over a period of time.
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With an open editing window for a player front-most, or one or more play-
ers selected in Eagle’s main window, choose Ringer Card... from the Reports
menu. Eagle will display a ringer card for each of the selected players:

O
; I“I:‘l_ Club: | Bushwood Country Club j From: l Tuesday, January 1, 2005] @
Course: | Bushwood Golf Course _ﬂ Through:  Wednesday, December 31, 2008 O
Sides: [ Frant Nine l-G-‘ [ Back Nine l-%]
112|314 ([5[6|7|8|9|0ut|10[11]12]|13]|14[15[16[17|1&| In | Tot
Men's Tees |402|166|504|360(384|180(479(362|390| 3227 [480[366|402 14 4|165(484( 3150|6377 | 70.20127
Par (4 |3 |5|4(|4|3|5(4 (4|36 ([5(4[4|4|3|4|4|3|5([36)72
Handicap [ 5 |[17| 1 [11]9 |15) 3 [13|7 6 |14 2 [10[18] & [12[16] 4
[OR Estimated Handicap: | 181 (26 rounds}
AlCzervik [5[4[4Ja[5]3[a[5[4a[38[5][5[6[4[3[5[5]a[5[42[80]18]62]
puts [2 [2 [1 ]2 2]z 1 Ja]e]6[a]e]1[e]1 a2z 17 ]33]

Ringer Card
Club — Select the club at which the rounds were played.

Course — If there’s more than one course at the club, selected the appropriate
course.

From —Type or set the beginning date to be used for selecting the rounds to
be examined to determine the ringer scores.

Through —Type set the ending date to be used for selecting the rounds to be
examined.

Use the tee selector popup menu to indicate a particular tee from which
rounds are selected, or choose All Tees in that menu to use any rounds at the
selected course, regardless of the tee that was played.

'The ringer card will display the number of rounds selected, and the hole-by-
hole ringer scores and ringer putts, if they’re available. You can provide an
illustrative handicap index or handicap to compute a theoretical net score for
the ringer card.

Print the ringer card by choosing Print... from the File menu or by typing
P (commanD-P).
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Course Analysis Report

With an open editing window for a player front-most, or one or more players
selected in Eagle’s main window, choose Course Analysis Report... from the
Reports menu. A sheet will be displayed:

Course Performance Analysis

AlCze )

Mary For Al Czervik...

Tony rounds at | Bushwood Country Club H

Earl H 3
Frieda on [ " Bushwood Golf Course H 5
Janny an .

Judge _| Combine: |

spaul

Ty Wel - Use...

E ® last rounds

‘ (O rounds from | Tuesday, January 1, 2008

WL

(3 (03

through _Wednesday, December 31, 2008

(O all rounds

19 rounds selectad

(" cancel ) (* Show Report )

Course Performance - Selection

Choose the rounds to be analyzed, first by identifying the particular golf
course for which the analysis is to be done, then identifying a particular
number of rounds, rounds between two dates, or all rounds on file. When
you've decided which rounds should be included on the report, click the
Show Report button.

Note: When you specify a large number (many hundreds) of rounds to be evaluated,

there may be a delay until the report appears on your screen.
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S S ———

Eagle will process information from the selected rounds and open a Course

Analysis report for that data:

Course Performance Analysis
Al Czervik
Bushweod Country Club - all rounds
Front Nine (36 rounds)
1 2 3 4 5 6 7 B 9 Total
Ydg AUZ-A1Z 185183 S04-522 380385 384384 180195 470403 380878 300401 3273354
Par 4 3 5 4 4 3 5 4 4 36
Handicap 5 17 1 11 9 15 3 13 7
Cross
Range 4-5 3-8 4-8 4-8 4-5 3-8 59 57 4-7 43-49
Average 52 4.5 5.4 45 52 4.2 6.0 52 5.0 457
vs. Par +1.2 +1.5 +0.4 +0.9 +1.2 +1.2 +1.0 +1.2 +1.0 8.7
Net
Range 35 36 35 35 35 25 4-8 4-6 3-6 10-545
Average 41 4.4 4.3 39 4.2 az 4.9 4.2 4.0 768.0 W
ws. Par +0.1 +1.4 -0.7 -0.1 +0.2 +0.2 -0.1 +0.2 0.0 +40.0
Putts
Range 2 1-2 1-2 1-2 o-2 2 1-3 23 2 14-18
Average 20 1.7 1.3 1.7 1.0 20 1.7 27 20 16.0
Fairways 33% 33% B7% 33% 0% B7% 0 33%
Greens [ [15) 67 %% [ [15) 0% B7% 3% 19%
Sand
Sawe Try 2 none 11 none none (] none o none 1/5
Pct. 0% 100% [119 %% 208
Penalty
v
/i

Course Performance Report

You can review the reports as shown on your screen, or you can send them to
your printer for a hardcopy. To print, choose Print... from the File menu or
type P (commanD-P).
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Handicap Report

With an open editing window for a player front-most, or one or more play-
ers selected in Eagle’s main window, choose Handicap Report... from the
Reports menu. A sheet will be displayed:

Doctol Handicap Report !
Al Cze ) 1
Mary For Al Czervik... €
r"”l'V Through: IWednesday, December 31, 2008 I @ !
Earl H

Frieda "1 Update Handicap Records

Janny 1 report requested

udge 1
paul ( Cancel ) Hhurhywb—) .
Ty Wel

—
10 Players, 1 selectad

[+][=]l~] B[ <]
Handicap Report - Selection

Through — Enter the date through which rounds should be used to produce
the handicap report.

Update Handicap Records — Check the box if you wish to have Eagle con-
struct and save a handicapping record for the player with an effective date
immediately following the Through date above.
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When you've set the effective date, click the Show Reports button and
Eagle open a Handicap Report for the selected players:

(o N Né)] Handicap Report
'y
)
Handicap Report
Al Czervik
Through Wednesday, December 31, 2008
Score History
Used Type Date Biteer Ratings Diff. | Course
20 Dec 2008 95 70.2/127 22.1 Bushwood Country Club
29 Nowv 2008 92 71.5/132 17.5 Bushwood Country Club
* 15 Mow 2008 91 71.5/132 16.7 Bushwood Country Club
5 Now 2008 92 70.2/127 19.4 Bushwood Country Club
* 4 Nov 2008 89 70.2/127 16.7 Bushwood Country Club
* 3 Nov 2008 89 70.2/127 16.7 Bushwood Country Club
1 MNowv 2008 91 70.2/127 18.5 Bushwood Country Club
* 4 Jul 2008 88 70.2/127 15.8 Bushwood Country Club
* 4 Jul 2008 87 70.2/127 14.9 Bushwood Country Club
22 Jun 2008 91 70.2/127 18.5 Bushwood Country Club
* 8 Jun 2008 87 71.5/132 13.3 Bushwood Country Club
7 Jun 2008 94 70.2/127 21.2 Bushwood Country Club
* T 23 May 2008 82 70.2/127 10.5 Bushwood Country Club
* T 20 May 2008 8l 70.2/127 5.6 Bushwood Country Club
* 18 May 2008 87 70.2/127 14.9 Bushwood Country Club
* 16 May 2008 88 70.2/127 15.8 Bushwood Country Club
11 May 2008 100 70.2/127  26.5 Bushwood Country Club
16 Apr 2008 91 70.2/127 18.5 Bushwood Country Club
11 Apr 2008 90 70.2/127 17.6 Bushwood Country Club
4 Apr 2008 94 71.5/132 15.3 Bushwood Country Club
Lowest Differentials of 2 Eligible Tournament Scores
Used Type Date Sec... Ratings Diff.  Course
= T 20 May 2008 81 70.2/127 9.6 Bushwood Country Club
* T 23 May 2008 82 70.2/127 10.5 Bushwood Country Club
Home Club Handicaps
Handicap Index®: 13.9 Bushwood Country Club
30 Dec 2008 14.1 ' Championship Tees 15 &/
30 Nov 2008 13.2 () Men’s Tees 15
30 Sep 2008 13.9
30 May 2008 14.1
30 Apr 2008 15.4
v
P

Handicap Report

You can review the reports as shown on your screen, or you can send them to
your printer for a hardcopy. To print, choose Print... from the File menu or
type P (commanD-P).
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Play List

A Play List is a handicapping report for golfers playing in an event or at a
scheduled outing. With one or more players selected in Eagle’s main win-
dow, choose Play List... from the Reports menu. A sheet will be displayed:

Docl Play List 12.4
Al C 14.1
Man For selected Players... ; 34.6
Earl Play at [ Bushwood Country Club l'é'] Sy
Frie 15.6
Agn on | gs Bushwood Country Club I-E'] 42.3L
Judg - . 13.5
Ty Using handicaps ST
effective IMondi{v, March 1, 2010 I @

from ) Players’ preferred tees
(O Tee: | @ Championship Tees i

CCanceI) E Show Report 3

8 of 12 Players, B selected

Play List - Selection
Play at — Choose the golf club at which play will take place.
on — Choose the course on which play will take place.

Using handicaps effective — If necessary, enter or adjust the date of
competition.

from — Decide to calculate players’ handicaps from their preferred tees or
from a particular tee. Choose the tee if necessary.

Note: If an Event window is frontmost when you choose Play List from the
Reports menu, the sheet shown above is not displayed. "Ihe information to appear
on the report (golf course, effective date, and players tee selections) is determined by
the settings already in place for the event.
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When you've selected the appropriate settings, click the Show Report but-
ton and Eagle open a Play List for the selected players:
W
Bushwood Country Club
Champicnship Tees - 1 Mar 2010

Player Member Phone Tee  Handicap Index® | Course Handicap

Y Al Czervik 234 555-5454 () = 14.1 16
£ Mary Czervik 234L @ 34.6 43
‘ Earl Havercamp B-141| (323) 825-... O = 8.7 10
i Frieda Havercamp 1600 (323) 825-... @ ¢ 15.6 19
£ Agnes smails @ : 37.8 47
B Judge Smails 5375 O . 13.5 16
B Ty Webh W-303 (888) 345-... O : 1.3 z

)

Play List

You can review the report on your screen, or you can send it to your printer
for a hardcopy. To print, choose Print... from the File menu or type 3P
(commAaND-P).

Handicap Cards

You can print standard or customized handicap cards for players in your golf
club or association. See details about producing these cards in “Handicap

Cards” on page 149.
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Guests

If you keep scoring histories for a large group of people, like a golf club,
league or team and you also have a number of occasional players or guests for
whom you keep event scores but don't monitor performance or compute a
handicap, you can identify those non-member individuals to be excluded in
some cases from lists of players. Mulligan’s Eagle calls these players “guests”
and allows you to identify them when they’re set up on your computer (see
“Player Preferences” on page 52).

In Eagle’s list of players in the main window, guests can be identified by the
tiny letter “G” next to their g or Gﬁ icon:

800 Mulligan's Eagle™

Home Club

4 Doctor Beeper Bushwood Country Club
'. Al Czervik Bushwood Country Club
5 Mary Czervik Bushwood Country Club
4 Tony D'Annunzic Bushwood Country Club
B Earl Havercamp Bushwood Country Club
5 Frieda Havercamp Bushwood Country Club
< Danny Noonan Bushwood Country Club
B Judge Smails Bushwood Country Club
Y Spaulding Smails
Gﬁ Lacy Underall Bushwood Country Club
BT Webb Bushwood Country Club
11 Players
& [+-1l7

Player List - including 4 “Guests”

You can temporarily hide guests in a list of players by choosing Hide Guests
from the Golf menu or by typing X 3G (opTION-COMMAND-G).

e00 Mulligan's Eagle™

Home Club

@ Doctor Beeper Bushwood Country Club
'. Al Czervik Bushwood Country Club
§ Mary Czervik Bushwood Country Club
B Earl Havercamp Bushwood Country Club
§ Frieda Havercamp Bushwood Country Club
by Judge Smails Bushwood Country Club
BTy Webb Bushwood Country Club

7 of 11 Players

& [+[-l7

Player List - 4 guests hidden
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Deleting Players

Re-display the guest players by choosing Show Guests from the Golf menu
or typing \ 3G (oPTION-COMMAND-G).

Deleting Players

With Eagle’s main window front-most, show the list of players, select (click,
sHIFT-click or commaND-click) the players to be deleted, then click the
Remove button at the lower left corner. Or choose Delete from the Edit
menu, or type & (DELETE). You will be asked to confirm that you really want
to delete the player(s). Click OK to delete or Cancel to continue without
deleting.

Deletion is permanent and cannot be undone. The player’s rounds will
remain on their scorecards, but cannot be modified. When a player is
deleted, all of the demographic information, preferences and handicapping
history for that player deleted too.

Note: If the Remove button is not available (the button is dim), either there are
no players in the list selected ' for deletion or the Player list has been locked to prevent
the addition or removal of players.
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Chapter 4

Scorecards

Scorecards are, as you would expect, the places where players’scores are kept.

-
Tl

'Ihey can contain scores for one or more COIIlpCtitOI‘S and team scores that

represent combinations of individual scores (like four-ball scores) or scores
for balls played by more than one player (like foursome or scramble scores).

Mulligan’s Eagle uses the symbol at the left to represent information on a
scorecard.

In this Chapter...
Creating New Scorecards 76
Editing Scorecards 79
Opening an Existing Scorecard . .......................... 79
Configuring a Scorecard. .. ........ ... ... o L oo 79
Competition Scoring . ........... . i i 81
Scorecard Options . . ...t 82
Players Rounds ........ ... ... . . o 84
Player Round Options . .......... ... .. 86
Adding Rounds to a Scorecard 87
AddingaPlayer........ ... ... il 87
AddingaTeam Round. ............... . ..o ooiiiiL 89
Team Round Options ........ ..., 90
Adding and Removing Teammates . ....................... 91
Scoring 92
Entering Scores . ........ .. 92
Entering Putts and Other Detail . . . ....................... 93
Competition Scoring — Player’s Rounds .................... 95
Competition Scoring — Scorecard ................. ... ..... 95
Importing Scores 96
From Mulligan Scoring Data Files ........................ 96
From Dropbox......... ... . i 98
FromiCloud. ...... ... ... .. 99
Exporting Scorecard Information 100
Printing Scorecards .......... ... .. ... o oo 100
Exporting to a Mulligan Scoring File .................. ... 101
Exporting a List of Scorecards to a Spreadsheet ............. 102
Exporting Scorecard Data to a Spreadsheet. . ............... 103

Deleting Scorecards 104
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Creating New Scorecards

Creating New Scorecards

Except when creating scorecards automatically by adding competitors to an
event, you will create a new scorecard any time you need to enter scores for a
player. There are several ways to start:

From Eagle’s Main Window

With Eagle’s main window front-most, show the list of scorecards, then click
the Add button at the lower left corner to continue opening a dialog where
you can select the players to appear on the scorecard.

Note: If the Add button is not available (the button is dim), the scorecard list has
been locked to prevent the addition or removal of scorecards (see ” on page 11).

Or, from the main window, show the list of players, hold the ~ (opTION) key
down and double-click the name of a player. Eagle will open a new score-
card for that player. If the player has a “preferred” course, the scorecard will
be configured for that course and the player’s preferred tees.

Or, from the main window, show the list of players and select all the players
to appear on one or separate scorecards. To make a single scorecard contain-
ing all the selected players, choose Scorecard for Selected Players from
the Players section of the Golf menu or type $S (COMMAND-S). To open

a separate scorecard for each of the selected players, choose Scorecards for
Selected Players from the Players section of the Golf menu or type 4> 38S
(SHIFT-COMMAND-S).

Note: If the menu option is not available (the item is dim and inactive), there are
no players selected in the list or the scorecards list has been locked to prevent the
addition and removal of scorecards (see ” on page 11).

Or, from the main window, show the list of players and select all the players
to appear on one or separate scorecards. To make a single scorecard contain-
ing all the selected players, click the Make Scorecard button at the bottom
right of the main window. To open a separate scorecard for each of the
selected players, hold down the C (OPTION) key and click the Make
Scorecard button.

Note: If the Make Scorecard button is not available (the button is dim), there are
no players selected in the list or the scorecards list has been locked to prevent the
addition or removal of scorecards (see ” on page 11).
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From the New Menu

Or, choose New... in the File menu or type 8N (COMMAND-N) to see a dia-
log allowing you to make a new item:

o MNew

Create a new...

O a Player - a golfer for whom you want to keep

information, like scores, statistics or a handicap.

A
O “ Club - a golf club, with one or more 9 or 18-hole
golf courses, where you and your friends play golf.

(MG ]
8 ] Scorecard - a scoring record for you or a group of
golfers, on a particular golf course.

O % Event - a golf event, with multiple players or teams
and special scoring and handicapping requirements.

@ (Cancal) o)

New Dialog

Select the option to make a new scorecard, then click the New button. You
will continue by selecting the players to appear on that new scorecard.

Note: If the new scorecard option is not available (the button is dim), the scorecard
list has been locked to prevent the addition or removal of scorecards (see ” on page

11).

From the New... Submenu

® Eagle JEY Edit Golf Reports Window Help

New... #N
Open #0
Recent > # Player 8P
Import > @ Club N8C
Close IpW ‘?' Event #HE

= 4 A
38 M

Page Setup... {r#P 4 Match...
Print... ¥p |

New Submenu

Or, choose Scorecard in the New... submenu in the File menu, or type X3S
(OPTION-COMMAND-S) to create a new scorecard and continue by selecting
the players to appear on it.

Note: If the menu option is not available (the Scorecard item is dim and disabled),
the scorecard list has been locked to prevent the addition or removal of scorecards

on page 11).

«»

(see
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From a Player Window

16 Apr 2008 Bushwoed Cou

ou

Or, with an editing window for a player front-most, show the Scores panel,
then click the Add button at the lower left corner. Eagle will open a new
scorecard for the player.

Nofte: If the Add button is not available (the button is dim), the scorecard list has
been locked to prevent the addition or removal of scorecards.

Or, with an editing window for a player front-most, show the Scores panel,
then choose Scorecard for Selected Players from the Players section of
the Golf menu or type S (COMMAND-S).

Note: If the menu option is not available (the item is dim and inactive), the score-
card list has been locked to prevent the addition and removal of scorecards (see ” on
page 11).

If the player has a “preferred” course, the new scorecard will be configured for
that course and the player’s preferred tees.

Selecting Players for a Scorecard

Select Players... (Qall )
Flayer | Club | City |
4 Doctor Beeper Bushwood Country Club West Bushwood, NJ

zervik Bushwood Country Club Bushwood, M)
rT Mary Czervik Bushwood Country Club Nutley, NJ
B Earl Havercamp Bushwood Country Club Carden City, NJ
i Frieda Havercamp Bushwood Country Club Garden City, NJ
B Judge Smails Bushwood Country Club
BT Webb Bushwood Country Club Chicago, IL
# Quick Add (" cancel ) ( New Scorecard )
A
Player Selection

In the New Scorecard dialog, select the player or players to appear on that
scorecard, then click New Scorecard. A new scorecard window will open
with all of the selected players assigned to the scorecard. Continue setting
up the scorecard like you would when editing an existing scorecard.

If you decide not to make a new scorecard, just click Cancel to proceed.

Note: ‘Ihere are no ‘empty” scorecards in Mulligans Eagle. At least one round
must appear on a scorecard and if that round is removed, the scorecard itself is
automatically deleted.
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Editing Scorecards

Opening an Existing Scorecard

Show the list of scorecards in Eagle’s main window and select the scorecards
for which you need to change information. Click the Edit button at the
lower left corner and each of the selected scorecards will be opened for you
to review information and make changes.

Or, open the scorecards by selecting them in the list and choosing Open
from the File menu or typing $0 (COMMAND-O0).

Or, just double-click the name of a scorecard in the scorecard list.

Note: If the Edit button is not available (the button is dim), there are no scorecards
selected in the list. Scorecards can be edited even when the scorecard list is locked.

16 apr 2008 muswocd coc O, with an editing window for a player front-most, show the Scores panel.

; . To open a scorecard for a round in the list, select the rounds of interest and
click the Edit button at the lower left corner. The scorecards containing the
selected rounds will be opened for your review. You may also open scorecards
for the selected rounds by choosing Open from the File menu, typing 30
(COMMAND-O0), or simply double-clicking a round in the list.

Configuring a Scorecard

A scorecard window contains all the information about a round of golf

for one or more players. When opening a new scorecard, considering the
player’s preferred course and tees, Eagle makes a “best guess” about how the
scorecard should be set up.

Club | Bushwood Country Club H Date Saturday, December 20, 2008

8
Course |Bushwnod Golf Course H Tee 1 Time @
Sides [ Front Nine %] [ Back Nine [ ) |EOpliDns .
112]|3|4([5[6|7|8|9|0ut|10[11]12]13]14[15[16[17|1&| In | Tot
Men's Tees |402|166(504|360(384|180(479|362|390| 3227 |480(366|402|355|145|366|364(165|484| 3150 | 6377 70.2M27
Ladies’ Tees (380[1 340|114 2892 |4 1|120]|450( 2856 [ 5748 71.1128
Par (4|3 |5 |4 (4[3|5|4|4|36 |5|4|4|4|3[4([4[3|5]|36]|72
& Handicap |5 |17[1 [11|9 |15]|3 [13|7 6 |14 2 [10[18]| & [12[16] 4
% Handicap | 5 [15[3 13|11 171 |8 |7 4 14| 6 [10[16]| & [12{18] 2
A @] ;]‘ Handicap Index®: 185 Putts | + | ¥+ |C)plionSV|6

AlCzervik [5][6[7]4[5]a[a]6[5[a6[5[5[7[5[a[6[5]a[7[ar[93]21]72]

B [E Handicap Index@: 65.0 | Putts | 4+ | E 3 |Gplions'|6
Mary Czervik [9 [8 [10]8 [9[8]6 |7 (10| 75 |8 |5 [8 [11]7]5]8[9[9] 70 [145] 74 | 71 |

Configuring a Scorecard

Club — Start typing the name of the golf club or choose the club at which the
rounds on this scorecard were played. This field is not editable on scorecards
associated with an event.
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Course — Choose the course at this club on which the rounds were played.
'This field is not editable on scorecards associated with an event.

Date — A date for the rounds on this scorecard is required. The date, by
default, is set to the current date, but a date in the past or a date in the future
is valid. This date cannot be changed on scorecards associated with an event.

Tee — It is assumed that the rounds begin on the tee of the 1st hole. If the
round begins on another tee, enter that number. You may also use modify-
ing alphabetic characters (ie: “1A,”“6B,” etc.) to indicate the first or second
group from the specified tee.

Time —The tee time is usually only needed for events in which the com-
petitors start at different times from the same tees. Enter or increment or
decrement the time to set a tee time.

Sides — Make sure the popup menus for the front and back side reflect

the nines that were played in this round. For courses with more than two
nines, select the nines played as the front and back side. The sides cannot be
changed on a scorecard associated with an event.

Note: If you are recording rounds on a scorecard for players who played the course
in an unusual manner (Back Nine  first, same nine twice, efr. ), there are no restric-
tions on how you configure the scorecard or record the scores. If the rounds will

be compared to those of other players on other scorecards - matching rounds in

some fashion, it is easier to do so by configuring all the scorecards using the same
sides. Scorecards for a “shotgun’ start, where players start at the same time from
different tees, should be configured normally (Front Nine, Back Nine) though dif-
ferent players may not play the holes in precisely that order. Scorecards for events
are automatically configured identically, and the club, course and sides cannot be
altered on those individual scorecards.

If the rounds recorded on this scorecard are 9-hole rounds, make sure the
front side popup menu indicates the nine played and the back side popup
menu is set to hone:

Sides [FronrNine l-%-l [ none I-G-] |E(}plinns -

1](2[3]4]5]6]7]8]9]0u Tot
CF i “",_ Tees [412)1 79[401 (3364 3364 35.8M132
Par (4|3 |5|4|4(|3|5|4|4]36 36
Handicap |5 (171 [11]9 [15]3 [13]7

Ty - . a . a

9-Hole Rounds

When only 9 holes are selected on a scorecard, total yardage, par, and the
playing handicaps of the players will be adjusted accordingly.

Options — Click the button to show a menu to choose scorecard-specific
actions or settings. See “Scorecard Options” on page 82 for details.
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Hole numbers, Lengths, Par and Handicaps — When you have indicated
the club, course and sides for this scorecard, the scorecard window will dis-
play the hole numbers, yardages, par and hole handicaps for the tees chosen
for the players on the card:

Sides | Front Nine I+ | Back Nine W& |Hoptions T

1]2[3[4]5]6]7]8]9 ] out[10[11]12[13]14[15[16]17][18] In | Tot
Men's Tees |402|166(504|360(384|180(479|362|390| 3227 |480[366(402 (355|145 |366|364(165(484| 3150 | 6377 70.2M27
Ladies" Tees |380[1 340|114 2892 |438(3. 1|1120|450( 2856 | 5748 71.1128

Par [4 |3 |5|4|4|3|5|4|4|36|5|4|a|4|3]|a|a|3|5]|36]72

M Handicap | 5 [17]1 |11]9 |15|3 |13|7 6 |14| 2 [10[18]| & [12[16] 4
i Handicap | 5 [15[3 [13|11|17]1 |9 |7 4 |14| 6 [10[16]| & [12{18] 2
Tees, Par ¢ Handicaps

If there are gender differences in par or the hole handicaps (as illustrated
above), they are shown separately. The Course Rating and Slope Rating for
rounds played from each tee are shown to the right. As players are added or
removed from the scorecard, or their chosen tee changes, there will be corre-
sponding changes to this displayed information on the scorecard.

Competition Scoring

In addition to the player’s gross scores, handicap and net result, scorecards
include another layer of information — competition scoring. If the player’s
score needs to be calculated as Stableford points, determined from a special
handicap allowance, or compared to teammates on the same scorecard, those
“extra” results are competition scoring. In an event, competition scoring

is frequently the result that appears on the scoreboard. Without an event,
Eagle provides features to let you review and configure competition scores
for each player’s round or for the whole scorecard. By default, the competi-
tion scores for a player’s round are their hole-by-hole net scores using their
playing handicap - or medal play with a full handicap allowance. Both the
style of play and the allowance can be changed to produce different results.

Mulligan’s Eagle uses a trophy symbol to represent those features of the
software related to competition scoring.

Some competition scoring features apply to all the rounds on the score-

card. Those features are configurable by setting scorecard options, which are
described in the next section. Other competition scoring capabilities are spe-
cific to an individual player’s round and those features are controlled by the
Competition Scores item discussed with “Player Round Options” on page
86. Generally, if a scorecard and its rounds are associated with an event,

the settings for competition scoring are dictated by that event and are not
modifiable on the scorecard.
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Scorecard Options

'The scorecard Options menu allows you to choose certain scorecard-specific
actions and settings. Click the Options button to show a drop-down menu:

In & Add a Player to this Scorecard... {r38A
11
15 Show Notes 138N
| Tournament Scorecard 8T
—  Adjust for Tee Ratings {+36R
. Show Skins {+ 38K
a7 | !
—= ; Competition Summary... D
‘_ & Competition »
T I Competition Allowances [
4 Add a Team Score >
‘ “4& Martch TEM
Print this Scorecard... 3P
‘?. Event...

Scorecard Options

Add a Player to this Scorecard — Choose this menu item or type <A
(SHIFT-COMMAND-A) to open a sheet on this scorecard window to add a

round for another player to the scorecard. See “Adding a Player” on page
87 for details.

Show (Hide) Notes — Choose this menu item or type <3N (SHIFT-COM-
MAND-N) to show or hide a drawer to enter notes about the scorecard:

ID? Nl Notes Clear || Close
o Driving rain storm. Winds 20, 3
] [+) | clubs on most holes.

Notes

You can type whatever you like in the window. Clear the notes by clicking
the Clear button on the drawer. Close the drawer by clicking the Close but-
ton on the drawer or typing <3N again. A little blue indicator adjacent to
the Options button reminds you that there are notes on file.
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B<

B<

B<

Tournament Scorecard — When checked (v/), indicates that this is a “tour-
nament” scorecard, a status that might effect handicapping calculations for
the player’s rounds. When unmarked, indicates that this is not a tourna-
ment scorecard. Choose this menu item or type 3T (SHIFT-COMMAND-T)
to identify the rounds on this scorecard as tournament or “organized com-
petition” scores. Scorecards for these rounds are also indicated by a little T
symbol adjacent to the scorecard Options button:

8 [Eomon <

In | Tot

Note: 'The “tournament scorecard” status describes the scorecard, not the rounds. If
you have rounds on a tournament scorecard that aren’t tournament rounds, you
should create another scorecard for them.

Note: If the Tournament Scorecard menu option is dim and unavailable
(checked or unchecked), the scorecard’s “tournament scorecard” status is controlled by
an associated event (see “Record as Tournament scores” page 111).

Adjust for Tee Ratings — When checked (v), indicates that handicap allow-
ances on this scorecard are being adjusted for differences in Course Ratings
for play from different tees (or different genders from the same tee). If
unchecked, no ratings adjustment has been calculated. Choose this menu
item or type ¢+ 3R (SHIFT-COMMAND-R) to make or clear the allowance
adjustment.

Show (Hide) Skins — Choose this menu item or type {*3K (SHIFT-
COMMAND-K) to show or hide holes that are computed as “skins” on this
scorecard or in the event associated with this scorecard. Holes scored as
“skins” are displayed with a special colored background.

Competition Summary — Choose this item or type 3D (COMMAND-D) to
display a sheet showing the competition scoring summary for this scorecard,
described at “Competition Scoring — Scorecard” on page 95.

Competition — Select the type of individual competition scoring to be used
on this scorecard. The default setting is Medal Play (stroke play). See
discussion of “Competition Scoring” on page 81. For descriptions of
competitions that may be unfamiliar, see the “Glossary” on page 201.

Competition Allowances — Select the type of handicap allowance for
computing competition scores on this scorecard. The default setting is Full
Handicap. See discussion of “Competition Scoring” on page 81.

Add a Team Score — Select a style of team score to be added to the score-
card. A team score might be calculated from individual player scores on this
scorecard (like four-ball) or represent a score made by the teammates playing
one ball (like foursomes). For descriptions of team competitions that may be
unfamiliar, see the “Glossary” on page 201.
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'The preceding 3 options - Competition, Competition Allowances, and
Add a Team Score - allow you to set up inter-player competition, use spe-
cial allowances or add a team round score to #his scorecard only. For example,
you can set up a 9-Point Game competition for 3 players, with the A-player
playing scratch. Or, you can add a team score of 2 Best-Balls that will be
computed automatically and might be used for scoring a match against a
team on another scorecard. Adding these competitions or rounds to the
scorecard have no effect on the scoring history of the player. These compe-
tition features are not configurable on a scorecard associated with an event.
'The event dictates what kinds of competition, allowances and team scoring
appear on its scorecards.

Match... — If the scorecard includes rounds for just one or two players,
choose this menu item, or type .M (OPTION-COMMAND-M), to open a
Match window for a match between the players.

Print this Scorecard... — Open the printing dialog to print this scorecard.
Event... — If this scorecard is associated with an event, open the window for
that event and bring it to the front.

Players’ Rounds

Each player’s round on the scorecard has an area for configuration and
scoring:

A O & Handicap Index@: = 18.5 |Putts| + | ¥+ |0Dli0n5'|
Alceervik [ | [ [ T T [T T T [TTTTTTTTT [T J2aa] §

Player’s Round

Player designator — on scorecards with more than one player, the players
are designated by an alphabetic character (A, B, C, etc.) that indicates their
relative position on the scorecard. If you want a player to be the “A-Player,”
move them to the top of the list of players.

Player’'s Name —The player’s name is draggable and can be dragged wher-
ever a round can be used, like the scoring areas in a Match window.
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Tee — Use the tee popup menu to choose the tee played during this round:

Ladies’' Tees |380(126)|466(342|340(114[460(340(324| 2
Par (4|3 |54 |4|3|5([4]|4

& Handicap | 5 1? 1 11 9 15 3 13| 7

E, Handicap L

9
' Champlonshlp Tees —

A Es
Al Czervilk ) Junior Tees

@ Ladies' Tees

MaryCzenrik| | | | | | | | | |

Tee Selection

Handicap — The title to this field indicates the type of official handicap used
to compute a playing handicap and allowances for this round. The com-
puted (or looked-up) default value is shown in the text box in dim text. This
default value will be used unless it is overridden by typing another value in
the text box. A little blue indicator adjacent to the text box indicates it con-
tains an overridden value. To remove an overridden value, select it and type

<] (DELETE).
L1 8 [12[18] 2 Putts — Click this button to open a sheet just below the scores for this player
[ies]| [runs | B8] to enter putts and other information about the round. (See “Entering Putts
|

LD L] | and Other Detail” on page 93 for details.) When the OPTION key is held
down, this button becomes the Competition Scoring button.

[16]8 [12]18] 2 Competition Scoring — With the OPTION key held down, click this button
(sl [T | Rl (the same as the Putts button) to display a sheet showing competition
|

scoring results for this round. See “Competition Scoring — Player’s Rounds”
on page 95 for details. See “Competition Scoring” on page 81 for a
discussion of competition scoring.

[ 1 Move up — Click to move this round up - ahead of the player just above. The
button is dim and not available when the player’s round is already the first on
the scorecard.

—]—d

e
B

»
o

=
=]
=

82| Move down — Click to move this round down - after the player just below.
pums | & | & [Options ¥ 'The button is dim and not available when the player’s round is already the
T T [ |

last on the scorecard.

Moving players rounds up or down changes their “A,”“B,”“C” player desig-
nation, and may (if the application preferences specify) change the name of
the scorecard or any team on the scorecard of which they’re a member.

7l

L=
i

round. See “Player Round Options” on page 86 for details about round

, Options — Click this button to perform actions or adjust settings about this
options.
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Player Round Options

'The round Options menu allows you to choose certain actions and settings
for this player’s round:

o L i

- | Options = L]

4 Edit information about Al Czervik...

w

f;) Make Men's Tees on Bushwood Country Club the Player's Preferred Course
20 Y, Event...

Putts. ..
_‘ & Competition Scores...
“4 Match for Al Czervik...

Show Handicap Dots

Move Round Up - Make Al Czervik the ‘A’ Player
Move Round Down

Delete Round. ..

Split Scorecard

Ignore for Handicapping
Penalty Round
Disqualified

Clear Scores

Round Options

Edit information about Player — Open a player editing window for this
round’s competitor and bring it to the front.

Make Tees on this Golf Course the Player’s Preferred Course — Choose
this menu item to make the settings of this scorecard (club, course, front and
back side, tee) the preferred settings of the player.

Event... — If the round is associated with an event, open a window for that
event and bring it to the front.

Putts... — Open a sheet to enter putts and other information for this round.
This is the same action as clicking the Putts button. See “Entering Putts and
Other Detail” on page 93 for details.

Competition Scores... — Open a sheet to review or configure competition
scoring for this round. This is the same action as clicking the Competition
Scoring button (the Putts button with the opTION key down). See
“Competition Scoring — Player’s Rounds” on page 95 for details.

Match for Player... — Open a match window with this player’s round
installed as the “A” competitor.

Show Handicap Dots — Show dots on the scorecard representing the handi-
cap strokes allowed this player at each hole.

Move Round Up — Move this round up on the scorecard ahead of the round
above it. This is the same action as clicking the Move Up button.
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Move Round Down — Move this round down on the scorecard after the
round below it. This is the same action as clicking the Move Down button.

Delete Round... — Delete this round from the scorecard. You will be asked
to confirm that you want to delete the round from the scorecard and from

the player’s scoring record. You can't delete the last round on a scorecard -

you'll have to delete the scorecard instead.

Split Scorecard — Move this round to a separate new scorecard. You may
only move the round if it is not the last round on the scorecard and the
round is not required to calculate a team round also on the scorecard.

Ignore for Handicapping — When checked (v), indicates that this round
will be ignored in the computation of the player’s handicap (perhaps

because it is not played under the Rules, or some other reason for exclusion).
Otherwise, the round will be included in the player’s scoring record and con-
sidered in handicapping calculations. Choose this menu item to ignore or
include the round. When ignored, a little © symbol is shown adjacent to the
handicap text field on the scorecard.

Note: If the player’s round is marked as ignored for handicapping (the \gnore for
Handicapping option is checked and the round is marked with the © symbol) but
the rounds status cannot be changed, the round is associated with an event which
specifies that the round should be ignored for both accumulation of statistics and
handicapping (see page 111).

Penalty Round — Make this a penalty round. A little red indicator to the
right of the Options button is used to indicate a penalty round. Penalty
rounds are typically posted as a substitute for an unreturned scorecard (see

the Glossary).

Disqualified — When checked (v'), indicates that this round has been dis-
qualified from competition in the associated event. The menu item is only
enabled when this round represents the competitive score in an event or is
one of the rounds used to calculate a team’s competitive score in an event. A
round may be disqualified from, or restored to, competition by choosing this
menu item.

Clear Scores — Choose this menu item to clear all of the scoring informa-
tion entered on this round, including the player’s scores, putts, any fairways
or greenside bunkers hit, penalty strokes or other status indicators.

Adding Rounds to a Scorecard

Adding a Player

You can add a round for a player to an open scorecard by choosing Add a
Player to this Scorecard from the scorecard Options menu (page 82) or
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Adding Rounds to a Scorecard

by typing #A (SHIFT-COMMAND-A). A sheet will be opened for you to

select a player:

Player

Enr Eng g Bn

Select a Player...

A Doctor
Al Czervik
Mary Czervik

r Beeper

Tony D'Annunzio
Earl Havercamp
Frieda Havercamp
Danny Noonan
Agnes Smails
BELCY 4 Judge Smails

q A Spaulding Smails
& Quick Add

fa All P

| Cluby |City |

Bushwood Country Club West Bushwood, NJ |4

Bushwood Country Club Nutley, NJ _C'|
Bushwood Country Club Nutley, NJ fot
Bushwood Country Club
Bushwood Country Club Garden City, M) 72
Bushwood Country Club Garden City, M)
Bushwood Country Club —
Bushwood Country Club od [
Bushwood Country Club - :[
‘™

(Ganee) (A

P

Adding Players

Select one or more players to appear on the scorecard and click the Add
button. Players who are shown with dim text are already on the scorecard
(or in an event, on another scorecard associated with the event) and can’t
be selected. The rounds of players newly added appear at the bottom of the

scorecard.

Frieda Havercamp

ﬁ Club |BushwquCountrv Club H Date Sunday, October 19, 2008 @
Course |Eushwnnd Colf Course H Tee 1 Time D
Sides [Front Nine FG-‘ [Back Nine FG-‘ |Eﬂplinns '|
1121314 ([5[6|7|8|9[0ut|10[11]12]13]14[15[16[17|18| In | Tot
Men's Tees |402|166|504(360(384|180(473(362(390| 3227 |480|366|402[355)14 4[165|484| 3150 (6377 T0.2NZ2T
Ladies' Tees [380[1 1 2832 1(120]450)| 2556 | 5748 T1.1128
Par (4|3 |54 (4[3|5)4|4|36|5|4 | 4|4|3(4([4[3|5|36]|72
& Handicap |5 |17[1 [11|9 15| 3 [13|7 6 (14| 2 |[10[18| 8 [12]|16] 4
§ Handicap | 5 [16[ 3 [13|11[17]1 |9 |7 4 |14 | 6 (10|16 & [12(18] 2
A [OX Handicap Index@: 34.4 | Putts | + | ¥+ |CI|:|Ii|m5'|6
Earl Havercamp [8 [4 [7[6 [7]6[6[8[4[56 [7[5[6[5[5][6[7]5][7]53[109]39[70]
B (@ Handicap Index®: = 51.2

| Putts | +* | E 3 |0Dli0n5'|

8 A A2

Added Player

You can also quickly add a single player to an open scorecard by dragging the
player’s name from the Players panel of Eagle’s main window onto the score-
card window. In this case, players are added at the bottom of the scorecard
or at the highlighted point between other rounds on the scorecard.
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2 W) |

i Add a Player to this Scorecard

In
&
35

|

k4l

Show Notes
Tournament Scarecard
Adjust for Tee Ratings
Show Skins

4 Competition Summary...

4 Competition

4 Competition Allowances
4 Add aTeam Score

4 Match

Print this Scarecard.

) Event...

oA

auN
aut
QAR
anK

%D

R Y]
P

Adding a Team Round

If you want to add a team score, to calculate a best-ball or add a round for a
ball played by the players on the scorecard, choose one of the submenu
options from the Add a Team Score item in the scorecard Options menu
(page 83). Eagle will add the selected type of team round to the scorecard,
and it will assume that all of the individual players on the scorecard are
teammates for this added round.

[Jele recard - Bushu ntry CI 08 - Earl & Frieda Havercamy
Club |Bushwood Country Club j Date Sunday, October 19, 2008 @
Course |Bushwood Colf Course j Tee 1 Time Q
Sides [ Frant Nine I-H [ Back Nine I-H |E(}plions =

1(2)3]4[|5|6|7|8|9|0ut|10)11]12]13|14|15]|16(17[18| In | Tot
Men's Tees |402|166(504|360|384|160|473|362|390| 3227 [460(366/402|355(146(356|364|165(484| 3150 | 6377 | 70.2127
Ladies’ Tees [380[1 340114 2692 [438(3 1|120(450| 2856 | 5748  71.1/128

Par (4 [3[5[aa3|5|a|a[36|5[afa[a[3]a]a]3]5]36]72
4§ Handicap |5 [17[1 [11] 0 [15]3 [13[7 6 [14] 2 [10[18] 8 [12[16] 4
£ Handicap 5 [15]3 [13[11[17[1 e [7 4 [14] & [10[16] 8 [12]18] 2
A [ ;]‘ Handicap Index@: = 34.4 | Putts | + | ¥+ |0Dli0l‘\5'|e
Earl Havercamp [8 [4 [7[6[7]6[6[8[4[56 [7[5[6[5[5][6[7]5][7]53[109][39]70]
B @ ;]‘ Handicap Index@: 51.2 Putts | &+ | ¥+ |0plians V|6
Frieda Havercamp (5 [5[8 [11]6[B[8[9[8[68 [6]6[6][7[6]5[7 [8[10] 62 [130] 58 [ 72 |
Havercamp, Earl & Frieda + | ¥ Opliansv6
Four-Ball [ [4 [7[6[6[6[6[8[4]52[6]5][6][5[5][5[7[5[7[51[103] [58]
[ Better-Ball (Four-Ball} l-G']

Team Round

'The team round scoring fields are near the bottom of the scorecard. Some
types of team rounds are calculated from the scores of the individual players,
like the four-ball score in the illustration above. Others, like Greensomes or
a Scramble, require that you enter a score for the team ball at each hole.

You can indicate how the teammates” handicap allowances should be cal-
culated by choosing an appropriate allowance from the Competition
Allowances submenu in the scorecard Options menu. The default is Full
Handicap. If the team score is to be calculated from Stableford points or

by some other method, choose the method of competition scoring from the
Competition submenu in the scorecard Options menu. The default is Medal
Play.

For team rounds not associated with an event, you may modify the type of
team play using the popup menu at the bottom of the team scoring area, as
shown in the preceding illustration. For team rounds that use team allow-
ances (like a Scramble), you may also modify the team’s handicap allowance
with a popup menu that will be available for that purpose. Because team
rounds associated with an event are controlled by the setup of that event,
these popup menus are not available.
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Team Name —The name shown for the team is draggable, and can be
dragged to any location expecting a round, like the competitors in a match

window.
6145459221 Move Up — Click this button to move the team round upward relative to
Optior other team rounds on the scorecard. Team rounds will always remain below

6|3 (5|41 |83

individual player’s rounds on the scorecard.

44545 |2 21|00 Move Down — Click this button to move the team round downward relative
¥ |options » ¢ to the other team rounds on the scorecard. Team rounds are always at the
3|54 |83 69
bottom of the scorecard.
sle2|a|n Options — Click this button to display a menu for you to choose activities or
L. O 8’ settings associated with this round. See the next section for details about
1 (83

these options.

Team Round Options

Like individual player rounds, you can configure team rounds from the
Options menu:

92 [ 21 | 71

- | Options « 6\‘

& Edit Teammates...

83
), Event...
4 Competition Summary... ®D

Move Round Up
Move Round Down
Delete Round...

Met Score in Tenths
Disqualified
Recalculate Scores

Team Round Options

Edit Teammates... — Display a sheet allowing you to add, remove or change
teammates for this team round (see “Adding and Removing Teammates” on

page 91).
Event — If this team round is associated with an event, choose this item to
open a window for the event and bring it to the front.

Competition Summary — Choose this menu item or type 3D (COMMAND-
D) to see the details of the individual scores that comprise the net team score.
See “Competition Scoring — Scorecard” on page 95 for details.

Move Round Up — Move this team round upward relative to the other team
rounds on the scorecard. This is the same action as clicking the Move Up
button.



Chapter 4 — Scorecards 91
S S ———

Move Round Down — Move this team round downward relative to the other
team rounds on the scorecard. This is the same action as clicking the Move
Down button.

Delete Round... — Delete this team round from the scorecard. You will be
asked to verify that you want to delete the round permanently. Rounds that
represent competitive scores for an event should be removed from the event.
To do so, choose Event... in this menu to open an event window, then use the
Options menu there of the associated contestant to delete the round. You
cannot delete the last round on a scorecard directly - you must delete the
scorecard.

Net Score in Tenths — When checked (v), indicates that the handicap
allowance and the net score determined from that allowance are both cal-
culated to a tenth of a stroke (0.1 strokes). When unchecked, net scores are
reported to the nearest stroke. The ability to calculate fractional net scores
helps avoid ties in some types of competition. This menu item is not avail-
able for rounds associated with an event - the event setup dictates whether
net scores are calculated in tenths.

Disqualified — When checked (v'), indicates that this round has been dis-
qualified from competition in the associated event. The menu item is only
enabled when this round represents a team’s competitive score in an event. A
round may be disqualified from, or restored to, competition by choosing this
menu item.

Adding and Removing Teammates

Even after a team round has been added to a scorecard, you can change the
teammates whose play contributes to that round. You begin changing team-
mates by choosing Edit Teammates... from the team round Options menu
(page 90). A sheet is displayed below the team round scoring area:

FourBall | | | | | | | L L@

Men 90% of Course Handicap, Women 95%

[
1 a Add or Remove Team Members... (Q| ‘} r

'Pla\fers | Index| |

Beeper, Doctor & Czervik, Al 3 Doctor Beeper 12.4 |

' Team Member | Tee | Index| Hdep| | _e Al Czervik 18.4m
a Doctar Beeper O = 12.4 15 i Mary Czervik 65.0
B AlCzenik Q:+ 185 21 4 Tony D'Annunzio 14.4
& Earl Havercamp 34.4
i Frieda Havercamp 51.2

4 Danny Noonan 7.7 v

2 players required 1«

Adding or Removing Teammates
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'The team members are shown at the left, with their chosen tee, handicap and
playing handicap. To add one or more teammates, select them from the list
of players on the right, then click the Add button.

To remove players from the team, select them in the list on the left, then
click the Remove button. If necessary, Eagle will add or remove individual
rounds on the scorecard to accommodate the style of team play indicated.

Players in the list on the right whose names are shown in dim text are
unavailable to add to this team because they’re already members of the team
or members of another team in any associated event.

Team Name — You may provide an alternative name for the team by typing
it into the text field at the left. The dim text shown represents the way the
team will be described without an alternative name.

Tee — Choose a tee from which a teammate will play the round.

Index —This column indicates the official, calculated or looked-up handicap
for a teammate. If there is no individual round on the scorecard associated
with the teammate (as in a Scramble or Foursomes), you may override this
value by double-clicking it and typing an override value.

Hdcp — This column indicates the playing handicap for a teammate. If there
is no individual round on the scorecard for the teammate, you may override

this value by double-clicking it and typing an override value.

Note: Different types of team play require a specific number, or minimum number,
of players. You should avoid reducing the number of players on the team below the
minimum number (shown below the list of teammates) to make sure team scores
can be computed.

Click Done when you're done reviewing or editing teammates.

Scoring

Entering Scores

You may enter scores on a scorecard in as much detail as you want. You may
enter a round simply by entering the gross total for that round. Or, you can
enter scores for each side, and Eagle will compute the total. Most likely,
however, you will enter players’scores hole-by-hole.
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J|16] 8 [12|18]| 2

When you open a new scorecard for a player, it opens ready to enter scores,
with the flashing cursor at the first hole:

A [OR Handicap Index@: = 18.5 |Putts| + | + |Oplions'|
mczenvik [ [T [ [ [ [ [ [T [TTTTTTTTT [ a1 |

Ready for Entering Scores

To enter scores, simply type the player’s hole-by-holes gross scores. You don’t
need to type TAB, ENTER or RETURN keys after each hole. Eagle will automat-
ically TAB to the next hole when you've entered a valid score. On a good day,
that means you can enter the hole-by-hole scores for an 18-hole round with
18 keystrokes. On a really good day, when you need to record a 1, type “1”
followed by the TAB key. The result looks something like:

A [@] :]‘ Handicap Index@: 18.5 |Putts| +* | L 3 |G|:|li1mSV|0
AlCzervik [5[6[7]4[5]4[4]6[5[46[5[5[7[5[3[6[5]a[7[4a7[93]21]72]

Score Entry Complete

Sub-par, par and over-par scores are readily identified by their color. If a
playing handicap is available, the net score for the round is shown. The little
green indicator (@) to the right means “scoring complete” - you've entered
enough information to use this round for analysis or handicapping. Rounds
for which scoring is not complete can also be identified in a player’s list of
rounds by their “dim” appearance in the list.

Entering Putts and Other Detail

If you want Mulligan’s Eagle to perform analysis on other parts of your (or
any player’s) game, you can provide the additional information about the
round by clicking the Putts button which displays a sheet immediately below
the scores just entered:

Handicap | o [lo)d [1a[ljlr ]9 || |4 [14] 0 |lujle]e [l2)18]& |

A B3 Handicap Index@: 18.5 Putts | 4 | ¥ C)ptiuns'6
Alczervik [5][6[7]a[5]4[a]6[5]a6 [5[5[7[5][3[6][5[a[7]47 21 [72 ]

w
w

Putts
B X A v 1|

Rivy @ @O 909 G9ee 98 9
sand @O0 OO0

Hole

1 402 Yards [ Up & Down Adjusted Gross Score: 93
Par 4 ["] Green in Regulation (P [ Gt
@ Penalty Strokes zero Sand Saves/Tries:

Putting and Scoring Details

Putts — Just like entering scores, you can enter your hole-by-hole putts by
typing numbers like 0, 1, 2, 3, etc. and Eagle will automatically TaB to the
next hole when you've entered a valid number. Note as you proceed entering
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putts that the big Hole number indicates the hole in which the insertion
point is located, and the editable data immediately to the right of that num-
ber is associated with that hole. To set the big Hole number, click to put the
insertion point in the putting entry field for a hole.

Fairway — Click the Fairway (@) button at the holes on which you hit the
fairway with your first shot from the tee. If you are recording fairways hit
but hit no fairways in this round, click the No Fairways (@®) button to
the right. You may also “set” the Fairway button for the hole indicated by
the big Hole number by typing the shorthand key for a fairway hit - an
“F”by default. To “unset” the Fairway button, type <+F (SHIFT-F) or \F
(OPTION-F).

Sand — Click the Sand (@) button at the holes on which you were in a
greenside bunker with the opportunity to make par (a “sand try”). You may
also “set” the Sand button for the hole indicated by the big Hole number by
typing the shorthand key for a greenside bunker hit - an “S” by default. To
“unset” the Sand button, type ©S (SHIFT-S) or XS (OPTION-S).

CCR —If the handicapping method in use for this player requires it, a text
field is shown for you to provide the Calculated Course Rating (CCR) or
Calculated Scratch Score (CSS) for this round. This number is a value that
represents the course rating adjusted for weather and other conditions on the

day of play.

Up & Down — Check this box if you want to record an “up & down” at the
hole indicated by the big Hole number. You may also record an up & down
for the hole indicated by the big Hole number by typing the shorthand key
for an up & down - a “U” by default. To reset the up & down setting, type
U (SHIFT-U) or XU (OPTION-U).

Green in Regulation — Check this box if you want to record a “green in regu-
lation” at the hole indicated by the big Hole number. If you provide a score
and putts, Eagle will check this box for you. You may also record a green

in regulation for the hole indicated by the big Hole number by typing the
shorthand key for a green in regulation - a “G” by default. To reset the green
in regulation setting, type <*G (SHIFT-G) or \.G (OPTION-G).

Penalty Strokes — Increment (or decrement) the number of penalty strokes
you want to record at the hole indicated by the big Hole number. You can
reset the number of penalty strokes to zero by clicking the zero button. You
may also add a penalty stroke for the hole indicated by the big Hole num-
ber by typing the shorthand key for a penalty stroke - a “P” by default. To
subtract a penalty stroke, type <P (shift-P). To reset the number of penalty
strokes to zero, type CP (OPTION-P).

'The use of the “F”,“S”,“U”, “G” and “P” keys described above and others used
for scoring is further described in “Scoring Shorthand” on page 180.
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Adjusted Gross Score — Eagle computes an adjusted gross score after
applying limits to individual hole scores based on the requirements of the
handicapping system in use for the player. This value is displayed for review.

Greens in Regulation —The total number of greens in regulation calculated
or entered for this round is displayed for review.

Sand Saves / Tries — The number of sand saves and the number of sand tries
for the round are displayed.

Competition Scoring — Player’s Rounds

[16]8 [12]18] 2 You can review the calculated net or competition scores for a player’s round
(sl [T ] Bhe] by holding down the opTION key and clicking the Competition Scoring
| |

button, which is the same as the Putts button. A sheet will be displayed
immediately below the player’s scores that describes the net or competition
scores for the round:

licap | o [1o]9 | lafll] [ ] [#fl4fojiujivjejiejibje]|
A f_) - Handicap Index@: 18.5 Dptmnsv
Aluemk|5|e|7|4|5|4\4|e|5|46|5|5\7|5|3|ﬁ|5|4|7|47|93|21\72|

B S Strokes 1 1 2 1 1 110 21
L 5mre|4|5|5|3|4|3\z|5|4|35|4|4\5|4|z|5|4|3|s|37|7z|

[ Medal Play "" [ Full Handicap I-H

Competition Score Display

'The competition scoring display includes the handicap allowance strokes and
the net or competition score in the style specified for this round. For rounds
that are not associated with an event, the type of competition scoring can

be set by the popup menu at the left. The default for individual rounds is, as
shown, Medal Play. The allowance popup menu allows you to choose the
calculation method for the handicap allowance for this round. The compe-
tition results themselves are shown in the displayed Score. Click Done to
dismiss the sheet.

Competition Scoring — Scorecard

You can adjust the competition scoring and allowance settings for a// of the
individual rounds on a scorecard with the Competition and Competition
Allowances scorecard options (see “Scorecard Options” on page 82).

From the scorecard, you cannot adjust competition scoring methods or
allowances for rounds associated with an event. Those settings are controlled
by the configuration of the event.

To display a summary of the competition scores, including both indi-
vidual scores and team scores derived from the individual scores, choose
Competition Summary... from the scorecard options (“Scorecard Options”
on page 82) or from any team round options (“Team Round Options” on
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EAGS

page 90), or type 3D (COMMAND-D), or hold the SHIFT and OPTION keys
down while you click the Competition Scoring (Putts) button. A sheet will
open displaying the data:
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112]|3]|4([5[6|7]|8
Al Czervik |4 |5 |5 (3 |43 |2(5
Mary Czervik (5 |4 |6 |4 [5 |4 |1 |3 |6 |38 |4 (14|73 ([1[4|5|4|33 | T

Full Course Handicap

Par [4 |3 |5 (4|43 |5[4|4]36[5|4[4|4[3[4[4]|3[5]|36]72)|
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S
w
I
S
'y
(]
S
[N
(1]
S
w
@
9
P

Competition Summary

'The summary will display the competition scores of all the players on the
scorecard, as well as team scores derived from the individual scores. Click
Done to dismiss the sheet.

Importing Scores

For large events or situations in which scores are recorded either by another
copy of Mulligan’s Eagle or with a compatible iOS application, scoring and

other information may be imported from data produced elsewhere.

Choose the one of the options in the File / Import menu available for
importing scores:

= EaglemEdit Golf Reports Window Help

New... >
Open #0
Recent >

£ Mulligan’s Eagle™ Club Files...

Export HE
? Mulligan Software Club Archives...

Close wrW

= Scores from Mulligan Scoring Data Files...
% Scores from Dropbox...

> Scores from iCloud...

Print... ®P

Import Menu - Scores

From Mulligan Scoring Data Files

Scoring files are Mac documents that contain all the detailed information
about one or more rounds of golf, demographic information about the golf
course played and the competitors. Scoring files may have been exported
from Scorecards by Mulligan’s Eagle or from compatible applications on
remote devices.
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Begin importing scoring data by choosing Scores from Mulligan Scoring
Data Files... from the Import submenu in the File menu.

Note: If the menu option is unavailable (the item is dim and inactive), the player
or scorecard list has been locked to prevent the addition or removal of scores.

Use the displayed dialog to locate the scoring data files to be imported:

O.0.08 Import
|a]» HEE o | H = v ‘ | (3] Mulligan Scoring 3] (@

FAVORITES Name 4| Date Modified Size
E e g 2012-06-18-Bushw-CzervikSchick.EAGS Today 1:59 PM

B 2012-06-18-Bushw-SmailsHavercamp.EAGS Today 2:01 PM

# Bushwood Country Club.CLUB Aug 25, 2008 2:31 PM 16 KB

@ Desktop @ bushwood_logo.jpg Feb 29, 2012 10:40 AM 15 KB ]

15} My Stuff
@ Documents
A Applications
Pictures

0 Downloads
H Movies

JJ Music

SHARED

E Al My Files

| Cancel | @

Choosing Scoring Data Documents to Import

Navigate until you have found the files, then select those you want to import.
Click the Import button when you are ready to continue.

'The application will display a dialog that will show your progress importing
each of the selected scoring data files:

800 Import

Importing Mulligan Scoring data files...

2 files selected - click Import to continue

Be sure to review the information imported from these files
for accuracy. If a golf course or player indicated in the data
is not on file, they will be created from available information.
If a scorecard for the date, course, and player indicated is
not on file, it will be created.

/__\
N/

| cancel | [ Import ]

Scoring Data Import

Click the Import button to import the data. The progress dialog will close
automatically when the process is complete. All the data will be imported. If
a scorecard of the proper date matching the round being imported is already
on file, scores will be imported, replacing any existing data. If an incoming
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player or golf course can't be found, they will be created. If necessary, a score-
card will be created to accommodate incoming scores.

From Dropbox

If you have an active Dropbox account, scores entered and saved to your
Dropbox on a remote device can be reviewed and imported to Mulligan’s

Eagle..

Begin importing scoring data by choosing Scores from Dropbox... from the
Import submenu in the File menu. The displayed window will list the avail-
able compatible Mulligan Scoring data files found in your Dropbox.

8 0.0 Import Scoring Data from Dropbox
\¢ -
‘F Drophbox munigars EQ gle '
| Unlink | || Check for scores at startup
oldest first 4 Competitar(s)
Scori Data Fil Mod.

DI, ala; 1. 85 sen 2 @ Judge Smails oK =
2008-12-20-Bushw-BeeperCz... 10 Jul 2013 @ Soaulding smails Tl e
eSS e = s S TR -

10 Jul 2013
2008-12-20-Bushw-Havercam... 11 Jul 2013
2013-07-15-Bushw-NoonanD... 15 Jul 2013
2013-07-15-Bushw-SmailsSmails 15 Jul 2013
2013-07-15-Bushw-WebbCzervik 15 Jul 2013 § . =
2013-07-25-Bushw-Blenkhorn... 3 Aug 2013 | @ Course @
@ Bushwood Country Club oK H
= Scores @
@ Judge Smails ] 91
@ Spaulding Smails (] 113
[=][¢] Loaded file 2008-12-20-Bushw-SmailsSmails.EAGS" | Cancel | = Import

Importing Scoring Data from Dropbox

Link / Unlink — Click Link to activate your Dropbox account using a previ-
ously registered account and password. If you don’t have a Dropbox account,
visit https://www.dropbox.com to sign up. Click Unlink if you want to dis-
continue (log off) using Dropbox.

Check for scores at startup — Eagle can initiate an automatic review of
incoming scoring data via Dropbox every time it starts up. Incorrect, incom-
plete or ambiguous data will be left for later review. Other data will be
imported into Eagle’s database. Check the box to enable review at startup.


https://www.dropbox.com

i
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When an incoming scoring record is selected (clicked) in the list at the left,
the competitors, the golf course and the incoming scores are evaluated to
determine whether the scoring record (in its entirety) can be imported. Valid
and complete data is identified by green or gray indicators. Missing data
about the golf course or a competitor will be identified by a red indicator.
You can delete an incoming scoring record by clicking the Delete “-” button
or you may take other action to install a competitor or the golf course into
Eagle’s database or skip the entry of scores for a particular player.

Once you have specified how the incoming data is to be resolved, clicking
the Import button will install or merge the scoring data into Eagle’s database
and the players’scoring history and the scoring data file will be deleted from
your Dropbox.

From iCloud
If you purchased Mulligan’s Eagle from the Mac App Store, and you have an

active iCloud account, you may import scoring data files from a special

reserved “Mulligan Scoring” folder synchronized through iCloud.

Begin importing scoring data by choosing Scores from iCloud... from the
Import submenu in the File menu. The displayed window will list the avail-
able compatible Mulligan Scoring data files found on iCloud.

8 00 Import Scoring Data from iCloud

‘ iCloud Mulligan’s Ea gl em

|| Check for scores at startup

oldest first 4 Competitor(s) [ ]
Scoring Data Fil Mod. =
éo?r;ingg Ei1: FI - BestBal|T 215 ;01'2 % TennyNoomn o T
i ANCaEes] a, s 55 @ Chuck Schick 0K H
2012-07-20-Bushw-Czervikde... 9 Oct 2012
'2012-07-04-Bushw-Noonan...
2012-09-13-Franc-NineHole5... 2 Nov 2012
2012-08-18-Eagle-MoonanSpa... 2 Nov 2012
2013-01-31-10-00-Bushw-D... 9 Feb 2013
2012-02-25-09-00-Eagle-Bo... 23 Aug 2013 | =
@ Course (]
@ Bushwood Country Club oK v
=) scores @
@ Danny Noonan ] 75
@ Chuck Schick - 94
— | Loaded file "2012-07-04-Bushw-NoonanSchick.EAGS" [ Ccancel | [ Import |

Importing Scoring Data from iCloud
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Check for scores at startup — Eagle can initiate an automatic review of
incoming scoring data in iCloud every time it starts up. Incorrect, incom-
plete or ambiguous data will be left for later review. Other data will be
imported into Eagle’s database. Check the box to enable review at startup.

When an incoming scoring record is selected (clicked) in the list at the left,
the competitors, the golf course and the incoming scores are evaluated to
determine whether the scoring record (in its entirety) can be imported. Valid
and complete data is identified by green or gray indicators. Missing data
about the golf course or a competitor will be identified by a red indicator.
You can delete an incoming scoring record by clicking the Delete “-” button
or you may take other action to install a competitor or the golf course into
Eagle’s database or skip the entry of scores for a particular player.

Once you have specified how the incoming data is to be resolved, clicking
the Import button will install or merge the scoring data into Eagle’s database

and the players’ scoring history and the scoring data file will be deleted from
iCloud.

Exporting Scorecard Information

Printing Scorecards

'There are many options for printing scorecards for use on the course. With a
scorecard window open, choose Print from the File menu or type $P (Com-
MAND-P), or choose Print this Scorecard... from the Golf menu.

Scorecard - Bushwood Country Club - 20 Dec 2017 - Mary Czervik & llma Havercamp

Printer:  Canon MX922

(O )

Presets: Default Settings

Copies: 1 Two-Sided

Pages: © All
From: 1 to: 1

Eagle

o Dot the Scorecards with...

" Course Handicap

© Handicap Allowance

Print scores...

v

Print Extra...
10of1

2 PDOF i  Hide Details Cancel

Printing a Scorecard
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With one or more scorecards selected in the Players panel of Eagle’s main window, choose Print from
the File menu or type P (COMMAND-P), or choose Print Selected Scorecards... from the Golf menu.
When an Event window is open and frontmost, you may choose Print All Scorecards... from the Golf
menu to print all the scorecards associated with the event.

In all those situations, Eagle allows you to “configure” how you would like the scorecards printed:

* Whether to “dot” the scorecard with handicap strokes, and whether to use the player’s playing
handicap or their handicap allowance for the competition.

* Whether to print a player’s scores (if scores are available) and whether to print them in color.
* Whether to print a player’s initials near the space reserved for their total score.

* Whether to print extra scorekeeping areas on the scorecard for players to record special data
(putts, etc.) or to display individual and / or team net or competition scores.

Eagle always prints scorecards to fit standard paper or cardstock, printed in landscape oreientation. It
always attempts to print as many complete scorecards as possible per page, considering appropriate spac-
ing and separation to produce high-quality printed cards for the competitors.

Exporting to a Mulligan Scoring File

You can export, or “save,” information about a scorecard to a Mac file. This file can then be imported by
another Mulligan’s Eagle software user or transported via a data network, like Dropbox or iCloud, to be
imported automatically to a central computer running Mulligan’s Eagle. (Exported Mulligan Scoring
files are essentially identical to scoring files produced by Mulligan Software’s iOS applications running
on remote devices.)

To export the information about a scorecard, start by opening a window for the scorecard (see “Editing
Scorecards” on page 79). Choose Export from the File menu or type $E (COMMAND-E) to open a
standard Mac OS save sheet in the window:

™ 0O O Scorecard - Bushwood Country Club - 28 Jul 2012 - Tony D'Annunzio & Danny Noonan

_ e 2]
| Save As: [2012-07-28-Bushw-TonyDAnnunziol \L| '_ l:'
|2
(«]»] |EE m | il || = v || 3 Eagle User Data s (Q ns |
Name 4| DateM
| FAVORITES ] |
L | &5 Dropbox 2012-06-13-Cowbo-EarlHavercampDannyNoonan.EAGS  Jun 18,2132
= Arab Country Club.CLUB Apr 18
Desktop .| Eagle Users Guide.pdf Aug 3, - -
A {5 My Stuff tions v | @
T¢ [ Documents
B #% Applications ? @
Pictures

[_lDﬂS ' '
‘ 0 Downloads P
H Movies
J7 Music
™ Hide extension | New Folder | [ cancel |

Exporting Scoring Data
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Navigate to the location where youd like to save the file, then click Export.
Eagle will assign an appropriate name to the file, identifying the date of
play, the course and competitors contained in the file. Unless you indicate
otherwise, Eagle will save the file in the Eagle User Data folder inside the
Documents folder inside your user directory.

Mulligan Scoring files are stored with, and identified by, a .EAGS extension.

Exporting a List of Scorecards to a Spreadsheet

From Eagle’s main window, you can export data for selected scorecards to an
open spreadsheet application. With Eagle frontmost, select the scorecards of
interest and drag the selection to the spreadsheet:

1 = Bushwood Country Club 1 Mar 2009 &
| B Bushwood Country Club 26 Feb 2009 Danny Na:

1 ﬁ Bushwood Country Club 21 Feb 2009 Tony D'An
| E Bushwood Country Club 17 Jan 2009 Frieda Hav
1 E Eagle's Bluff Country Club 9 Jan 2009 Frieda Hav
4 E Bushwood Country Club 1 Jan 2009 Earl & Frie
1 E Bushwood Country Club 1Jan 2009 Judge & 5

Dragging a selected list of scorecards to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
each selected scorecard:

* Club name

* Date

* Player(s)

'The data is organized in a tabular array, one scorecard per row, when inserted
into the spreadsheet:

8006
A [ E I C | D | E [ F [ G | .H.. I --I .I 7]

<
1 | Golf de Lésigny 11-Apr-02 Judge Smails
2 |Bushwood Country Club B-Apr-09 Mary Czenvik
Bushwood Gountry Glub 1-Mar-08 Doctor Baspar

ol Nioy

Spreadsheet Scorecard List
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Exporting Scorecard Data to a Spreadsheet

You can also export detailed information about a single scorecard to an open
spreadsheet application by opening the scorecard, then dragging the icon at
the top left of the window onto the spreadsheet:

Club |Bushwood Country Club d
Course I Bushwood Golf Course H
sides | Front Nine 5] [ Back Nine

1/2[3(4[5|/6(7[8[9|0ut{l0f11]12

hip Tees |412 394 79|401| 3364 [499(370(414|3°
Men's Tees |402|166|504|360|384|160|479|362|390| 3227 |480|366|402|a:
36 (5 (4|44
17(1 (119 |15|3 [13|7 6 |14]2 1

=

Par

|
w
w
=
o] &
w
w
£
o>

Handicap

Dragging detailed scorecard information to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
the scorecard:

* Date

* Name (competitors’ names)

* Club name

* Course name

* Front nine

* Back nine

* Starting tee

* Tee time

+ Tournament scorecard (yes or no)

and for each round on the scorecard:
* Competitor’s name
+ Tee
* Tee color
* Holes 1 - 9 gross score and total
* Holes 10 - 18 gross score and total
* Gross score
* Playing handicap (Course Handicap, etc.)
* Net score
* Scoring complete (yes or no)
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* Disqualified (yes or no)
* Ignore for handicapping (yes or no)
* Trend handicap

®00

< A [ B [ c IDIEIFIGIHII\J|K|L|M|N|o|r
1 |Date Scorecard Club Cours Front Back Tee Time umament | | |
2 |Wednasday, April 1, 2009 Beeper, Czervik & Smails |Bushwood Country Club | Bushy Front Back Nina No

3 |Competitar Tee Calar 1, 2 3 4 5 & 7 8 8 Ouw| 10 11 1
4 | Doctor Baepar Championship Tees Blue 6 3 6 5 4 4 4 [ 5 43 5 6 £
5 |Judge Smails Championship Tees Blue § 3 & & 4 4 5 5 5 4 & &

6 | Al Czarvik Men's Tees Whita ] 4 2] 8 4 4 L] 5 5| 45 6 &

4

| 9 |

10

Spreadsheet Scorecard Information

If your spreadsheet application has difficulty importing data dragged from
Eagle (no columnar results, improperly interpreted numbers or spacing, etc.),
you may need to change the format of the dragged information. See “Drag
& Drop data delimiters” on page 17 for more information.

Deleting Scorecards

With Eagle’s main window front-most, show the list of scorecards, select
(click, sa1rT-click or commanD-click) the scorecards to be deleted, then
click the Remove button at the lower left corner. Or, choose Delete from
the Edit menu, or type @ (DELETE). You will be asked to confirm that you
really want to delete the scorecard(s). Click OK to delete or Cancel to
continue without deleting.

Deletion is permanent and cannot be undone. The rounds on the deleted
scorecards are permanently removed from their players’scoring records.
When a scorecard is deleted, all of the rounds, scores and other data for those
rounds is deleted too.

Note: If the Remove button is not available (the button is dim), either there are no
scorecards in the list selected for deletion, or the scorecard list has been locked to pre-
vent the addition or removal of scorecards(see ” on page 11).
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Events

3

to an event.

In this Chapter...

Creating New Events

Editing Event Information
Opening an Event Window. .. ....... ... ... ... 108
SetUP « o e 109
Events Requiring Hole Selection. ..................... ... 113
Registration . ........ ... ... 116
Registering a Player foran Event. ..................... ... 118
Editing Player Registrations ............................ 118
Reports. . ... o 120
Results . ... .o 123
Adding Contestantstoan Event . . ....................... 126
Removing Contestants froman Event. . ................ ... 128
AddingaNew Player. . ....... ... .. ... L. 129

Event Scoring
Contestant Options . . ..., 131
Fast Scoring . ...... ... 133
Final Results and Placement . ..................... ... ... 134

Exporting Event Information
Exporting a List of Events to a Spreadsheet ................ 135
Exporting Event Data to a Spreadsheet. . ............... ... 136

Deleting Events

Events are competitions, whether between the players in your four-ball, your
weekly league outing, the members of your golf club, or the donors of your
charity golf tournament. Mulligan’s Eagle can help you plan, run and score
your event.

Mulligan’s Eagle uses the symbol at the left to represent information related

106
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130

135

137
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Creating New Events

You can create and keep on file information about as many golf events as you
wish. There are several ways to start:

From Eagle’s Main Window

With Eagle’s main window front-most, show the list of events, then click the
Add button at the lower left corner to open a window for a new event.

Note: If the Add button is not available (the button is dim), the event list has been
locked to prevent the addition or removal of events (see ” on page 11).

From the New Menu

Or, choose New... in the File menu or type $N (COMMAND-N) to see a dia-
log allowing you to make a new item:

Create a new...

O 5 Player - a golfer for whom you want to keep
information, like scores, statistics or a handicap.

d
O “‘ Club - a golf club, with one or more 9 or 18-hale

golf courses, where you and your friends play golf.

[ .
O i) Scorecard - a scoring record for you or a group of
golfers, on a particular golf course.

8 \b Event - a golf event, with multiple players or teams
and special scoring and handicapping requirements.

® (Concel) o)

New Dialog
Select the option to make a new event, then click the New button.

Note: If the new event option is not available (the button is dim), the event list
has been locked to prevent the addition or removal of events (see ” on page 11).



From the New... Submenu
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® Eagle G Edit Golf Reports Window Help

New... » New. .. 3N
Open #0
Recent > & Player HP
Import > @ Club N#HC
Export *E B Scorecard 35S
e o
Page Setup... (3P | a4 Match. "M
Print... £

New Submenu
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Or, choose Event in the New... submenu in the File menu, or type \$8E
(OPTION-COMMAND-E) to create a new event and open a window for config-

uring it.

Note: If the menu option is not available (the Event item is dim and disabled),
the event list has been locked to prevent the addition or removal of events (see ” on

page 11).

The Event Window

In all cases, a new event window is opened, ready for you to provide informa-

tion about the event:

80O

Event - New Event

New Event Window

N\ ) New Event
& Medal Play - Thursday, January 1, 2009
Event Name  New Event Team Play | None )]
Date  Thursday, January 1, 2009 O Individual Play | Medal Play e
Tee m Time @ Allowance | None (Gross) H'i
Club | Bushwood Country Club ﬂ Max 1 @ players per scorecard
Course |Bushwood Country Club =] Tie-Breaker | None B
Sides | Front Nine [3) [Back Nine B3
1)/2)3|4|5|6|7|8|9|0ut|10]11]12]13]|14|15|16|17|18| In | Tot
Chal hip Tees |41 79(401| 3364 [493(3 164(401]388(175|502( 3305 |666a|  71.5/132
Par |4 |3|5|4|4|3|5|4)|4|36|5|4|4|4|3|4|4|3|5|36 |72
Handicap | 5 |17 1 |11] 9 |15| 3 |13] 7 6 |14|2 [10|18|B [12[16] 4
] Limit Handicap Indexes® [ Limit Course Handicaps
Maximum: £ O Maximum: g 36 & 36
Limit a player's Handicap Index® for this event to a maximum value for Limit Course Handicaps to a maximum value when computing handicap
computing Course Handicaps, handicap allowances, etc. The limit may be allowances (strokes). The limit may be different for men and women.
different for men and women.
] Adjust allowances for differences in Course Ratings () Teammate Difference ) 8 strokes
[ Calculate net scores to a tenth (.1) If teammate handicaps differ by more than the indicated strokes
| Record as Tournament scores (*) Reduce the higher handicap(s)
[ ignore individual scores for stats & handicapping 7 Reduce all teammates' handicaps by 10 %

Y,
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Editing Event Information

'The window for a new event is already configured with a name of “New
Event,” set up for individual medal play on today’s date. Continue, as when
changing information about an existing event, with “Setup” on page 109.

Editing Event Information

Opening an Event Window

Show the list of events in Eagle’s main window and select the event for
which you need to enter or change information. Click the Edit button at the
lower left corner and a window will open for you to review information and
make changes for the selected event.

Or, open the window by selecting one or more events from the list and
choosing Open from the File menu or typing 30 (COMMAND-O).

Or, just double-click the name of the event in the event list.

Note: If the Edit button is not available (the button is dim), there are no events
selected in the list. Event information can be edited even when the event list is

locked.

An event window generally will open to the Results panel (page 123) if
contestants and results have been entered for the event. New events and
events without contestants open to the Setup panel.
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Setup

The Setup panel allows you to specify the details of the event - including
where and when it is played, who participates and how teams are assigned.

o0 e Event - New Year Four-Ball
. / ’1& 3 =
= E & a =
Setup Registration Results Fast Scoring New Player Print
\’ New Year Four-Ball Duplicate...
& Net Four-Ball - Sunday, January 10, 2016
Event Name New Year Four-Ball Team Play | Four-Ball
Date |Sunday, January 10, 2016 Individual Play Medal Play

0

n

Starting Tee Time Allowance | Men 80% of Course Handicap, Women 85%
Club | Bushwood Country Club Max 2 |2 players per scorecard
Course | Bushwood Country Clua [N Tie-Breaker Back nine, last 6 holes, last 3 holes, last hole
Sides | Front Nine Back Nine
1[2|3[4|5(6|7 (8|9 |0ut|10[11]12|13]|14]|15]16]|17]18| In | Tot
Chamgpionship Tees |412/1 4 1|3364 |499|370(414|392(164|401 | 388|175 |50; 6669 715132
Men's Tees |402|166|504|360| 354180 3227 |480(368|402|355)|148|386 |364| 165|484 | 3150 | 6377 70.2127
Ladies’ Tees [a8a]1 o[114 42092 1[120[s50[ 2666 [6748 | 71.11128

6 [14[ 2 [10[18]| 8 |12]|16( 4
4 [14[ 6 [10[16] 8 |12]|18] 2

50
Par[4]3[5(alal3]5
@ Handicap [5 [17] 1 [11] 9 [15]8

1

2
436 [5|alalalafafala][s5]36]72
7

% Handicap |5 [15] 3 [13[11]17 7

| Limit Handicap Indexes® | Limit Course Handicaps
¥
»
i andicaps to a maximum valus han computing handicap
it may b n 2nd women

Maximum: 4 &

okes). The limit may be

Adjust allowances for differences in Course Ratings » strokes

If teammate handicaps differ by more than the ind;

| Record as Tournament scores. -

| Ignore individual scores for stats & handicapping %

| Show Registration Status & Notes

Event Window - Setup

Event Name — Provide a descriptive name for the event, like “Fall Best-Ball”
or “President’s Cup,” etc. The name will be used to identify the event in most
windows and reports.

Date — Indicate the date of the event by typing a date or adjusting the date
shown. The date of an event can be in the past or the future, too.

Tee — If all of the contestants in the event start from the same tee, enter that
tee. If contestants start from different tees, that information will be entered
on their scorecards and you should leave this field empty.

Time — If all of the contestants in the event start their rounds at the same
time, enter that time. If the contestants start at different times, their starting
time may be entered on their scorecards and you should leave this field blank.

Club — Select the golf club at which the event takes place. This setting will
be reflected on scorecards for the event, where it will not be editable.
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Course — Select the golf course at the club on which rounds for this event
are to be played. This setting will be reflected on scorecards for the event,
where it will not be editable.

Sides — If the default settings are not appropriate, choose the nines that will
be played on the front side and back side during this event. If the event is
played over 9 holes, indicate the nine being played for the front side, and
“none” for the back side.

Team Play — If the event will be contested by teams of two or more players,
either playing their own ball or playing a ball as a team, select the team com-
petition from the popup menu. Choose None if the event is an individual
competition. If you're unfamiliar with the team games shown in the menu,
visit the “Glossary” on page 201 for more details.

Individual Play — If there is no team play style selected (this is an event con-
tested by individual players) or the selected style of team play requires scores
recorded for individual players, choose how the player’s competition score
will be determined in this event. If the selected team play style does not
require individual scoring, like foursomes or a Scramble, this menu will say
“None” and it will be dim and unavailable.

Note: Selecting an individual style of play, like Stableford, indicates that the cal-
culated event results - the competition score - will be determined from Stableford
points. It will not influence how you record or enter a player’s or a team’ scores.
You will supply the hole-by-hole gross scores for the competitors and Mulligan’s
Eagle will do the rest.

Allowance — When you have indicated the styles of team and individual play
for the event, choose an appropriate method for calculating the contestants’
handicap allowance. Allowance calculations that are not appropriate for the

style of play are dim and disabled.

Max players per scorecard — If there is a maximum limit you want to
impose on the number of players appearing on a single scorecard, adjust the
limit. For team competitions, all the team members and their rounds (if
individual scores are kept) will appear on the same scorecard. For individual
competition, you may use separate scorecards (this limit would be 1) or com-
bine competitor’s scores on a scorecard (up to this limit).

Tie-Breaker — Choose any tie-breaking method you want to use for this
event. These tie-breaking calculations will apply to gross or net competition
and, for net competition, will allocate handicap strokes or calculate fractions
of strokes as required to break ties. All the methods can still result in a tie if
two competitors have identical rounds and identical handicaps.

Limit Handicap Indexes — If you wish to limit competitors’ official handi-
caps when computing playing handicaps for this event, check this box. In
the Maximum text fields, enter the maximum values to use for calculating



Chapter 5 — Events 111

playing handicaps for men and women. If this box is unchecked, there is
no maximum limit on the player’s ofhicial handicap used to calculate play-
ing handicaps in this event. When you first check this box, Eagle inserts
the maximum handicap for men and women that is not a “local” or “club”

handicap.

Adjust allowances for differences in Course Ratings — In events where
competitors may play from difterent tees, or men and women may play from
the same tees, check the box to adjust handicap allowances for differences in
the ratings of those tees. Generally, this means that the handicap allowances
of players competing from tees with a higher rating will have their allowance
increased by the difference between the rating of their tees and the rating

of their competitor’s tees. If the event includes competitors playing with a
handicap that doesn’t support such adjustments (like the World Handicap
System), this option is disabled for all players in the event.

Calculate net scores to a tenth (.1) — Check this box to compute the net
score of the event’s competitors to a tenth of a stroke. This capability is par-
ticularly helpful for avoiding ties. It is frequently used in Scrambles. If this
option is unavailable, the style of play is not compatible with net scores cal-
culated in this fashion.

Note: Remember that a competitor’s “net score” in an event is not necessarily the
same as the net score you might see on their scorecard, computed by subtracting their
normal playing handicap from their gross score. Net event scores are calculated
using a handicap allowance, which may be subject to limits, adjustments or calcu-
lations specific to the competition.

Record as Tournament scores — If the rounds returned by the players
competing in this event should be flagged as “tournament” scores for handi-
capping or other purposes, check this box. The box is dim and unavailable if
the competition does not include rounds by individual players.

Ignore individual scores for stats & handicapping — If the rounds returned
by the players do not conform to play under the rules, like a shamble in
which players share an initial tee shot, check this box to prohibit the use of
these rounds for accumulating statistics or computing handicaps. This option
is unavailable if the players do not return individual scores.

Limit Course Handicaps — If you wish to limit competitors’ playing handi-
caps when computing handicap allowances, check this box. If checked, you
may selected the method by which playing handicaps are limited — a maxi-
mum value, or a difference between partners:

Maximum — Select this option to limit men’s and women’s playing handicaps
when computing handicap allowances. Enter the limits for men and women
in the appropriate text fields.
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Teammate Difference — Select this option if you prefer to limit playing
handicaps when the difference between partners’ handicaps exceeds some
number of strokes (which you provide in the adjacent text field).

Note: You may either limit playing handicaps to a maximum or limit teammates
handicaps, but not both. If you need to reduce handicaps and then limit teammates’
handicaps, start by limiting official handicaps (Handicap Indexes).

Reduce the higher handicap(s) — If you've selected the Teammate
Difference option of limiting playing handicaps, select this option to reduce,
if necessary, the playing handicap of the higher handicapped teammates to
the specified number of strokes more than the lowest handicapped team-
mate. The USGA recommends this method of limiting handicaps of
teammates in four-ball stroke play to a difference of 8 strokes.

Reduce all teammates’ handicaps by — Or, if you've selected the Teammate
Difference option of limiting playing handicaps, select this option to reduce
the handicaps of all the teammates by a specified percentage when any team-
mate’s handicap exceeds the lowest handicapped player by more than the
specified number of strokes. Enter a percentage as a whole number between
0 and 50. The USGA suggests this alternative if the method above (limiting
only higher handicapped players) is not available.

Duplicate... — Click the button at the upper right to produce a duplicate of
this Event, including Scorecards organized with competitors in the order the
Event is currently sorted. You must provide a name for the new Event (“Big
Tourney - Day 27, etc.) and a date for the new Event. You may also option-
ally include registration information and preserve flight assignments from
the original Event.
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Events Requiring Hole Selection
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Some types of events require the selection of holes - before, during or after

play. If you choose Medal Play - Selected Holes as this event’s form of
individual play, or you choose Medal Play and choose an allowance that
requires the selection of holes, the Setup panel allows you to select:

anoe Event - The Big Peoria Charity Event =

\’ The Big Peoria Charity Event
g Peoria System - Saturday, November 28, 2008

Event Name | The Big Peoria Charity Event | Tearn Play | None ]
Date Saturday, November 29, 2008 @ Individual Play [ Medal Play i-v‘-l
Tee | 1 Time 8] Allowance | Peoria ]
Club |Bushwood Country Club ﬁ Max 4 @ players per scorecard
Course |Bushwood Country Club :i Tie-Breaker | None D-H
Sides | Front Nine 4] [ Back Nine 3
[EREN 3 [+ [5[e A & o [ou fT11[12 ] 14]15[16 [EA 18] In |Tot
Champit hip Tees |41 79|401| 3364 |433(370(4 164|401(388(175|502| 3305 | 6669 71.5M32
Men's Tees (s02|166(504(360[384|180[47 3227 |+80[366|402355 148|386 364 165|484| 3150 | 6377 | FO.21127
Par (4 |3 (5|4 (4|3 (5|4 (4|36 (5|4 (4|4|3|4|4|3|5|36 |72
Handicap [ 5 |17[1 |11[9 |15|3 |[13|7 6 [14] 2 [10]|18[ 8 |12[16] 4

Selectedboles I MO0 0000 @OO@OO0O0® O [ Reser -]

Peoria - Six holes, including two par-3 holes, twa par—4 hales, and two par-5 holes whose
scores are used to compute a handicap.
] Limit Handicap Indexes® [] Limit Course Handicaps
Maximum: 2 O Maximum: & 36 # 36
Limit 2 player's Handicap Index® for this event to 2 maximum value for
computing Course Handicaps, handicap allowances, etc. The limit may be
different for men and women.

Limit Course Handicaps to a maximum value when computing handicap
allowances (strokes). The limit may be different for men and women.

[ Adjust allowances for differences in Course Ratings : Teammate Difference ) 8 strokes

[_] Calculate net scores to a tenth (.1) If teammate handicaps differ by more than the indicated strokes.

| Record as Tournament scores (*) Reduce the higher handicap(s)

[ ignore individual scores for stats & handicapping () Reduce all teammates’ handicaps by 10 %

Event Setup - Selected Holes

You can manually select holes for the indicated event by checking or
unchecking the boxes below each hole in the Setup panel. Or, click the

Y,
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Reset button to the right of those checkboxes to display a menu for auto-
matically checking the boxes:

Clear
Select All

Front Nine
Back Nine P
Peoria (random)
Modified Peoria (random)
Zig-Zag (random)

Par 3's
Par 4's
Par 5's
Par 3's & Par 4's

Par 4's & Par 5's
Par 3's & Par 5's

T&F (9 holes)
0-N-E-5 (9 holes)
T-0-E-5 (13 holes)
N-O-T-E (10 holes)

The Reset Menu

Most of the choices available in the Reset menu are self-explanatory. Those
that aren’t:

Peoria (random) — Select six holes (randomly) that meet the requirement of
the Peoria System. Each time this item is chosen, six holes will be selected
randomly.

Modified Peoria (random) — Select six holes (randomly) that meet the
requirement of the Modified Peoria System. Each time this item is chosen,
six holes will be selected randomly.

Zig-Zag (random) — Select three holes (randomly) that will be used to cal-
culate a team handicap. Each time this item is chosen, three holes will be
selected randomly.

T & F — Check the 9 holes whose names begin with the letters “I” and “F”.

O-N-E-S — Check the 9 holes whose names begin with the letters “O”, “N”,
“E”’ Or “S”.

T-0-E-S — Check the 13 holes whose names begin with the letters “I”,“O”,
“E”’ Or “S”.

N-O-T-E — Check the 10 holes whose names begin with the letters “N”, “O”,
“T”’ Or “E”.
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Results and scorecards for events with selected holes will indicate those holes
as in these illustrations:

Club  Bushwood Country Club Date Saturday, November 29, 2008
Course Bushwood Golf Course Tee 5 Time Q
Sides  Front Nine Back Nine
12 ERERE 68 9 |Out PUNI1L |12 FEN14|15(16 BFA18| In | Tot
CF i hip Tees [412|183|522|385(394 79|401| 3364 |499|370(414(392(164[401(388|175|502)| 3305 | 6669 71.5M132
Par (4 |3 |(5|4|4|3|5|4|4|36|5|4|4|4[3[4)|4|3|5][36|72
Handicap |5 [17| 1 |11]8 [15]3 13| 7 6 [14]2 |[10|18] 8 [12|16]| 4
("] :]‘ Handicap Index@: 7.7 | Putts | 4+ | E 3 |Oplions '|6

Danny Noonan [5 [4[4 44454539 [5[4]5[4]a[s]5[5[4[38[77] 9 [65]

.;“ Handicap Index@: 18.4 |Putts| + | L 3 |(}plim‘ps'|e
AlCzervik [5[5[6]a[6]a[5]5[6[a6 [7[4[5[5[4[4[5]5[7[46[92]21]71]

Handicap Index@: 33.4 |F'utts| +* | + |0Dli0n5'|6
Spaulding Smails [6 [7 [6 [5[8[5]5[8[5[55[5]6]5[6 4]0 [7[8]6]56 [111[39]72]

H

Handicap Index@: 34.4 Putts| 4+ | E 3 |Opli0ns'|6
7[5]6[6]3[5]6][5]50]6[5]9[7][6][7[10]5][6] 61 111[40] 71 ]

H

Earl Havercamp | 7

Scorecard with Selected Holes

L ) Scorecard - Bushwood Country Club - 459 Nov 2008 - Lzervik, Havercamp, Noonan & smails

\£ Peoria System
B 3 [4([5]6 8 (9 [Out el 11|12 pEN 14 (15|16 PFA1E| In | Tot [Hcp | Net
DannyMoonan (5 (4 |4 (4[4 |4 |54 (5|39 |5|4|5|4 (3|3 |5(5([4)38 /|77 (10|67
AlCzervik |5 |5 |6 |4 (6|4 |5 (5(6 |46 |7 |4 |5|5|4(4(|5|5|7 |46 (9219 |73
Spaulding Smails |6 (7 |6 (5 (8|5 |5 |8 |5 |55 (5|6 |5 |6 |4 (9|7 (8 (6|56 111 24 | 87
Earl Havercamp (7 |7 |5 (6 (6|3 |5 (6 (5|50 (6|5|9 |7 |6 |7 |10(5 (6| 61 (111 29 | 82
™ T - T I T |
] T - | o

Competition Summary with Selected Holes

You may change the selection of holes for an event even after play is com-
pleted and you have recorded the participants’scores. The effect of that
change will be reflected immediately on all of the scorecards and results for
the event.

Note: Choosing an option in the Reset menu sets the checkboxes appropriately,
and Mulligan’s Eagle remembers that setting. If you subsequently change the selec-
tion by checking or un-checking boxes, that new setting applies and the old setting
is forgotten. If you alter the selection to be incorrect for the events style of play or
allowance - choosing 4 holes for Zig-Zag handicapping rather than the 3 holes
required, for example - the handicapping and results for the event may also be
incorrect. You can always re-configure the selection properly by checking the correct
holes or using the Reset menu to assist you.
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Registration

The event registration feature of Mulligan’s Eagle is solely to assist you with
the bookkeeping associated with registering prospective players before the
event. Contestants in an event don’t need to be registered to participate, nor
do registered players have to participate in the event.

To register players in an event, show the Registration panel in the event
window:

8eno Event - 2009 New Year Scramble —
" 2 =
e VDO -
- =
Setup Results Fast Scoring Print
\’ 2009 New Year Scramble
’i Net Florida Scramble - Thursday, January 1, 2009
@ Player Tee Index Home Club Registered Paid Werified Notes
4 Doctor Beeper @ 12.4 Bushwood Country Club O ™ O
® 5 AlCzervik (&) 14.1 Bushwood Country Club =] =] =]
® £ Mary Czervik @: 30.6 Bushwood Ceuntry Club O O O
® j Judge Smails (&) 13.5 Bushwood Country Club O ™ ™ Prefer white tees
& Ty Webb @ +2.9 Bushwood Country Club =] =] =]
y 5 registered players
|l | P Handicapping: 35% of A-Player's Course Handicap plus 15% of B-Player's Sort ~ y
Z|

Event Window - Registration

@ — If a registered player has been added as an event contestant individu-
ally or on a team and appears on a scorecard in the event, a blue indicator is
shown in the first column.

rF
Player —The player’s name. If the player is a guest, their little d org’
icon has a tiny letter “G” next to it.

Tee — You may indicate the player’s preferred tee, to be used as the default
setting when the player is added as a contestant in the event. Once added,
the player’s tee is adjusted on their scorecard.

Index — The best available handicap known at the time of registration. This
is the computed or looked-up value for the player, as determined from their
handicap record, effective on the day of the event.

Home Club — From the player’s information, the club designated as their
home club - where their handicap is calculated.

Registered —This checkbox represents one of 3 flags that characterize some
aspect of player registration. Check the box if this status is true.

Paid — This checkbox represents one of 3 flags that characterize some aspect
of player registration. Check the box if this status is true.

Verified — This checkbox represents one of 3 flags that characterize some
aspect of player registration. Check the box if this status is true.
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Note: The names associated with the 3 preceding checkbox items are configurable.
See “Event Registration” on page 16.

Notes — When added or edited, you may indicate your own textual notes
related to registration of a player. Those notes are shown in this column.

Add Registration —To register a player for the event, click the Add button at
the bottom left. A sheet will be displayed for you to add players to those
already registered (see “Registering a Player for an Event” on page 118).

Remove Registration —To remove a player’s registration, select the registra-
tions to be deleted and click the Remove button. You will 7oz be asked to
confirm this removal.

Edit Registration(s) —To edit one or more registrations, select those to be
edited and click the Edit button. A sheet will be displayed for you to review
or change registration information for the selected players (see “Editing
Player Registrations” on page 118). You may also quickly edit a registration
by double-clicking the player’s entry in the registration list.

Sort —To temporarily sort the registered players, perhaps to group them for
choosing partners, planning team assignments, or any other reason, click this
button to display a menu of sorting options. Choose the method by which
the list of registrants should be sorted.

| sert v [
alphabetically
alphabetically by first name
by gender (men, women, unknown)
randomly

by increasing handicap
by decreasing handicap

Registered
Paid
Werified

Registration Sorting
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Registering a Player for an Event

items:

Register Players (b, All
—— Player | Club | City e
_ Al Czervik Bushwood Country Club MNutley, NJ e
ar 5 Mary Czervik Bushwood Country Club MNutley, NJ &
4 Tony D'Annunzio Bushwood Country Club O
k FY Earl Havercamp Bushwood Country Club Garden City, NJ o]
i § Frieda Havercamp Bushwood Country Club Garden City, NJ

From the Registration panel of an event window, click the Add button at the
lower left of the window. A sheet will be displayed for editing the selected

ul Danny Moonan
£ Agnes Smails

Bushwood Country Club
Bushwood Country Club

B Judge Smails Bushwood Country Club I
| -

Spaulding Smails

Gﬁ Lacy Underall Bushwood Country Club v
# Quick Add (Cancel ) (" Register )
Z
Registering Players

Select one or more players to be registered from the list of players, then click
the Register button. Players who are already registered for this event are
shown with dim text and are not available for selection. Use the search field
at the top of the sheet to filter for players by name or club.

Editing Player Registrations

From the Registration panel of an event window, select the player registra-
tions to be edited and click the Edit button at the lower left of the window.
You can quickly edit the registration of a single player by double-clicking
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their name in the list. A sheet will be displayed for editing the selected
items:

‘ Information for 2 registrations...

1 Date Registered: Wednesday, December 17, 2008 Verified
o ' D
Preferred Tee: r_o Championship Tees H" =)
0
g Registered =
s =] Paid =]
[ Verified

Notes: | Caddies can play in this eventi

Registration Information

This sheet allows you to edit the registration information about several play-
ers at the same time. Whatever settings you change here will be applied to

all the players selected for editing.

Date Registered — By default, today’s date or the date the player was origi-
nally registered. You may enter another date.

Preferred Tee — If all the players being edited prefer the same tee, choose
the tee from the menu.

Registered — When checked, indicates all of the individual registrations
have this status. When marked, indicates some of the registrations have this
status. Check or uncheck the box to change the status of all the registrations.

Paid — When checked, indicates all of the individual registrations have this
status. When marked, indicates some of the registrations have this status.
Check or uncheck the box to change the status of all the registrations.

Verified — When checked, indicates all of the individual registrations have
this status. When marked, indicates some of the registrations have this sta-
tus. Check or uncheck the box to change the status of all the registrations.

Notes — Type notes to appear on the Registration panel and printed report
for each of the selected registrations.

Click the Done button when you've made your changes.
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Reports

When an event window is frontmost, or an event is selected in the Events
panel of Eagle’s main window, some reports are available from the Reports
menu specific to that event:

Play List

For an event, the Play List provides a complete list of all the competitors
entered as participants of the event, with information about their tee time,
the tees they play, and the tee from which they start. See “Play List” on page
71 for details about producing and using a Play List.

Golf Cart Signs

For golf course operators conducting an event, there is frequently a require-
ment to produce printed golf cart assignment placards (“cart signs”) for the
participants. Eagle provides a planning view representing all of the players in
an event, organized by tee times and starting tees and golf carts:

[ NeNe) Cart Assignment Planner
Stableford Best Ball
Time [ Cart [ Player Tee Notes
¥ {5 Tee no.1- 7:30 AM A
- e
Vs
& Danny Noonan ' Championship Tees
& Tony D'Annunzio 0 Champicnship Tees
¥ () Tee no. 1 - 7:40 AM
Vi
M Doctor Beeper f_) Men’s Tees
B Al Czervik () Men’s Tees
¥ (&) Tee no. 1 - 7:50 AM W
Vs
M Frieda Havercamp 0 Ladies' Tees
& Mary Czervik @ Ladies' Tees v
B Players in 4 carts for 4 tee times
( Apply ) ( Assign ) ( Cancel ) ( Show Cards )
P

Golf Cart Assignment Planner

You may reorganize the tee times and cart assignments by dragging the
times, carts or players to a position in the list that you prefer. Dragging a
player onto another player or a cart onto another cart will swap the position
of the players or carts. When you have the participants organized as you
wish, you can click the Assign button to have Eagle provide some assistance
assigning tee times or starting tees:
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@8 e Cart Assignment Planner
Times or Tees e
Time / Cart / Playg
v &) Tee o 1 Assigned Tee Times Shotgun Start ] | H
Vs . : : o
& Danm First Tee Time 7:30 AM | |,/
& Tony v - ma
¥ () Teeno. 1 | (®) from 1st tee |
Vea () from 1st and 10th tee
M Docte <
e 10 Q minutes apart
¥ () Teeno. 1 1 |
Vea
& Fried: ( Cancel ) ( Assign Tee Times ) ;
& Mary | v
B Players in 4 carts for 4 tee times
( Apply ) ( Assign ) ( Cancel ) ( Show Cards )
P

Bl
Tee Time Assignment

For events with assigned (sequential) tee times, indicate the first time,
whether the events starts from 2 tees, and the interval between tee times.
'When you click the Assign Tee Times button, appropriate times will be
assigned to all the participants in the planning window (changes are not
made in event scorecards yet -so you can change your mind or make addi-
tional changes). If your event requires a simultaneous start in which the
competitors start from different tees at the same time, choose Shotgun Start
and indicate how the starting tees are assigned.

'When you have assigned the contestants to the tee times or starting tees you
prefer, click Apply to save that information to the event scorecards.

Finally, to produce the golf cart signs for the event, click the Show Cards
button in the planning window, and print the contents of the resulting win-
dow to standard 8 %2 x 11 paper or card stock:




122 Editing Event Information

Stableford Best Ball
Bushwood Country Club
Wednesday, July 6, 2011

Doctor Beeper

Al Czervik

7:40 AM

Cart Sign

Starter’s List

For an event, a Starter’s List provides a list of all the competitors for use by
the starter or professional responsible for starting, cart assignment, and tee
times.

Publish Session List

If Remote Scoring features are enabled for Eagle (see “Remote” on page

20), you may publish, for remote use a Session List, which describes the
Event, the competitors and their Scorecards. Remote devices can use a
Session List to provide scores, which can be returned to Eagle for permanent
use and storage. Choose Publish Session List... in the Reports menu to
indicate how the list is published:
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Event = Christmas Best-Ball

Results Fast Scoring

J Session List

vebb, Ty & Havercan z: Publish to Dropbox
. ‘, Publish event scoring information to the Dropbox/fApps/

Mulligan Scoring folder for use by remate scoring
applications using the same Dropbox 1D,

=N

=

{avercamp, Frieda &

Publish to iCloud
r
EEEEEE Publish event scering information to the Mulligan Scoring
folder in iCloud Dirive for use by remote scoring

applications using iCloud with the same Apple 1D.
‘eeper, Doctor & Cze

“addies - Noonan & D'Annunzio [ = "4 | & | Options ::

=

Publishing a Session List

Note: Publishing Session Lists via iCloud is available only from copies of Eagle
purchased from the Mac App Store.

Results

\ 'The Results panel in the event window is where individual or team con-
testants are added to the event, and where the results are displayed and
compared. The Results panel is effectively the “scoreboard” for an event.

800 Event - 2009 New Year Scramble

=}
=

2009 New Year Scramble
Net Florida Scramble - Thursday, January 1, 2009

Na contestants - Click + to add contestants.

Handicapping: 35% of A-Player's Course Handicap plus 15% of B-Player's

Event Window - Results

Add Contestant — To add a contestant to an event, click the Add button at
the lower left of the window. A sheet will be displayed for you to select the
players to appear, individually or as a team, on scorecards for the event. See
the next section “Adding Contestants to an Event” on page 126 for details.
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from the menu:

Sort — At any time after you have added contestants to the event, you can
sort the list of results by clicking the Sort button and choosing a criteria

2" net

SR [ Pace ]

-

alphabetically

alphabetically by first name

by contestant or team 1D

by flight

by gender (men, women, unknown)
randomly

by handicap allowance, increasing
by handicap allowance, decreasing
by tee time

by starting tee

Gross 5core
Met Score

Placement

Event Results Sort

Selecting a method of sorting does not disturb the existing order of con-
testants who sort the same. For example, if the contestants are sorted
alphabetically, then sorted by flight, the resulting list will be ordered alpha-
betically (the first sort) within flights (the last sort).

Sorting contestants will not alter the computed results placement shown in

the list.
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Place — You may designate how “places” in the event should be determined
by clicking the Place button to display a menu of options:

3" gross, 2 " net [

) ]

Gross Only
‘ Met Only
Cross, then Net

MNet, then Gross
GCross & Net

1st Gross, rest Net
Lst Net, rest Gross

¥ Full Field
Flights
Overall, then Flights

Event Results Placement

'The menu will allow you to select only options compatible with the style of
the competition:

Gross Only —The event’s results are determined from gross scores only.
Net scores are not reported (although they may appear on the contestants’
scorecards).

Net Only —The event’s results are determined from net scores only. Gross
scores, though they may be used for calculation of net scores, are not
reported.

Gross, then Net — Both gross and net scores are reported for the event,
but contestants place only with their gross score or net score, but not both.
Gross scores have precedence, so places are determined in order: 1st Gross,
1st Net, 2nd Gross, 2nd Net, etc. In events with both gross and net results,
this method prohibits a contestant from placing in two categories.

Net, then Gross — Both gross and net scores are reported for the event, but
contestants place only with their gross score or net score, but not both. Net
scores have precedence, so places are determined in order: 1st Net, 1st Gross,
2nd Net, 2nd Gross, etc. In events with both gross and net results, this
method prohibits a contestant from placing in two categories.

Gross & Net — Both gross and net scores are determined and reported, and
each contestant’s placement in both categories is shown.

1st Gross, rest Net —The winning gross score (and ties, if necessary) is iden-
tified, and the remainder of the places in the competition are decided by net
scores.
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1st Net, rest Gross — The winning net score (and ties, if necessary) is identi-
fied, and the remainder of the places in the competition are decided by gross
scores.

Full Field — All contestants’ places are determined relative to all the contes-
tants in the event.

Flights — Contestants’ places are determined within their specified flight.

Overall, then Flights — The overall winner(s) of the event are determined
and the remainder of the constestants’ places are determined within their

specified flight.

Adding Contestants to an Event

From the Results panel of the event window, click the Add button at the
lower left of the window to begin adding a contestant (individual or team) to
the event. A sheet will be displayed for you to select the players to appear on
a single scorecard - either as individual co-competitors or teammates:

‘ Players to add to a new scorecard: fQall b
. R E— e M
—q Net Florida Scramble | © | Players i | —
O [:] ‘ Doctor Beeper 12.4 |a
1| @ & Al Czervik 14.1 Pl
5
I: _Noonan. Danny e % Mary Czervik 34.6 ' j
Team Members \ Tee | Index| Hd:pl" 1 ,‘ Tony D'Annunzic 14.4:' —
B Danny Noonan O = 5.5 B ‘ Earl Havercamp 8.7 2nd
5 Frieda Havercamp 15.6 ;  m—
< Danny Noonan 5.5 '
E £ Agnes Smails 37.8 =
1 ® § Judge Smails 1358
2 o =} Pla
& Spaulding Smails 334 vl ©
2 d
et L - EI [ Show registered players only F
& Quick Add ( Cancel ) _Add to Event )
A

Adding Event Contestants

The list to the right side of the sheet shows the players who can be added to a
scorecard for this event. You may filter this list of players by name with the
search field at the upper right of the sheet or restrict the players eligible for
selection by displaying only players previously registered for the event.
Players whose entry is marked with a blue @ indicator are those registered
for this event. Players whose name is dim and cannot be selected are already
contestants as individuals or team members in the event.

When you have selected one or more players from the list on the right, click
the Move button to move them into the list on the left of co-competitors or
teammates who will appear on the same scorecard.
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Note: The expected (or required) number of players to complete a scorecard in the
event is shown immediately below the list of players on the left. The limits and the
number of players selected may effect whether you can proceed to add the players fo
the event. If the Add to Event button at the bottom right of the sheet is dim, you
may have provided too many or too few players or you may need to return to the
Setup panel to adjust the number of players that can appear on a scorecard (see
“Setup” on page 109).

Sort — Click the Sort button to temporarily sort the list of eligible players to
aid your selection:

BT Webb

alphabetically | ==
alphabetically by first name

by gender (men, women, unknown})
randomly

by increasing handicap

by decreasing handicap

Contestants Sort

Show registered players only — Check this box to restrict the list of eligi-
ble players to only those who are previously registered for this event - those
marked with a blue @ indicator.

You may remove a player from the list of competitors on the left by selecting
them in the list and clicking the Remove button. The player is again eligible
for selection from the list on the right.

When you have finally identified the players to appear as teammates on the
scorecard in a team event, you can provide an alternative name to identify the
team:

‘ Players to add to a new scorecard: fQal )
1 Net Florida Scramble I L |, |
d ® § Doctor Beeper 12.4 &
_E ICaddies - Noonan & D'Annunzio| I : g deCr:Ecr:;t\-ik ;j_é E
e Team Members | Tee | Index| Hdcpl | A Tony D'Annunzio 144 B
%d Danny Noonan 9 : 5.5 6 & Earl Havercamp 8.7 [i{fond
e’ Tony D'Annunzio 6 = 14.4 17 .§ Frieda Havercamp 15.6 E—

d Danny Noonan 5.5
E £ Agnes Smails 37.8 &
® § Judge Smails 13.5 .
a’ Spaulding Smails 33.4 84 Lb

e i [] Show registered players only
# Quick Add (" Cancel ) ( Add to Event )

-

Adding Team Contestants
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To add the selected competitors and their team (if any) to an event scorecard,
click the Add to Event button. The appropriate scorecard for the competi-
tors will be automatically created, and one or more entries will be added to
the Results panel for each added contestant.

If you wish to add a player’s round that has already been recorded on a
scorecard to an event, make sure the Results panel is selected in the event
window, and the scorecard is open as the frontmost window:

Event - The Big Pe

7o

Setup Registration Results Fast Scoring

\, ] ML The Big Peoria
2 - Bushwood Country Club  Pegria System - Saturda

Club |Bushwood Cour

@ Al Cznrvi? [)rag Course |Bushwood Golf
Eﬂnnn Sides | Front Nine

1)12)|3)4
(sl ionship Tees |41

Par (4|3 ([5]4
Handicap [ 5 |17[ 1 |11

Ty Webb nnﬂ“

or Drag

Dragging to Add a Contestant

Drag the scorecard icon at the top left of the scorecard window onto the
event window, or drag the round by dragging the competitor’s name onto
the event window. If the round on the scorecard is appropriate for the event
(team or individual scoring, the competitor isn't already a contestant, etc.), it
will be added to the event and displayed in the Results panel. If necessary,
the date, club, course and sides specified for the event will updated on the
scorecard.

Removing Contestants from an Event

B 5 | [fa To completely remove a contestant (an individual or a team) from an event,
— | g Edit Player... click the Options button in the results area of the contestant to be removed,
B scorecard... = and choose Delete Contestant. You will be asked to verify your request (see
en 35 E

Show Allowance Dots page 132 for more details).
‘ Move Round Up

Move Round Down

Delete Contestant...

If you need to add, remove or substitute for team members of a contestant

team, do so by opening the team’s scorecard (clicking the scorecard but-
Dsauaified ton in the event results area or choosing Scorecard... from the Options
menu shown at the left), then proceeding by choosing Edit Teammates...
from the team score options on that scorecard (see “Adding and Removing
Teammates” on page 91).
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Adding a New Player

Wohen setting up an event, you may need to quickly add information about
a player who has not previously been set up in your database for scoring or
handicapping. The capability is particularly useful if you need to add golfers
to an event for whom you don't plan to keep data for analysis or tracking.

Start by clicking the New Player icon at the top right of the Event window.
A “sheet” will be presented allowing you to provide basic information about a
new player:

i L
Pairings | Results | Fast Scoring
Add a New Player
" Name: ISpauIding | | smails H—
ickering, T | flight
Gender: @male () female
Home Club: IBushwood Country Club [+

ceper, Dg Handicap: _| flight

EE [2] Cuest

Jebb, Ty { [ Cancel | [ Add | ||[flignt

:’:’:IIIIIIIIIIII

zervik, Al & Smith, Sam
T

[ 1 |
[ & | # [options¥| [ 10 | [fight
T T T

New Player Sheet
Name — Provide the player’s first and last name.
Gender — Select the proper button.
Home Club —Type a name or select from the drop-down list.
Handicap — Enter the player’s handicap as recorded at their home club.

Guest — If this is a one-time player or visiting event competitor, check the
box to exclude them from certain activities, like handicap calculations.

When you click the Add button, that player is immediately available for
addition to a scorecard, team, event, etc. If you don’t plan to enhance the
data on file for the player, make sure you specify them as a “guest” (for addi-
tional information, see “Guests” on page 73).

Note: All the settings entered when adding a new player by this method are modi-
Jrable using the normal editing functions available in Eagle (see “Editing Player
Information” on page 50).
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Event Scoring

When you have decided who the contestants are in an event, the Results
panel of the event window will show all of them:

800 Event - Christmas Best-Ball =

\é Christmas Best-Ball
Net Best-Ball - Saturday, December 20, 2008

16 e Havercamp, Frieda & Czervik, Mary +* ‘ E 3 |0plionsv‘ I | I flight
v [ T T T T T T T T T TTTTTTITTIT [ ]

i o O Webb, Ty & Havercamp, Earl | = | + ‘ ¥+ |0plinns v‘ D flight
wor [ [ T T T T T T T T TTTTTTTT T |

15A @ Smails, Spaulding & Judge [E] 2] % [options~| [ 10 | [flight
o [ TTTTTTTTT TTTTTITITTITITL T ] [

17 o Caddies - Noonan & D'Annunzio | E | +* ‘ E 3 |Clplions V‘ [[s] flight
wo [ T T T T T T T T T TTTTTTTTTIT [ 1]

188 o O Beeper, Doctor & Czervik, Al | = | + ‘ 4 | Options = D | flight
woem [ T T T T T T T T T TTTTTTTTTT [ 1 []
Handicapping: Men DO?KE:fnlt:?:ri::Handicip, Women 95% /

Event Window - Results

'The display for each contestant includes their name (the team’s name if the
contestant is a team of players) and the tee(s) from which they are playing

the event. If a starting tee or starting time have been entered during setup
of the event or on their scorecard, it is shown to the left of the contestant’s
results.

Scorecard — Click the scorecard button to open the contestant’s scorecard
and bring it to the front. All individual or team hole-by-hole scores are
entered from the scorecard, as in this illustration:

F Club  Bushwood Country Club Date Saturday, December 20, 2008 &

Course Bushwood Golf Course Tee | 188 | Time | 01:00 PM| @

Sides  Front Nine Back Nine = options

1(2)3(4[|5[6|7|8|9|0ut|l0|11]12]13|14|15]|16[17[18| In |Tot
Championship Tees [412|183|522(385(394] 79|401| 3364 [495(370(414(392(164(401|388(175|502( 3305 | 6669 | 71.5/132
Men's Tees |402(166(504|360(384(180(479(362(390| 3227 [480(366 |402|355(148(386|364|165(484( 3150 | 6377 | 70.2127

Par (4 |3 (5|4 |4|3|5|4|4|36|5|4)4|4(3[4)|4|3|5|36)72

Handicap |5 [17[1 [11] 98 [15]3 [13]7 6 [14] 2 [10[18] 8 [12]16] 4

A [W Hand\[aplndak@:_ 12.4] |Putts| f|}|0plinnSV|6
Doctor Beeper [5 [5[4[5[4[4[6[5[6]44[6[6]5[4]a[5]6[a][5[43[87[14]73]

B (@] Q‘ Handicap Index®: | 185 |F'L||tts|f|lr|clplions'|6
AlCzervik [5][6[5]5[5]5[5][6[5[47[6[5][4[5[4[6[6]a[5]4a5[92]21][71]

Christmas Best-Ball Beeper, Doctor & Czervik, Al 4+ | E 3 Clplions'6
Four-Ball [5[5]4[5[4[a[5]5][5]42[6[5]4[4]a3[5]6[3[5[4a1[83] Je9]

Men 90% of Course Handicap, Women 95%

Event Scorecard
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Move Up — Click this button to move the results for a contestant upward in
the list. Their position in the list has no effect on their results or placement
in the event.

Move Down — Click the button to move the results for a contestant down-
ward in the list. Their position in the list has no effect on their results or
placement in the event.

Options — Click this button to display a menu of options available for this
contestant. See the next section “Contestant Options” on page 131 for
details.

ID — If you assign team or contestant numbers or ID’s of some kind , you can

type those values in the provided field. You may then sort this list by ID.

Flight — If your event includes flights or divisions, you can type the name or
identification of the flight in which each contestant belongs. You can sort

the list by flight.

Contestant Options

When you click the Options button in the results area for any contestant, a
menu will be displayed where you can perform certain activities:

lr_ Options * D flight
| Edit Player...

[ scorecard. ..
en 351

ort
Show Allowance Dots
‘ Move Round Up F
Move Round Down
Delete Contestant...

Disqualified
Clear Scores

Contestant Options

Edit Player... — If the contestant is an individual, choose this menu item to
open an editing window for the player. The option is not available for teams,
although you may edit team characteristics, like its members or its name,
from the available options on the contestant’s scorecard.

Scorecard... — Open the scorecard for the contestant and bring it to the
front. This is the same action as clicking the Scorecard button.

Show Allowance Dots — If the format of the event dictates a handicap
allowance applied hole-by-hole, display the strokes available at each hole,

based on that allowance.

Move Round Up — Move the results for this contestant upward in the list.
This is the same action as clicking the Move Up button.
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Move Round Down — Move the results for this contestant downward in the
list. 'This is the same action as clicking the Move Down button.

Delete Contestant... — Choose this menu item to delete the contestant from
the event. You will be asked to confirm your request, and may need to con-
sider situations like illustrated here:

Are you sure you want to delete the Christmas
W Best-Ball result for Mary Czervik & Frieda
i‘ Havercamp? e
srean fli
E[ Scores have been entered for one or more players on this team. :
Deleting the result will remove this team's scorecard and those
SCOres. —
b, Ty | fli
E[ To preserve the t tes' scores but their team from
— the event, click “Keep the Scores". I
ils, § fli
E[ ( Keep the Scores ) ( Cancel ) E—Belc!c—)
lies fli
Talalalalalaslalalalalelalelalal as] enl a1

Deleting a Contestant

If there are players’ results already entered and you want to preserve them

- effectively “detaching” them from the event - click the Keep the Scores
button. To delete the contestant from the event, including the scorecard and
any results, click the Delete button.

Disqualified — If checked (v), indicates that this contestant’s result has been
disqualified from the event. To re-instate the contestant’s results, choose the
menu item. If unchecked, the contestant’s results are eligible for calculating

placement in the event. Choose this menu item if you wish to disqualify the
contestant.

Note: This is disqualification of the contestant for the entire event. In a team com~
petition, a team member may have a score for a hole disqualified from inclusion in
the team score by recording an “X” status at a hole.

Clear Scores — If this contestant’s results are based on entry of hole-by-
hole scores, not a calculated result, choose this item to clear those scores. For
individuals, this includes clearing putts and other hole-by-hole status. For
calculated results, this item is unavailable, but individual teammates’ scores
can still be cleared from the scorecard.
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Fast Scoring

When you are conducting a large event in which many player scores arrive
at the same time to be entered, you can quickly and efficiently enter those
scores by selecting the Fast Scoring panel. A tabular list of the competitors
for whom scores are required is displayed.

8en0o0 Event - Christmas Best-Ball —
]
=
% Christmas Best-Ball
d Net Best-Ball - Saturday, December 20, 2008
Competitor_ [1fefsfa]s[6]7[8]o ou[10/0]12[13[14[15]16[17]18 In [ Tot [@]
octor Beeper
Dn B 6 6| 4|5 5|3 5 6 6 46 5 5/6,4 3 4 4|5 5 41 87 @
zervil
AlC ik 6| 4|6 |5 |6 |4]|35 LT 48 6|5 |4|6|3 T | A T 47 85 @

G MamCeenk 161617 s ols o lals oo N | ]

& Tony D'Annunzio
& Earl Havercamp
% Frieda Havercamp
Y Danny Noonan
& Judge Smails

Y Spaulding Smails
& Ty Webb

10 scores - 2 complete

Event Window - Fast Scoring

To enter scores, select the competitor’s row by clicking, then press the TAB
key to select the contents of the cell representing the first hole. Type the
player’s score for the hole, and the selection will automatically move to the
next hole. Continue typing hole-by-hole scores until you have completed
entry of the player’s score.

To skip the score for a hole (if no score is returned), type a single sPACE key,
and entry will proceed with the next hole. To indicate an “X” for the player
at a hole, type the shorthand key for an “X” score and entry will proceed with
the next hole. Type a TaB key to skip a hole without changing its score.

@ - A green indicator in the right-most column of the table indicates that
scoring is complete for that competitor.

'The scores entered in the Fast Score panel will appear on the scorecard for
each player. Any team scores that need to be recomputed will be adjusted.
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Final Results and Placement

When you have provided scores for the event by entering information
returned for each scorecard, the Results panel reflects that data:

®O® Event - Christmas Best-Ball =)
=
—
\; Christmas Best-Ball
Net Best-Ball - Saturday, December 20, 2008
16 O Havercamp, Frieda & Czervik, Mary +* ‘ E 3 |0|)liuns'“ | Ilﬂighl |
100 [2]4]4]3]6]6[4a]1]2]32]2]2]4[5]4a[2]3]2]4] 28] 60] 1% net
1 O O Webb, Ty & Havercamp, Earl |E| +* ‘ E 3 |Clplionsv‘ ‘ [[s] | |Fllght |
1o0pa [4]3[3[44a]3]3]5]3[32[4[5[3[4[3[4a]5]2[5][35]67] [71] 1% gross
18A 0 Smails, Spaulding & Judge |E| +* ‘ ¥+ |0plinnsv‘ ‘ D | |Flight |
voorm [4JaJaf7JaJafaa]s[38 a2 s]3]2]aJaf2]3]27]65] 2™ et
Caddies - Noonan & D'Annunzio |E| +* ‘ E 3 |0|)liuns" ‘ o] | !flighl |
toopm [5[3[4[3[4[3[afaa3a[afafa[a[5]a[5[3]a]35]69] 2™ gross
O O Beeper, Doctor & Czervik, Al |E| +* ‘ & |Clplionsv‘ ‘ [[s] | |ﬂ|ght |
100em [5[a[3afa[3]afa[5]36 [aa[a[a]a[a[a]a]a]31]67] 37 et
5 contestants
Handicapping: Men 90% of Course Handicap, Women 95% /
)

Final Results

Use the Place menu to choose how the placement of contestants will be
determined (see “Results” on page 123). The placement of every contestant
according to that selection will be displayed to the right of the results, as
illustrated above.

Note: Remember that placement considers any tie-breaking calculation you have
specified for the event. Total results that look the same in the display may earn dif-

ferent placements based on the tie-breaker. Ties that remain are indicated as ties.

Use the Sort menu to organize results as you require (see “Results” on page
123). You can sort the list of contestants by their calculated placement. The
list stays in the resulting order until you choose to sort it again. That is, if a
contestant’s name, score, placement or other data change, they won’t move in
the list until you re-sort it.

To display skins for an Event from the Results panel, choose Show (Hide)
Skins from the Golf menu or type < #K (SHIFT-COMMAND-K) to show or
hide holes that are computed as “skins” for this event. Holes scored as “skins”
are displayed with a special colored background.
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Exporting Event Information

Exporting a List of Events to a Spreadsheet

From Eagle’s main window, you can export data for selected events to an
open spreadsheet application. With Eagle frontmost, select the events of
interest and drag the selection to the spreadsheet:

o EvENL i | Competition
| \Y puttin' On The Ritz The Ritz
N Even?lﬂ Florida Scramble Medal Play
Net Selec

Fa

Fok
21Feb

1jan 20

Peoria System

Dragging a selected list of events to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
each selected event:

* Event name

* Competition format

* Date

'The data is organized in a tabular array, one event per row, when inserted into
the spreadsheet:

< |
1 |Extravaganza Net Salacted Holes | 21-Feb-03
2 |2009 Mew Year Scramble Net Florida Scramble 1-Jan-08
3 | Christrnas Best-Ball Net Four-Ball | 20-Dec-08
4

5 |
[

[ 7 |
8

9
10

Spreadsheet Events List
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Exporting Event Data to a Spreadsheet

You can also export detailed information about a single event to an open
spreadsheet application by opening an editing window for the event, then
dragging the icon at the top left of the window onto the spreadsheet:

/800 _ _ ~ Event - Christmas Best-Ball

Christmas Best-Ball

Net Four-Ball - Saturday, December 20, 200

..................................... = 1 @ () Waebb, Ty & Havercamp, Earl = :‘
. |limm([4a[3[3[4]4]3]3]5]3]32]4a|5[a]4]3]4]5]2]5]35]6

E 16 @ Havercamp, Frieda & Czervik, Mary Hl+|$

Dragging detailed event information to a spreadsheet

A tab-delimited, textual array is exported to the spreadsheet, including for
the event:

* Date

* Event name

* Club name

* Course name

* Front nine

* Back nine

* Starting tee

* Tee time

* Tournament scorecards (yes or no)

and for each competitor’s results in the event:
* Competitor’s name
o Tee
» Tee color
* Holes 1 - 9 competition score and total
* Holes 10 - 18 competition score and total
* Total score
* Handicap or allowance
* Net score
* Gross score
* Placement description (1st, etc.)
* Rank
* Tie (yes or no)
* Gross rank
* Gross tie (yes or no)
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* Scoring complete (yes or no)

* Disqualified (yes or no)

* Ignored for handicapping (yes or no)
* Trend handicap

®eco

Smart
< A | B | E [DTEJF]IGTH] I [J[K[L[M[N]JOTP]C
1 |Date Event Club Cours Front Back Tee  Time Tournamant | | |
2 | Saturday, December 20, 2008 Christmas Best-Ball Bushwood Gount Bushy Front Back Nine | #### Yes
3 | Compelitor Tee Calar 2 3 4 5 & T a8 9 Out 10, 1 12
4 | Earl Havercamp & Ty Wabb Championship Tees | Blue 4 3 3 4 4 3 3 -] 3 32 4 5 3
5 |Mary Czenik & Frieda Havercamp | Ladies’ Tees Fad 3] 4| 4 a3 € & 4 1| @ a3 3| 3| 4
6 |Caddies - Noonan & D"Annunzio | Championship Tees | Blue 5 3 4 3 4 3 4 4 4 34 4 4 3
7 | Doctor Baeper & Al Czervik Champienship Tees | Blue 3 4 3 4 4 3 4 4| 5 34 4 4 3
8 |Judge & Spaulding Smails Championship Tees | Blue 4 4 4 T 4 4 4 4 3 a8 4 2 3
9
o I | | | I |
1L
1z
(13
14
15

Spreadsheet Event Data

If your spreadsheet application has difficulty importing data dragged from
Eagle (no columnar results, improperly interpreted numbers or spacing, etc.),
you may need to change the format of the dragged information. See “Drag
& Drop data delimiters” on page 17 for more information.

Deleting Events

With Eagle’s main window front-most, show the list of events, select the
events to be deleted, then click the Remove button at the lower left corner.
Or, choose Delete from the Edit menu, or type & (DELETE). You will be
asked to confirm that you really want to delete the event(s). Click OK to
delete or Cancel to continue without deleting.

Deletion is permanent and cannot be undone. The events and all of the
configuration and registration information is deleted. Team rounds that are
only related to a deleted event are deleted, and if they are the last round on a
scorecard, the scorecard is automatically deleted too. In some cases you may
specify if you wish to keep individual players’ rounds in place on their score-
cards. If you keep them, they remain in the players’ scoring records.

Note: If the Remove button is not available (the button is dim), either there are no
events in the list selected for deletion, or the event list has been locked to prevent the
addition or removal of events(see ” on page 11).
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Chapter 6

Handicapping

Whether computing handicaps for one player or hundreds, Mulligan’s Eagle

has capabilities to provide casual or official handicaps for any golfer.

In this Chapter...

Introduction

Handicapping Systems
USGA Handicap System™ .. .............. ... ... .. 140
World Handicap System . .............................. 140
RCGA Handicap System™. ....... ... ... ... ... ..... 141
CONGU Unified Handicapping System. . ................. 141
Australian Handicapping System. . .......... ... ... .. ... 141
Mulligan Handicapping. . ......... ... . oo 142
Second-Best Score System. .. ... ... .. ool 142

Personal Handicapping

Single Round (Event) Handicapping
The “Official” Callaway System . ............ ... ... ... .. 143
The Scheid System. .. ... 143
'The Peoria and Modified Peoria Systems. ............ ... ... 143
System 36. . ..o 144
Zig-Zag Handicapping . .. ........ . ... .. .. L 144

Calculating Handicaps
How Handicap Recordsare Used ..................... ... 147
Synchronizing Your Handicap Calculations ................ 148
Retroactive Handicap Calculations . ................... ... 148

Handicap Cards
Standardized Formats ............ ... ... .. ... L 150
Printing Handicap Cards. .. ....... . ... .. ... ... 150
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Introduction

Introduction

Any golf handicapping system is essentially a way for golfers of various skill
levels to compete equally and have fun. You may have played in events that
computed your “net” score in a number of ways — using a handicap com-
puted from just one round, like the Callaway or Peoria methods, or using the
handicap or Handicap Index computed for you by your home golf club or
golf association.

You might also be responsible for handicapping a group of golfers, like the
players in your league, on your golf team, or at your club.

Mulligan’s Eagle supports most of the handicapping systems described in
this chapter.

Handicapping Systems

USGA Handicap System™

The United States Golf Association administers the Rules of Golf and the
Rules of Handicapping in the United States and on behalf of other national
golf authorities. Sinces January 1, 2020, the USGA, in association with the
R&A implemented the World Handicap System, and ceased use and autho-
rization of The USGA Handicap System.

'The Rules of Handicapping manual is available (along with many other

publications, like the Rules of Golf) from the USGA Order Department at
http://www.usgapubs.com or 1-800-336-4446.

World Handicap System

'The World Handicap System (WHS) was introduced in 2020 as a unified
organization of multi-national golf associations responsible for the adminis-
tration of golf and its rules around the world. Initiated and developed by the
United States Golf Association and the R&A, the Rules of Handicapping
are regularly reviewed, updated and published by the USGA, the R&A

and certain major national golf associations who administer handicapping
throughout the world.

'The World Handicap System and its associated golf authorities specify the
rules by which a golf club, organization or association calculates, issues and
authorizes golf handicaps for its members. In the United States, the Rules
of Handicapping are available online at https://www.usga.org/handicapping/
roh/2020-rules-of-handicapping.html.

An authorized golf association or golf club must obtain permission to use
the trademarks and service marks associated with the WHS, and to issue
a Handicap Index. Mulligan Software provides support for the World


http://www.usgapubs.com
https://www.usga.org/handicapping/roh/2020-rules-of-handicapping.html
https://www.usga.org/handicapping/roh/2020-rules-of-handicapping.html
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Handicapping System, and users must certify that this capability is used for
the purpose of following the Rules of Handicapping and use of the USGA’s
and associated authority’s marks. Only an authorized golf association or golf
club can issue a World Handicap Index.

RCGA Handicap System™
The Royal Canadian Golf Association (Golf Canada) publishes the RCGA

Handicap Manual, which is the complete book of information and instruc-

tion about the RCGA Handicap System.

An authorized provincial golf association or Member golf club must obtain
a license from Golf Canada to utilize the RCGA Handicap System, to

use Golf Canada’s trademarks or service marks, and to issue an RCGA
Handicap Factor. Mulligan Software provides support for the RCGA
Handicap System, and users must certify that this capability is used for the
purpose of following the RCGA Handicap System and using Golf Canada’s
marks. Only an authorized provincial golf association or member golf club can
issue an RCGA Handicap Factor.

CONGU Unified Handicapping System

'The Council of National Golf Unions comprises representatives of nine
golf unions in Great Britain and Ireland, who publish and administer the

CONGU Unified Handicapping System.

A golf union and its affiliated clubs are charged with the responsibility of
administering the Unified Handicapping System in their jurisdiction and
providing their members with a CONGU Handicap. Mulligan Software
provides support for the CONGU Unified Handicapping System, and
users must certify that that capability is used for the purpose of calculating a
CONGU Handicap on behalf of the affiliated home club of a member.

Australian Handicapping System

Golf Australia, the governing body for golf and golf handicapping in
Australia, publishes and maintains the Australian Men’s Handicapping
System and the Australian Women’s Handicapping System.

Australian handicapping is administered by the responsible State Handicap
Manager and the club handicap manager or committee who provide appro-
priate recording of scores and the calculation of an affiliated member’s
exact handicap. Mulligan Software provides support for the Australian
Handicapping System, and users must certify that this capability is used

for the purpose of calculating an Australian Men’s Handicap or Australian
Women’s Handicap on behalf of the affiliated member’s home club.
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Personal Handicapping

Mulligan Handicapping

'The Mulligan Handicapping System has been in continuous use since 1995
by clubs, leagues and golf organizations. Developed by Mulligan Software
and supported by the classic Mulligan’s Golf Personal stats and handicapping
application, the Mulligan System closely resembles the scoring system of
other sports, discarding the best and worst performances and calculating an
“Estimated Handicap” from the remaining scores.

'The Mulligan System produces quite stable and useful handicaps calculated
on gross scores and their relationship to the best available course ratings
from the tees played. Popular use seems to indicate that the method pro-
vides accurate and competitive playing handicaps for players of all skill levels.
Mulligan’s Eagle supports the Mulligan Handicapping System without any

limitations on its use.

Second-Best Score System

The Second-Best Score System (copyright © 1980, 1989 United States Golf
Association) was developed by the USGA to provide a method of handicap-
ping a player with just a few rounds available. It bases a player’s handicap on
a formula which uses the player’s second-best reported score. The USGA
provides this disclaimer:

“The Second Best Score System is an alternative handicapping method intended for casual
play and local use only. A Second Best Score System handicap is not transportable from

club to club. NOTE: The use of the Second Best Score System will not produce a valid
USGA Handicap or a USGA Handicap Index.”

Mulligan’s Eagle supports the Second-Best Score System for handicapping

players with few rounds available.

Personal Handicapping

You may wish to configure and use a handicapping technique of your own.
Mulligan’s Eagle supports this capability, and allows you, in the application
preferences (“Handicapping” on page 17) to indicate key parameters that
will be used to calculate a handicap for players. If none of the handicap-
ping methods described here are appropriate for your use, you may be able to
specify a calculation that meets your requirements.

Single Round (Event) Handicapping
Mulligan’s Eagle supports a number of single round handicapping meth-

ods developed for golf events in which there are a number of unhandicapped
golfers, or golfers with a very wide range of skills.
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Generally, the goal of single round handicapping is to derive a handicap (or
handicap allowance), computed from all or part of the player’s gross scores,
that can be used to provide a net score by which the competition is decided.
Whether the calculation is biased toward rewarding good play, or produc-
ing almost random results, most methods tend to “shrink” the range of scores
returned by the competitors. The effect is that those who don’t win come
close.

Mulligan’s Eagle supports the single-round methods described here (also
mentioned in the “Glossary” on page 201):

The “Official” Callaway System
The Callaway System (copyright © 1957 Lionel F. Callaway) computes a

handicap based on the hole-by-hole scores of a single round, ignoring some
number of a player’s “worst holes” based on the player’s total gross score for
the round. It is useful for computing handicaps for a group of unhandi-
capped players or for players with no playing history on which to base a
handicap. The objective of the Callaway System is to produce net scores in
a range from par to the middle 70’s. Occasionally, a net score below par is

produced.

The Scheid System
'The Scheid System (copyright © 1988 United States Golf Association)

computes a handicap based on the hole-by-hole scores of a single round. It
is useful for computing handicaps for a large group of unhandicapped play-
ers or for players with no playing history on which to base a handicap. The
Scheid System produces approximately equal net scores. The USGA pro-
vides this disclaimer:

“The Scheid System is an alternative handicapping method intended for casual play and
local use only. A Scheid System handicap is not transportable from club to club. NOTE:

The use of the Scheid System will not produce a valid USGA Handicap or a USGA
Handicap.”

The Peoria and Modified Peoria Systems

Both the Peoria System and the Modified Peoria System are commonly used
to compute handicaps for a group of unhandicapped players or for players
with no playing history on which to base a handicap.

In a Peoria competition, the committee selects, unknown to the players, six
holes on the course at which the player’s scores will be used to compute a
single-round handicap. The methods differ only in the computation of the
player’s handicap allowance for the round.
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Calculating Handicaps

System 36

System 36 is a method of computing a one-round handicap for events in
which unhandicapped players participate. The player’s handicap allowance is
derived from “points” which are earned by pars and bogeys made during the
round. The more points accumulated, the lower the allowance.

Zig-Zag Handicapping
Zig-Zag handicapping is a method of calculating a handicap in a Scramble

or other team event. It generates net results of a somewhat random nature,
with almost all results under par.

Calculating Handicaps

To calculate handicaps for some or all of the players for whom you keep
records, choose Calculate Handicaps... from the Golf menu. If you want

to perform the calculation for just a single player or small group of players,
select them in the Players panel of Eagle’s main window before you choose
the Calculate Handicaps... menu item. A dialog will be displayed for you to
indicate what kind of handicap calculations you want:

[ JON J Handicap Calculation
Calculate New Handicaps Schedule Handicap Calculations Remove Handicap Records
With rounds through: ‘ Wednesday, September 30, 2020‘ ’

For: All Players
Members of ~ Bushwood Country Club
OAII World Handicap System handicaps

Cancel Calculate

Handicap Calculation Dialog

Select the handicapping calculation activity you want to perform. Generally,
you'll choose Calculate New Handicaps - creating handicap records for a
group of players. You may also schedule regular automatic handicap calcu-
lations by choosing Schedule Handicap Calculations. Or, this calculation
function also provides a method to remove old handicapping records for
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periods before or after a specified date. To perform that activity, choose
Remove Old Records.

With rounds through — Indicate the ending selection date for the handicap
calculations - the last date on which a round can be recorded and be included
in this calculation. Any rounds after this date are not considered for calcu-
lating new handicap records.

Note: If your schedule for calculating handicaps must coordinate or coincide with
a schedule dictated by your local or regional golf association or their handicap-
ping service, they may expect a delay between days on which a round is played and
when it is posted for handicap calculation. The effect, commonly seen in club hand-
icapping, is that some rounds that precede the handicapping ‘effective date” do not
appear in the handicapping record. 'Ihis is not the case when calculating handi-
caps with Mulligan’s Eagle. The date you enter here represents a true cutoff date,
and the ‘effective date” of the calculated handicapping record is the next day. That
is, if you select all rounds through December 315t for calculation, the player’s new
handicap is “effective” for any round played on January 1st or later.

For — Identify the players for whom new handicap records are to be calcu-
lated (or records removed). To be included, a player must meet the selection
criteria here (all players, just members of a particular golf club, anyone
whose handicap is determined by a specific handicapping method, or spe-
cifically selected players) and this software must have been certified for use
in calculating handicaps for the player’s designated handicapping method.
For example, if a player’s records indicate their handicap is computed by

the World Handicap System, but this software is not certified to calculate
Handicap Indexes for such players, there will be no handicap calculation for
that player. See discussion of “Handicapping Certification” on page 11.

To perform the specified handicap calculations, click the Calculate but-
ton. The dialog will display the progress of the calculation, then will close
automatically.
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Calculate New Handicaps

Handicap Calculation

Schedule Handicap Calculations

Remove Handicap Records

With rounds through: |

Manday, December 14, 2015| z

For: °AII Players

" Members of Bushwood Country Club B

Al | USGA Handicap System B handicaps
Primary Schedule: = Monthly through the 14th B
Secondary Schedule: | Monthly through the last day B

Cancel Schedule

Handicap Calculation Scheduling

To schedule a regular handicap calculation, choose Schedule Handicap
Calculations, provide a date through which rounds are to be selected for

each calculation, and identify the players whose handicap is to be calculated.
Then...

Primary Schedule — Choose the interval on which the handicap calcula-
tion is to take place. Options are daily, weekly through a particular day of the
week, monthly through a particular day of the month, or monthly through
the last day of the month.

Secondary Schedule — In some cases, an additional calculation might be
desired - for example performing a calculation through the 15th and through

the last day of the month. If needed, choose an appropriate additional
schedule.

Click the Schedule button to finalize and save your handicap calculation
schedule. Eagle will examine the schedule you've requested every time it is
started and will perform the calculation automatically if needed. Automatic
scheduling of a handicap calculation is limited to just one schedule. If you
need another handicap calculation performed according to another sched-
ule, you may do that calculation manually by choosing the Calculate New
Handicaps option.
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[ JoN ] Handicap Calculation
Calculate New Handicaps Schedule Handicap Calculations Remove Handicap Records
Before | Saturday, December 31, 2016| z
For: °AII Players
" Members of Bushwood Country Club B
Al | USGA Handicap System B handicaps

" Selected Player (Al Czervik)

Cancel Remove

Handicap Record Removal

Before or Since — When removing old handicap records, choose whether
you want to delete records before the indicated date or since the indicated
date. Records with an effective date equal to the indicated date are not
removed. Click the Remove button to permanently delete the handicap
records.

Note: 1o review and delete individual handicap records, see the Preferences topic
Advanced” on page 19.

How Handicap Records are Used

Handicap records are produced whenever you calculate handicaps (as

just described beginning on page 144), or make a handicap adjustment

for a player (page 55), or save information after looking up a handicap
(page 57). These records have an “effective date” and contain a handicap
(Handicap Index®, etc.) to be used for play beginning on or after that effec-
tive date. Handicap records continue to be effective until another record is
produced that has a later effective date.

Unless you override the handicap to be used (see “Players’ Rounds” on page
84 and note below), when you create a new round on a scorecard for a
player, the latest handicap record with an effective date on or before the
scorecard’s date is used to determine the handicap to be used for that player’s
round and the calculation of the playing handicap (Course Handicap, etc.)
for that round.

Note: If the Handicap field for a player’s round on a scorecard is overridden (a
value entered), that overridden value remains in effect on that scorecard until its
removed, regardless of any subsequent calculation of handicap records.
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Synchronizing Your Handicap Calculations

Ifit’s required, you are responsible for making sure that your calculation of
handicaps occurs on a particular schedule or is synchronized with your club’s
calculation of handicaps. You may wish to perform a handicap calculation at
the end of every month, or on a particular day of every month. With Eagle,
the process is simple. To calculate handicaps for all your players, make sure
you have entered or posted all their rounds #Arough your chosen date (the
“effective date” will be the next day), then calculate handicaps as described in
this chapter through that date. If you receive eligible scores after the calcu-
lation is performed, you should record the scores, but have a choice about
whether to recalculate a player’s handicap before the next scheduled cal-
culation. Since you have the capability of re-calculating a handicap record
for a single player, you can do so or wait for the next regularly scheduled
calculation.

If you're trying to synchronize your calculations with those of your club or
a handicapping service, you need to know the date #Arough which scores
are included in their processing, regardless of what they call their “effective
date.” You should select the same “through” date when you perform your
calculation.

Retroactive Handicap Calculations

If you have already recorded rounds and need to calculate the handicaps
that should have been used when scorecards for those rounds were created,
you may perform a handicap calculation with an effective date before those
rounds, but you may notice certain differences:

In a player’s list of rounds (“Scores” on page 58), those rounds after the
effective date will not be listed with new playing handicaps. That is, Eagle
will not automatically recalculate playing handicaps for rounds whose scor-
ing is “complete” to prevent possible retroactive changes to net scores, event
results, etc.

In the player’s list of rounds, those rounds after the eftective date whose scor-
ing is not complete wi// have their playing handicaps recalculated. Those
rounds are easy to identify — they’re dim in the list of rounds.

If you wish to update the playing handicap used for a round entered before
an appropriate handicap was calculated retroactively, just open the scorecard.
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Opening any scorecard re-evaluates (if it’s not overridden) the handicap used
to calculate playing handicaps on that scorecard.

Note: 'This means that if you open a scorecard used in an event and it results in
the recalculation of any participant’s handicap, it may also effect the results of the
event. 1o restore the original event results, you may have to override the handicap

used for that player’s round.

If you need to recalculate the playing handicaps for several rounds in a
player’s scoring record, open an editing window for that player and select the
Scores panel. Select (by clicking, surrT-clicking or commanD-clicking) the
rounds for which recalculation is to take place. Then hold down the con-
TROL key while you click and hold to display the contextual menu for the
selected rounds:

hwood Country Club Bushwood Golf Course o8

hwood Country Club Bushwood Golf Course Q

hwood 2 i)

wwood ¢ Edit Scorecards for Selected Rounds %0

hwood, & Match... M i_

hwoed  Print Scorecards for Selected Rounds

hwood

hwoed  Tournament Scorecards 38T 3

:"“‘"“: Penalty Rounds

WO o . .

hwood ONOTE for Handicapping iratl 3
)

Recalculate Course Handicaps

Assign Selected Rounds to Another Player |

‘ Repair Links

Delete Selected Rounds &

Recalculating Playing Handicaps

Choose the Recalculate option in that menu. When you release your mouse
button, handicaps will be re-evaluated and playing handicaps recalculated for
each of the selected rounds.

Handicap Cards

You can produce handicap cards for players in your golf club or association.
If you are properly licensed to provide “official” handicaps for your players,
and you have certified your authority to provide such handicaps, these handi-
cap cards can provide your members with documentation of their “official”

handicaps.



150 Handicap Cards

Standardized Formats

Eagle provides capabilities to produce handicap cards on standard pre-perfo-

rated forms typically used for this purpose:

5377,5870, 5871, 5874,
5876,5877,5882,5911,
8376,8377,8471, 8476,
8571, 8865, 8870, 8871,
8873, 8875, 8876, 8877,
27871,27882,27883,
28371,28873, 28876,
28877,28878)

Form Size Style Custom Image Size
Avery 5390 | 2%"x3%" | Name Badge Insert 1014w x 638h (300 dpi)
(8 cards) (also Avery 5383, 243w x153h (72 dpi)
74461,74549,74556)
Avery 8371 | 2"x3%" Business Card 1050w x 563h (300 dpi)
(10 cards) (also Avery 5371,5376, | 252w x 135h (72 dpi)

Standard Forms

If you have pre-printed forms for your golf club in the style shown in the
table above, you may print handicap card information on the reverse (blank
side) of those forms. Or, you may use Eagle to print a standard design or a
design of your own on the back of the cards.

Printing Handicap Cards

To print handicap cards for a group of players, select (by clicking, sHIFT-
clicking and opTiON-clicking) those players in the Players panel of Eagle’s
main window, then choosing Handicap Cards... from the Reports menu.
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A sheet will be displayed for you to begin the production of cards for the
selected players:

3 Do Handicap Cards b
L, Al 4.1
- mal _For selected Players. .. B4.6
, Tor () Selected Players 14.4
3 N O Members at | Bushwood Country Club H-l B

Frig 15.6
§ Dal Effective: {Saturday‘ February 28, 2009 I @ 5.5
~ Ag . 37.8
 Jud Form: [.Avery 5390 Name Badge Insert M 3.5
) 5P "1 Update Handicap Records 4
l [ 7 cards requested E| |:)-

» = (o) ED gy

Handicap Card Selection

Selected Players — Choose this option to produce handicap cards for the
players you selected in the main window.

Members at — Choose this option to produce handicap cards for all play-
ers who are designated as members of the indicated club (whether selected
in the main window or not). Use the popup menu to select that club if
necessary.

Effective — If necessary, adjust the date on which the calculated handicap
shown on the handicap cards is effective. Only rounds played before (or
handicap records effective on) the effective date will be considered.

Form — Select the type of form on which you will print cards for the selected
players. Your printer should be loaded with sufficient sheets to accommodate
printing all of the selected cards.

Update Handicap Records — If a handicap record is not available for a
player as of the specified effective date, Eagle will perform a handicap cal-
culation to produce the handicap card. If you wish to also save a permanent
handicapping record as of the specified effective date, check this box.

To print the face of the handicap cards, with the player’s name, scores,
handicap and other information, click the Print button. To print the reverse
(decorative) side of the cards, click the Print Reverse button. Your printer
should have the appropriate forms loaded to print the proper side.
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A window will be displayed representing the information to be printed on

the selected forms:

© Al Czervik
Bushwood Country Club 234
Effective: Saturday, February 28, 2009
Handicap Index®: 13.9
Course Handicaps at Bushwood Country Club:
@16 e

B T o1t 32 83

Effective: Saturday, February 28, 2009

Handicap Index: 8.7

Course Handicaps at Bushwood Country Club:
6]

we T 106 107 82 A 73 *A

Effective: Saturday, Febreary 28, 2009
Handicap Index®: 37.8
Course Handicap at Bushwood Country Club:

@ 43

Ty Webb
Bushwood Country Club
Effective: Saturday, February 28, 2009
Handicap Index@: 1.3
Course Handicaps at Bushwood Country Club:

@2 01

W-303

Avery 5390 - 2.25 x 3.5 Name Badge Insert Refills

* Mary Czervik
Bushwood Country Club 234L
Effective: Saturday, February 28, 2009
Handicap Index@: 40.1
Course Handicap at Bushwood Country Club:

116 *T 144
8 * 31 a3 * a7 * 21 136 143 133
&7 * 94 82 T 81 T 87 *
L 88+ 100 91 30 34 . .
e e T
* Earl Havercamp " Frieda Havercamp
Bushwood Country Club B-141 Bushwood Country Club 1600

Effective: Saturday, February 28, 2009
Handicap Index@: 15.6

Course Handicap at Bushwood Country Club:
@ 18

86 * 32 A 118 T 84 *A 91 A

a1 *A 83 A 83 A 83 *A 76 A 87 *A 115 87 *A 87 *A 93 A
TE A 86 A 82 A 76 A 73 *A 8% *AT 91 AT 86 *A 33 A 88 *A
+ 88 A 73 A 83 A a0 A 73 A ¢ s 80 A 92 A 92 A 39 A 91 *A !

e -
* Agnes Smails ‘ Judge Smails
Bushwood Country Club Bushwood Country Club 5375

Effective: Saturday, February 28, 2009
Handicap Index@: 13.5
Course Handicaps at Bushwood Country Club:

P

Handicap Cards

Choose Print from the File menu to print the handicap cards to your printer.
You may close the window after printing (and repeat the process, if you wish,
to print the reverse side of the forms).
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After printing, separate and distribute the cards:

/AI Czervik A

Bushwood Country Club 234
Effective: Saturday, February 28, 2009

Handicap Index®: 13.9

Course Handicaps at Bushwood Country Club:

@ 16 16

95 T 92 91 * 92 89 *

89 * 91 87 * 88 * 91

87 * 94 82 *T 81 *T 87 *
\_88 * 100 91 90 94

www.mulligansoftware.com

Printed Handicap Card - Front

Handicapping with: ™
Mulligan’s Eagle

www.mulligansoftware.com

N

Printed Handicap Card - Reverse
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Customizing Handicap Cards

To produce handicap cards with your own design on either the front or
reverse, create an appropriate image of the size shown in the Standard Forms
table on page 150. Because printers usually have considerably better resolu-
tion than your computer screen, the best results require an image sufficiently
sized and detailed to support 300 dpi (dots per inch). For example, to pro-
duce an image for the front or reverse of a handicap card printed on Avery
form 5390, create your artwork 1014 pixels wide x 638 pixels high. This
image is not the complete size of the form, but leaves enough room for inac-
curacies in printing.

'The image file may be of any common image data type, like JPEG or PNG
formats. It is preferable if the image does not include transparency. Name
the image file “HandicapCardFrontnnnn” or “HandicapCardReversennnn”,
where nnnn is the four-digit number identifying the form on which the
image is to appear (in the example below, “HandicapCardReverse5390”).

When composing handicap cards for printing, Eagle will look first in the
folder at ~/Documents/Eagle User Data/ (a folder in your user directory
that may or may not exist - you can create it if needed), then in the folder

at ~/Library/Application Support/Eagle/ (a folder in your user directory in
which Eagle databases are kept), looking for an appropriately named image
file. If'it fails to find an image file to use for customization, it will proceed
using it’s default design. You may therefore customize the front or reverse or
both sides of handicap cards printed on each of the available standard forms.

Bushwood Country Club
Ted Swanson — Head Golf Professional

Sandy McFiddish — Golf Course Superintendent
Lou Loomis — Caddymaster

Handicap Card customized by placing
image file HandicapCardReverse5390.jpg
in ~[Documents/Eagle User Data/ folder
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Chapter 7

Matches

Match play is hole-by-hole competition between two competitors.
Mulligan’s Eagle allows you to display match play results between any two
rounds played by individual golfers or teams. This chapter shows you how.

Mulligan’s Eagle uses the symbol at the left to represent information related

.’?\d to a match.

In this Chapter...

Opening a Match Window 156
ForaPlayer'sRound ............. ... ... ... ... ... ... 156
ForaTeamsRound ........ ... ... .. .. .. ... .. . .. .. ... 157
For Roundsona Scorecard ............ ... ... ... ... ..... 158

The Match 159
Color Scheme ... ..ot 160
MatchType .« oo 160
Handicapping ......... .. . 162
Presses ..o 162
Manual Presses. . . ..o 163
Automatic Presses . ... .o 163
Bets oo 164

Adding or Replacing a Competitor . ...................... 164
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Opening a Match Window

A match window is designed to score two rounds of golf as match play

- hole-by-hole competition until a winner is determined. The features
described in this chapter allow you to evaluate a match from round scores
already completed and recorded. 'The match window is nor designed for the
entry of scores - that is done on the scorecards of each competitor.

For a Player’s Round

To open and configure a match window from a player’s round on a scorecard,
click the Options button in the round scoring area of the scorecard to display
a menu of the options available for the player’s round:

4 Options ~ GL

80 & Editinformation about Danny Noonan...

1 ) '. Make Championship Tees on Bushwood Golf Course the Player's Preferred Course
95 | Y, Event...

5| Puts.

78 | & Competition Scores. .

Show Handicap Dots
Move Round Up
Move Round Down - Make Danny Noonan the 'B' Player
Delete Round. ..

Ignore for Handicapping
Penalty Round
Disqualified

Clear Scores

Creating a Match from a Player’s Round

Choose the Match for Player... item to open a match window with the
player installed as the ‘A’ competitor:
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Club  Bushwood Country Club Saturday, December 20, 2008
Course Bushwood Golf Course 01:00 PM
Front Nine Back Nine
1(2)|3(4|5(6|7|8|9|0ut(l0|11]12{13|14|15|16[17[18| In |Tot
Championship Tees [412[183(522|385|394] 79|401| 3364 |498|370(414(392(164 (401 (388|175|502| 3305 | 6669 F1.5M132
Par (4 |3 (5|4|4|3|5|4|4|36 |5|4|4|4|3[4]|4|3|5|36]|72
Handicap | 5 [17|1 |11]|8 [15]3 |[13|7 6 14| 2 [10]|18] 8 [12|16] 4

Handicap Allowance: 9
| Danny Noonan|[6 [3 [6 [4[5[3[5[4]5][36 |64 [4[3[5][4[5][3]5]35]71]

Vs,
I Y

| ks [ T[T TTTTT T T
_.. or drag a round here
LT T T T] [ T Tow] | [ T T T T T [mJTo]
Type Handicapping Automatic Presses Bets
() Match Play () Front & Back O Grass [] 2-down Value: §|  1.00]
() Nassau () 3 % & Holes @) Net [ Full Hdep. ] 1-down last hole Wins: §|  0.00

Match Window for a Player

Continue by adding the ‘B’ competitor as described in “Adding or Replacing
a Competitor” on page 164.

For a Team’s Round

To open and configure a match window from a scorecard containing a team
round, click the Options button in the round scoring area of the scorecard to
display a menu of the options available for the team’s round:

[145] 74 | 71 |
4 | Options ~ L
E 4 Edit Teammates...

%, Event...

4 Competition Summary... ¥ED
& Match for Czervik, Al & Mary...

und
M und
Delete Round...

Recalculate Scores

Creating a Match from a Team Round
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Opening a Match Window

Choose the Match for Team... item to open a match window with the team

installed as the ‘A’ competitor:

Club  Bushwood Country Club

Saturday, December 20, 2008

Course Bushwood Golf Course 12:00 AM
Front Nine Back Nine
1(2)|3[4(5(6|7|8|9|0ut(l0|11]12(13|14|15|16[17[18| In |Tot
Ck i hip Tees [412[183|522|385(394) 79|401| 3364 |498|370(414(392(164 [401(388|175|502| 3305 | 6669 71.5M1132
Par (4 |3 |(5|4|4|3|5|4|4|36 |5|4|4|4[3[4)|4]|3|5]|36 |72
Handicap |5 [17|1 |11]8 [15]3 13| 7 6 (142 |10]|18] 8 [12|16]| 4

| Czervik, Al&Mary|[5 [6 [7 [4[5[4[a[6]5[31 [5]5[7[5[3[5[5[4]7][27]58]

V5.

| cickoadd ([ T T T T T T T T T TTTTTITTTTT T ]
_.. or drag a round here
LI T T T T T T T Jowf [ TTTTTTT [mnro]
Type Handicapping Automatic Presses Bets
@ Match Play () Front & Back () Gross ] 2-down Value: § 1.00
() Nassau () 3 x 6 Holes @ Net [ Full Hdcp. ] 1-down last hole Wins: § 0.00

Match Window for a Team

Continue by adding the ‘B’ competitor as described in “Adding or Replacing
a Competitor” on page 164. You may add another team as a competitor, or
add a player’s round as the team’s competition.

For Rounds on a Scorecard

With a scorecard containing 1 or 2 players’ rounds front-most on your screen,
the Match... item in the New... submenu in the File menu will describe the
competitors (1 or 2) to appear in a match window. Choose the menu item or
type \3EM (OPTION-COMMAND-M):

# Eagle Edit Golf Reports Window Help

New. N
Open #0
Recent > & Player P
[mport » @ Club HC
Export #*E = Scorecard S
Close W “}, Event HE
Page Setup... {132P & Match - Danny Noonan vs. Tony D'Annunzio. ..
Print... #P

Creating a Match from a Scorecard
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A match window for the indicated competitors will be opened:

8.0.0 Match - Danny Noonan v. Tony D'Annunzio

- Club  Bushwood Country Club Saturday, December 20, 2008
{ ﬂ Course Bushwood Golf Course 01:00 PM
.

Front Nine Back Nine

1({2)3[4[5[6|7|8|9|0ut|l0)11]12]13|14|15|16[17[18| In |Tot
Ch ionship Tees (4121 78|401| 3364 [499(370(414(392(164(401|388(175|502( 3305 | 6669 | 71.5/132

Par (4 |3 |5|4(4[3|5)|4 |43 |5|4|4|4|3([4([4[3|5]|36]|72
Handicap | 5 [17[1 [11]9 |15] 3 [13]|7 6 |14 2 [10[18]| & [12[16] 4

| Danny Noonan|[6 [3 [6 [4 [5[3[5[4[5[41[6[4[4[3[5[4[5[3[5][39[80] 1
vs. - (- - I-- e EEE

[ Tany D'Annunzio|[6 [6 [5[4 [5[4]66]5[43 [5]6[5]4]5][6[7]5]5]44]87 | 0
Handicap Allowance: &

[1]2]3]a]s[6]7[8]9 ou]io]11]12]13]14]15]16[17]18] 1n [Tot]

Type Handicapping Automatic Presses Bets
@ Match Play () Front & Back () Gross ] 2-down Value: § 1.00
() Nassau () 3 x 6 Holes @ Net [ Full Hdep. ] 1-down last hole Wins: § 1.00

Match Window for 2 Players

If the scorecard contained 2 player’s rounds, the match window will be set
up with the rounds installed as the ‘A’ and ‘B’ competitors. If the scorecard
contained just one round, that round will be installed as the ‘A’ competitor,
and you can proceed to add the ‘B’ competitor as described at “Adding or
Replacing a Competitor” on page 164.

You may also use the Match... item in the New... submenu of the File menu
or type 1 (as above) when you have a single scorecard selected in Eagle’s main
window, or when you have a round selected in the Scores panel in a player
window.

The Match

When you first open a match window, it is configured for one or two players
y p g play
(the “A” competitor and the “B” competitor) competing at regular match play:

| Danny Noonan|[6 [3 [6 [4[5[3[5[4]5]41 64 [4[3[5][4[5][3]5]39]80] 1
vs. [ - | - |- - i-[-EEEEE S
[ Tany D'Annunzio|[5 [6 |4 [4 |5 [4]5 6443 [4]6 44557 5]4]44]87| 0

Handicap Allowance: 8§

Match Hole-by-Hole

'The score of the “A” competitor, an individual or a team, is shown in the
upper row of hole-by-hole scores. The score of the “B” competitor is shown
in the lower row of hole-by-hole scores. The type of scores shown, gross

or net, is determined by the handicapping setting used for the match (see
“Handicapping” on page 162).



160 The Match
|

Between the scores of the competitors are the hole-by-hole status of the
match. When the “A” competitor is leading, the number of holes the player
or team is “up” in the match at a particular hole is shown as a number with a
blue background between that hole and the next hole. When the “B” com-
petitor is leading, their advantage is shown on a red background. The status
of holes played after the match is complete are marked with a “-” character.
When the match is all square or halved, no color highlight is shown.

To the right of the hole-by-hole match results, the final match result is
shown, color-coded, as the number of holes “up” and the number of holes
left to play at the end of the match. In the illustration, the “A” competitor
has won the match “3 & 2”- 3 up with 2 holes to play. Halved matches are
marked accordingly.

Note: Match windows do not accommodate matches that extend beyond 18 holes.
A match that is tied after 18 holes is considered halved (a tie).

To the right of each competitor’s scores is a color-coded field indicating the
number of matches in this window won by the competitor. These points are
awarded as 1 point for a victory, ¥2 point for a halved match. These points are
used to compute over-all match or betting results between the competitors.

Color Scheme

'The match window uses a two-color display to identify information about
the “A” competitor - illustrated here with shades of blue, and the “B” compet-
itor illustrated here with shades of red. These colors used identify the players
and their information are configurable in Preferences (see “Scoring” on page

13).

'The buttons on which the competitors’ names are shown use the appropri-
ate color. The status of the match after a hole is designated by a number (the
number of holes the competitor is “up”) and a color (the competitor who

is “up”). Holes at which the match is halved (tied) do not have a highlight
color. 'The total match “points” to the right of the scores is color-coded, as is
the betting result shown at the bottom right of the window.

Match Type
You indicate the general type of match by selecting from the options in the

Type box at the lower left of the match window:

Type
® Match Play () Front & Back
() Nassau (0) 3 x 6 Holes

Match Type Settings
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Match Play — Regular hole-by-hole match play beginning at the first hole,

ending when a competitor leads by more holes than holes remaining:

| Danny Noonan|[6 [3 [6 [4[5[3 [5[4]5]41]6[4[4[3[5][4[5][3]5]39]80] 1
vs. [ - | - |- - i-[- EEEEE S
[ Tony D'Annunzio|[5 [6 [4 4[5 [4]5]6 443 [4[6[4]4[5][5][7]5]4]44]87 | 0

Handicap Allowance: 8

Match - Match Play

Front & Back — Two matches of nine holes, one over the front nine, and the
other over the back nine:

| Danny Noonan|[6 [3 [6 [4 [5[3[5[4[5[41[6[4[4[3[5[4[5[3[5][39[80] 1%
Front |1 [- |0 2 fa[-]- -] halved
Back i-- TR EE BEEE

[ Tony D'Annunzio|[5 [6 [4 [4[5[4[5[6[4 43 [4]6[a[4a[5]5[7[5][4[44]87] %

Handicap Allowance: &

Match - Front & Back

Nassau — Three matches, one over the entire round, one over the front nine,
and one over the back nine:

| Danny Noonan|[6 [3 [6 [4[5[3[5[4]5]41]6][4[4[3[5]4[5][3]5]39 80| 2w
15 [J[ - [0 - |- - i-T- T EEEEE S
Front |1 [- |02 fe[-]- -] [halved|
Back -- R EEE

Tany D'Annunzio|[5 [6 (4[4 [5[4]5]6 443 [4]6[4]4]5][5][7]5]4]44]87 | %

Handicap Allowance: &

Match - Nassau

Note that there is a separate line of results for each match, and that each
competitor’s points reflect the combined results of all the matches.

3 x 6 Holes —Three matches, one over holes 1 through 6, one over holes 7
through 12, and one over holes 13 through 18:

| Danny Noonan|[6 [3 [6 [4[5[3 [5[4]5]41]6[4[4[3[5][4[5][3]5]39]80] 2
1-6 - [ RE-] halved
7-12 [-]H-] o-1-] [halved|
13- 18 112 3 = = 3&2

Tany D'Annunzio|[ 5 [6 [4 4[5 [4]5]6 443 [4[6[4]4]5][5][7]5]4]44]87 ] 1

Handicap Allowance: &

Match - 3 x 6 Holes
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Handicapping

You indicate whether this match is to be contested with gross or net hole-by-
hole scores in the Handicapping box:

Handicapping
() Gross
® Net [ Full Hdep.

Match Handicap Settings

Gross — Select this option if the match is to be scored with hole-by-hole
gross scores, without handicaps.

Net — Select this option if the match is to be scored with hole-by-hole net
scores.

Full Handicap — If unchecked, net hole-by-holes scores are computed as rec-
ommended for match play - adjusted so the lower-handicapped player plays
at scratch, and the higher-handicapped player receives an allowance of the
difference between the handicaps of the players. (That difference will be dis-
played as a “Handicap Allowance” adjacent to the competitor’s total score.)
Check this box to compute net scores at each hole from each player’s full

playing handicap.

Presses

Presses are a wagering device in which a player bets at some point in a match
that if an equivalent match begins immediately, he can win that bet to get
“even” with his opponent. See the Glossary entry for “Press” on page 212.

| Danny Noonan|[6 [3 [6 [4[5[3[5]4]5]41]6[4[4[3[5]4[5][3]5]39 80| 2
vs. [ - | - - - i-T- T EEEEE S Presses

o --7- HEEE FAEEEEEEEE e -

[ Tany D'Annunzio|[5 [6 (4[4 [5[4]5]6 443 [4]6[4]4]5][5][7]5]4]44]87 ] 0

Handicap Allowance: 8

Match with Press

In the illustration above, the original match has been pressed, beginning at
the second hole. The press represents another match over the 17 remain-
ing holes, starting all square and having the same value (as a wager) as the
original match. The press is identified to the right of the match results (in
this case with a “+” character, representing a manually-added press) and it is
shown immediately below the match from which it originated.
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Manual Presses

You may indicate a press of a match at any hole by double-clicking on the
status of the previous hole. Illustrated here, to begin a press at the 16th hole,
double-click the status of the original match at the 15th hole.

Danny Noonan | [ 6 3 6[4]5 3 5 4F?HQIT 'flﬁlﬂlﬁﬂa |]3|5|39|aa| 2

OT"IICI'? 2 . 3&2 Presses
to add a press here 1)z » [za1 & -
Tony D'Annunzio|[5 [6 [4 [4 |5 [4[5]6[4[43[4[6]4]4[5][5[7 544487 ] 0

Handicap Allowance: 8§

Manually adding a Press

'The window displays the newly created match immediately below the
match that originated the press, with the first hole result at the position you
indicated.

Removing a Manual Press

To delete a manually added press, click the delete indicator shown at the
right of the press, or OPTION-DOUBLE-CLICK (hold the OPTION key down
while you DOUBLE-CLICK) any of the result fields of the press. You will not
be asked to confirm removing a press. Removing a press also removes any
press of that match, and any descendant presses.

Automatic Presses

You may specify two kinds of automatic presses that apply to all of the
matches shown in the window:

_Automatic Presses ]
] 2-down
[T 1-down last hole

Automatic Presses Settings

2-down — Check this box to calculate automatic 2-down presses. When
a competitor is 2 holes down in a match and the match has never been
pressed, another match (the press) is started automatically at the next hole.
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Automatic 2-down presses are indicated by a little “24” to the right of the
match results as illustrated:

| Danny Noonan|[6 [3 [6 [4[5[3[5[4]5]41]6][4[4[3[5]4[5][3]5]39 80| 2
vs. [ - | - - - i-T- T EEEEE S Presses

1 2 » 2&1 2}

1 1up 21

Tany D'Annunzio|[ 5 [6 (4[4 [5[4]5]6 443 [4]6[4]4]5][5][7]5]4]44]87 ] 1

Handicap Allowance: &

Automatic 2-down Press

1-down last hole — Check this box to calculate automatic 1-down presses on
the last hole of the match. When a competitor is exactly 1 down with one
hole to play in a match and the match has never been pressed, another match
is started beginning and ending at the last hole. Automatic 1-down presses
are indicated by a little “14.” to the right of the match results as illustrated:

| TyWebb [4 [3[4]a[43[a[5[4[35 [4[5]a[4[3][a]6]2][5]37]72] %
v [-H[- TEEEEE 1[-Jlal2 2 12 [t 2] [hawved presses

1 1up 11

[ Earl Havercamp|[4 [6 [3 [5[5[3 4 [5]2[37 [4[3[5[7[3[4[3[2]4]35 72| 1%

Handicap Allowance: 37

Automatic 1-down Press

Bets

In the Bets box, you may indicate any value to be assigned to match points
earned in this match window:

Bets

Value: § 1.00
Wins: § 1.00
Bets Settings

Value — Enter the value to be assigned to each match point (1 point for a
victory, ¥ point for a halved match).

Wins —This field will be computed to reflect the winner (designated by its
color code) and amount won based on the number of points earned by each
competitor and the value of those points.

Adding or Replacing a Competitor

To evaluate a match, there must be scores for a completed round in the ‘A’
competitor position (the upper scoring area), and in the ‘B’ competitor
position (the lower area). To add or replace a round in the ‘A’ or ‘B’ position,

click the appropriate colored button.
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A sheet will be displayed for you to choose a round to appear in the match
window:

Moonan v. Tony D'Annunzio
"'o! Add a Round... Q, Bushwood Country Club ] 8
) M
<3 Club | Date | Player(s) | Round
E Bushwood Country Club 1Jan 2009 Earl & Frieda Havercamp g Havercamp, Earl & Frieda |4
e
F Bushwood Country Club 1Jan 2009 Judge & Spaulding Smails g Smails, Judge & Spaulding
Ch E Bushwood Country Club 1Jan 2009 Tony D'Annunzic & Da... a Caddies (Noonan & m kR

» = Bushwoed Country Club 20 Dec 2008 Doctor Beeper & Al Cze._.
> E Bushwood Country Club 20 Dec 2008 Earl Havercamp & Ty Webb
¥ 5 Bushwood Country Club 20 Dec 2008 Judge & Spaulding Smails
:l 4 Judge Smails 1

4 Smails, Spaulding & Judge || g

| » P Bushwood Country Club 20 Dec 2008 Mary Czervik & Frieda ... b
Cancel ) f Add 3
ype
| AF
(*) Match Play () Front & Back () Gross 1 2-down Value: §/ 1.00

Adding or Replacing a Competitor

'The sheet displays a view of recent rounds at the same club as the oppo-
nent’s round was played. This filtering is the result of the insertion of that
club name in the search field at the top right of the sheet. You can change
or remove that search text to look for all recent rounds at any club, or rounds
played at another club.

Note: If you choose a different club than that played by the opponent, the match
results may be strange. You are evaluating a match played between competitors on
different courses. If you choose a round played at another club, or from different
nines at the same club, you'll probably want to choose another round played on the
same course for the opponent.

'The recent rounds are grouped by scorecard, and if more than one round is
available on a scorecard, the row can be expanded by clicking the little dis-
closure triangle (as in the illustration) to show all of those rounds. Rounds
whose player or team names are dim and unavailable have not been com-
pleted, or don’t have hole-by-hole scores. Rounds whose names are displayed
with the match window color scheme (by default, blue and red) represent the
rounds already in the window in the ‘A’ or ‘B’ position.

Choose a round by clicking its row to select it. In the example, the round for
Spaulding has been selected to be installed as the ‘B’ competitor in the match
window. The color swatch between the Cancel and Add buttons indicates
where the added round will appear.
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The Match

Click the Add button to install the selected round and return to the match
window:

800 Match - Danny Noonan v. Spaulding Smails
- Club  Bushwood Country Club Saturday, December 20, 2008
ﬂ Course Bushwood Golf Course 01:00 PM
- Front Nine Back Nine
123456789 |0ut(l0)11]12{13|14|15|16(17[18) In |Tot
CF i “‘i,’_‘ Tees (4121 79|401| 3364 |498|370(414(392(164 [401(388|175|502| 3305 | 6669 71.5M1132
Par |4 |3 [5|4|4|3|5(4|4|36|5(|4|4([4|3|4[4|3|5]|36]|72
Handicap [ 5 [17] 1 [11[ 9 [15] 3 13| 7 6 (14| 2 |[10[18| 6 [12]|16] 4
Danny Noonan|[6 [3 [6 [4 [5[3[5[4[5[41[6[4[4[3[5[4[5[3[5][39[80] 2
12 [ (33 4 s 6 S e s 4 4 /45|45 s 5&3
Front 1 2 3 4 5 =« = & & 5&4
Back IR -1 - DaE
Spaulding Smails|[7 [7 [7 [5 [,7 [5 |4 [5]3|50 (4[4 |4]5[3]6[4]3[3]36]86] 1

Handicap Allowance: 30
[1]2T3]4]s[6]7[8]9ou]io]11]12]13[14]15]16]17]18] In [Tot]

Type Handicapping Automatic Presses Bets
(O) Match Play () Front & Back O Gross ] 2-down Value: § 1.00
() Nassau () 3 % & Holes ) Net [] Full Hdep. ] 1-down last haole Wins: § 1.00
Competitor Round Added

'The match window now displays the results of the newly configured match.
You can change the Type, Handicapping, Automatic Presses and Bets for
this window as you require.

You may also install a player’s round or a team round into the ‘A’ or ‘B’ posi-
tion in a match window by dragging that round from a scorecard (drag the
player’s or team’s name) and dropping it in the match window:

8,.0,0 Match - Danny Noonan v.
- Club  Bushwood Country Club Saturday, December 20, 2008
'\\5 Course Bushwood Golf Course 01:00 PM
) Front Nine Back Nine
1(2|3|4(5([6|7|8[9|0ut|10)11(12({13]14[15(16({17|18( In |Tot
Cl i hip Tees [412|183|5 791401| 3364 (499|370(414)392|164|401(38B|175(502| 3305 | 6663 71.51132
Par (4 |3 (5|4|4|3|5|4|4|36 |5(|4|4|4[3[4]|4|3|5|36]|72
Handicap | 5 [17|1 |11]|8 [15]3 [13|7 6 [14]2 [10|18] 8 [12|16] 4

Handicap Allowance: 9
| Danny Noonan|[6 [3 [6 [4[5[3[5[4]5]36 |64 [4[3[5][4[5][3]5]35]71]

V5.

| cickoadd [ T T [T T[T TTT TTTTTTTTTT T 7
Y yony D'Annunzio ... or drag a round here
ST T T T T T T T Jow[ TTTTTT T [inror]
Type Handicapping Automatic Presses Bets
@ Match Play () Front & Back O Gross ] 2-down Value: $’W
() Nassau () 3 % & Holes ) Net [] Full Hdep. ] 1-down last haole Wins: $W

Dragging to Add a Round

When you drag the round into the match window, the scoring area for the
‘A competitor or ‘B’ competitor is highlighted with a rectangle. Release your
mouse inside the highlight to install the round.
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)
- Club  Bushwood Country Club Saturday, December 20, 2008
{ ﬂ Course  Bushwood Golf Course 01:00 PM
) Front Nine Back Nine
112|314 ([5[(6|7|8|9|0ut|10(11]12]13]14(15[16[17|1&| In | Tot
Championship Tees [412[183[522[385[384 79401(3364 [4s[370[414]392|164[401[388[175[502[ 3505 [6668|  71.51132
Par (4|3 |5|4|(4[3|5|4|4|36|5|4|4|4|3[4([4[3|5]|36]|72
Handicap | 5 [17[1 [11]9 |15] 3 |[13|7 6 |14| 2 [10[18]| & [12[16] 4
| Danny Noonan|[6 [3 [6 [4[5[3[5[4]5]41 64 [4[3[5][4[5][3]5] 39 80| 1
vs. - | R E- -l -] i-- TR EE BEEE
[ Tany D'Annunzio| [ 6 [6 5[4 [5[4[6[6]5[43 [5]6[5[4[5]6[7[5][5]44]87| 0
Handicap Allowance: &
[1]2T3]4]s]6]7[8]9 ou]io]11]12]13]14]15]16]17]18] In [Tot]
Type Handicapping Automatic Presses Bets
() Match Play () Front & Back O Grass [] 2-down Value: § 1.00
() Nassau () 3 % & Holes @) Net [ Full Hdep. ] 1-down last hole Wins: § 1.00

Competitor Round Added

As before, the match window is automatically updated to reflect the results
of the match. You can continue to re-use a match window, or open other
windows for other matches.

When you are finished with a match window, close it by clicking its close
button, choosing Close from the File menu or typing $W (COMMAND-W).
No data is saved or stored from match windows. If you need to re-create
the results of a match, you can do so easily by choosing Match options on a
scorecard or in the New menu or dragging rounds to a newly opened match
window.
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Chapter 8

Remote Scoring

Mulligan’s Eagle provides facilities (in versions 2.4 and later of the software)
to accommodate remote scoring — the entry of golf scores on remote devices
that can be returned for permanent storage and analysis to Eagle running on
a Mac desktop or portable computer.

In this Chapter...

Configuring Eagle for Remote Scoring 170
Dropbox. ... ..o 170
iCloud ..ot 171

Remote Devices and Applications 171
IPress o v e 171
The Scoring Machine. . .........oooiiiiiiiiiii ... 172

Data Synchronization 172
Session Lists. . ..o vttt 172
Scoring Files ....... ... . .. 173

Remote Scoring with Eagle 174
Producing a Session List .. ......... ... i i 174

Importing Scoring Files. . . ...... . ... ... L. 175
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'The remote scoring features of Mulligan’s Eagle and the software operating
on remote devices require an active shared Dropbox or iCloud account. That
is, the remote devices receiving data from Eagle or sending data to Eagle and
the computer running Eagle must use a shared Dropbox or iCloud account.

Configuring Eagle for Remote Scoring

Visit the Remote panel of Eagle’s Preferences window (see “Remote” on page
20) to set Eagle up for remote scoring.

Preferences

P B/ & o

Authorization Scorecards Scoring Appearance Other Handicapping Advanced Remote

:: Use Dropbox Unlink Dropbox

Check for scores at startup Check for Scores Now
Scores can be imported or updated from scoring data files synchronized to the

“Dropbox/Apps/Mulligan Scoring” folder on this computer. Choose "Scores from
Dropbox..." in the File / Import menu to review incoming scores.

‘ use iCloud
Check for scores at startup Check for Scores Now

Scores can be imported or updated from scoring data files sent to iCloud by remote
devices logged in using the same Apple ID used for iCloud on this computer. Choaose
“Scores from iCloud.." in the File/Import menu to review incoming scores.

Factory Settings “

Preferences - Remote

'There, you may specify that you want to use Dropbox, iCloud, or both ser-
vices to synchronize information.

Note: iCloud file synchronization is available only in copies of Eagle purchased
from Apples Mac App Store. 1f iCloud is not available to you, Dropbox provides
equivalent capabilities.

Dropbox

To use Dropbox, you must have an active Dropbox account, and Dropbox
must be installed on your Mac. If you need a Dropbox account, visit
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https://www.dropbox.com to sign up for one and to download and install
the Dropbox software on your Mac.

In the Remote panel of Preferences, check the Use Dropbox checkbox and
click the Link button to authorize Eagle’s use of Dropbox on your Mac.
Eagle will link to a special Mulligan Scoring folder inside the Apps folder
inside your Dropbox folder. Eagle will not have access to any other part of
your Dropbox. Eagle and software on remote devices will place files into
this special folder and remove them as necessary. You may add or delete files
yourself, but it’s highly recommended that you don’t modify any files you find
there.

iCloud

To use iCloud for synchronizing data with remote devices, your iCloud

v account must be active on your Mac (visit the iCloud System Preferences

| and make sure you have provided an appropriate ApplelD and password to
activate iCloud). For direct access to Mulligan Scoring data files, iCloud
Drive must be enabled.

In the Remote panel of Eagle’s Preferences, check the Use iCloud checkbox
to enable Eagle’s use of iCloud’s data services. Eagle will use (and create if
necessary) a special directory within iCloud called “MulliganScoring” where
it may publish (export) or use (import) data to support remote scoring. You
may view or delete files from the MulliganScoring directory by accessing
iCloud Drive from the Finder on your Mac.

Remote Devices and Applications

Any remote devices running applications that are compatible with Eagle’s
remote scoring features must use either the active Dropbox or iCloud
account used on your Mac.

Mulligan Software has two applications for iOS available on the App Store
that can use or produce scoring data.

iPress

iPress for the iPad is an iOS application that supports match play wager-
ing - the entry of individual player hole-by-hole scores and the calculation of
various forms of bets from those scores.

iPress supports either Dropbox or iCloud using the same account configured
for use with Eagle. iPress exports Scoring Files for completed golf rounds
recorded on the iPad. It does not import data from Eagle or other sources,
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Data Synchronization

although it can retrieve club information from Mulligan Software’s golf club
archives.

See iPress settings on the iPad to configure it for remote scoring.

The Scoring Machine
'The Scoring Machine for the iPhone, iPod touch and iPad is an iOS appli-

cation that performs golf scoring for individuals, scorecard competitors or
whole groups of golfers. It provides support for all the types of scoring, team
and individual play used by Eagle.

'The Scoring Machine supports either Dropbox or iCloud using the same
account used by Eagle. It can import Session Lists produced by Eagle to
completely configure Events, Scorecards, Competitors and even the course
to be ready to accumulate scores for an Event that originated from Eagle.
It can export (publish) partial or complete scoring results using Dropbox
or iCloud back to Eagle and to other mobile devices running The Scoring

Machine.

Like iPress, The Scoring Machine can retrieve club information from
Mulligan Software’s golf club archives.

See The Scoring Machine’s settings on the iPhone, iPad or iPod touch to
configure it for remote scoring.

Data Synchronization

'The data exchanged between Eagle and remote devices running compatible
applications is contained in simple text-based, XM L-structured data files
with a date-descriptive name and a . EAGS'’ file name extension. These files
contain golf-related infomation that you can easily examine with a text or

XML file-reading application from within your Dropbox or iCloud storage.

Eagle and the related remote devices don’t attempt to prevent conflicting use
of shared files. Session Lists and Scoring Files (published scores grouped by
Scorecard) are assumed to be one-way documents - produced on one device
and used on another. Eagle is expected to remain the long-term repository
of the data because it is most likely to have large storage capabilities and
includes features for statistical analysis of the data. Because of storage con-
siderations, the applications running on remote devices will generally limit
the length of time and the amount of data they can retain.

Session Lists

A Session List is a configuration document specifying the particulars of an
Event. Typically produced by Eagle (although The Scoring Machine can

also produce Session Lists), it is used to “prime” remote devices so they are
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ready to record scores to later be returned to Eagle or shared with other
devices.

Generally, if a Session List identifies a golf course or player that the remote
device does not have on file, the remote application will install that data on
the device. 'The ability to enter scores for Scorecards built from a Session List
should usually be prohibited (locked) until the user of the device asks to do
so. In alarge event with multiple remote devices, this protection ensures that
mobile users enter scores only for the players for whom they’re responsible.

Scoring Files

A Scoring File is a consumable file that contains partial or complete scor-
ing information from a Scorecard on a remote device (although Eagle can
export a similar file). Generally, Eagle consumes (uses, then deletes) Scoring
Files. Remote devices produce Scoring Files and may use them to update
local data, but they don't delete them. (Deleting a file from a Dropbox or an
iCloud Drive directory, whether with an application or by dragging it to the
trash, means that the file is deleted everywhere, for all devices sharing the
account.)
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Remote Scoring with Eagle

Eagle can produce Session Lists for use in remote scoring and it can receive
Scoring Files containing scoring data from remote devices to incorporate
into its permanent storage.

Producing a Session List

After you have configured an Event in Eagle, including adding all of the
contestants to their Scorecards, finalizing the format, tees, scoring, pairings,
tee times, etc. you can publish a Session List from the open Event window.
Choose Publish Session List... from the Reports menu.

event - Chnstmas bBest-Ball

- |
Results Fast Scoring

Session List

Jebb, Ty & Havercan :z Publish to Dropbox L
‘ Publish event scering information to the DropboxfApps/ [
EEEEE Mulligan Scoring folder for use by remote scoring
applications using the same Dropbox 1D.

lavercamp, Frieda & - -
Publish to iCloud

o
EEEEE Publish event scoring information to the Mulligan Scoring
folder in iCloud Drive for use by remote scoring

applications using iCloud with the same Apple ID.
‘eeper, Doctor & Cze

“addies - Noonan & D'Annunzio I = "4 T & |options -

N N N ¢

Publishing a Session List

Select the appropriate method to publish the Session List. Eagle will pre-
pare the Session List and deposit it in the Dropbox or iCloud directory
where it can be retrieved by interested (and authorized) remote devices.
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Importing Scoring Files

When the Event is complete, the Dropbox or iCloud directory should con-
tain Scoring Files ready for use by Eagle. From the File / Import menu

[ Eagle WZICW Edit Golf Reports Window Help
New... >

Recent >

)

& Mulligan’s Eagle™ Club Files...

9 Mulligan Software Club Archives...

Close EW

= Scores from Mulligan Scoring Data Files...
232 Scores from Dropbox...
® Scores from iCloud...

Print... #P

Import Menu - Scores

choose Scores from Dropbox... (or Scores from iCloud...) to review the
available scoring data:

[ NON ) Import Scoring Data
:‘: Dropbox mutigan's Eagle” /A
Unlink | Check for scores at startup

oldest first () Competitor(s) @
Scoring Data Files Mod. @ Ty Webb oK s
2016-01-10-Bushw-NewYearFou... 4 Jun 2017 @ Lacy Underall OK S
2016-01-10-Bushw-KennethReb... 4 Jun 2017
2016-01-10-Bushw-NoonanBee... 4 Jun 2017
2016-01-10-Bushw-WebbUnder... 4 Jun 2017
2016-01-10-Bushw-KennethReb... 4 Jun 2017
2016-01-10-Bushw-NoonanBee... 4 Jun 2017
2016-01-10-Bushw-WebbUnder... 4 Jun 2017 & Course -
2016-01-10-Bushw-KennethReb... 4 Jun 2017
2016-01-10-Bushw-NoonanBee... 4Jun2017 @ Bushwood Country Club OK s
2016-01-10-Bushw-WebbUnder... 4 Jun 2017
2016-01-10-Bushw-KennethReb... 4 Jun 2017 £ Scores L
2016-01-10-Bushw-NoonanBee... 4 Jun 2017 @ Ty Webb e 73
2016-01-10-Bushw-WebbUnder... 4 Jun 2017 @ Lacy Underall @ 98
2017-06-27-Bushw-BishopCzer... 27 Jun 2017
2017-01-10-Bushw-NoonanCzer... 10 Oct 2017
2016-01-10-Bushw-KennethReb... 13 Oct 2017
2016-01-10-Bushw-NoonanBee... 13 Oct 2017
2016-01-10-Bushw-KennethReb... 16 Oct 2017
— || & | Loaded file "2016-01-10-Bushw-WebbUnderall- Cancel Import

FD147D34.EAGS"

Importing Scores from Dropbox

If dropbox is active and linked, available Scoring Files are listed at the left for
review. Click to select a file and the competitors, the course and the scores
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included in the data will be summarized to the right. Information about

the Players and the Course that can be identified as valid for merging into
Eagle’s data is identified with a green @ dot to the left of the item. Data that
requires intervention is identified with a red @ dot. The popup menu at the
right of such items provides options for you to select an alternate Player or
Course, to update the information for an existing Player or Club, to ignore
and skip some incoming data, etc.

Once any issues are resolved, click the Import button at the lower right to
install the data from this Scoring File and delete the file. If you want to
delete a Scoring File without using it, select it in the list and click the delete
(-) button at the lower left.

You may request that Eagle review incoming Scoring Files automatically
whenever it starts up by checking the Check for scores at startup check-
box. When done automatically, Eagle will process and delete any Scoring
Files without errors, but keep those files that require your review.

Note: Mulligan’s Eagle consumes Scoring Files — merging the contents of a

[file into its database, then deleting the file. Deletion of the Scoring file from the
Dropbox or iCloud storage where it was stored makes it inaccessible to all the com-
puters and devices using that storage. If new scoring results subsequently arrive

from a remote device, another Scoring File can be produced that may later require
importing.
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Chapter 9

Shortcuts

'There are lots of shortcuts available to help you use Mulligan's Eagle quickly
and efficiently. Of course, as a Mac application, the ways you interact with
your computer are familiar and many of the shortcuts are identical to other
programs. This chapter identifies some of the shortcuts that can make using
Eagle even easier.

In this Chapter...

Keyboard Commands 178
Scoring Shorthand 180
Activities 181

Special Startup Actions 182
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Keyboard Commands

Keyboard Commands

Most of the menu commands available in Mulligan’s Eagle can be initiated
from the keyboard. The following is a list of the available keyboard com-
mands and their respective actions:

Keys Action

FHA Select All

A Deselect All

G FHA Add a Player...

#C Copy (to clipboard)
X#EC New Club

#D Competition Summary
#E Export

\¥E New Event

#G Golf Calculator...

HG Show [ Hide Guests

¥#H Hide Eagle

{¢FEH Calculate Handicaps...
\¥EH Hide Others

S Ignore for Handicapping
N Junior Par...

¢HK Show [ Hide Skins

#L Lookup Handicap...

N FHL Lock List

¥$M Minimize

X#EM Match...

N New...

S #EN Show [ Hide Scorecard Notes
#0 Open

¥$P Print

P New Player

#¥Q Quit Eagle

S HER (set / reset) Adjust for Tee Rating
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Keys Action

S (make) Scorecard for Selected Players
oS (make) Scorecards for Selected Players
¥ES New Scorecard

oBT (set / reset) Tournament Scorecard
HT Special Characters...

¥U Eagle Users’ Guide (open)

HU Eagle Users’ Guide (reset, download)
#BV Paste (from clipboard)

FEW Close

X Cut (to clipboard)

4 Undo

SHZ Redo

38, Preferences...

#£? Eagle Help...

& (delete) Delete

B < (left arrow) Previous

3> (right arrow) Next

home Scroll to top

page up Scroll up one page

page down Scroll down one page

end Scroll to bottom

Where the key symbols represent:

Key Meaning
FS COMMAND
O SHIFT

AW OPTION

N CONTROL




180

Scoring Shorthand

Scoring Shorthand

Wohen entering scores or putts, you may enter scoring shorthand characters
prior to the number representing the score or putts. These pre-entry charac-
ters can be used to set certain status attributes for the hole.

'These keyboard characters are configurable in Mulligan's Eagle Preferences
(see "Scoring" on page 13). What is shown in the following table are the

factory settings for the shorthand keys.

Key  Meaning < (SHIFT) X (OPTION)
C Clear all Same Same
F Fairway Reset Reset
G Green in Regulation Reset Reset
M Handicap Maximum Remove 'X' | Remove 'X'
P Penalty Stroke (+1) -1 Zero
S Greenside Bunker (sand) Reset Reset
U Up-and-Down Reset Reset
X Unfinished hole Reset Reset

Clear all — erase the score and putts for the hole, and reset Fairway, Green
in Regulation, Greenside Bunker, Penalty Strokes, Up-and-Down, and X'

status.

Fairway — set indicates the first shot from the tee on a par 4 or par 5 hole

came to rest in that hole's fairway.

Green in Regulation — set indicates (when it can't be determined from score
and putts) that the player reached the green in par less 2 strokes or fewer.

Handicap Maximum — set indicates an unfinished hole ('X') and inserts the
maximum value recordable for the hole for handicapping purposes (ESC
stroke limit in the United States). With sHIFT or oPTION key, leaves the
existing score, but removes the X' status for the hole.

Penalty Stroke — for each 'P' keystroke, add one penalty stroke. With sHIFT
key down, subtract one penalty stroke. With opTI0N key down, set penalty

strokes to zero.

Greenside Bunker — set indicates ball in a greenside bunker with the oppor-
tunity to make par (ie: a "sand try," which if successtul results in a "sand

"
save ).

Up-and-Down — player's final two shots were "up-and-down," a determina-
tion made by the player, not the software, for statistical purposes.
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X — set indicates an incomplete hole, estimated score or a score not played
under the Rules of Golf. X' scores disqualify a player for that hole in

Stableford, four-ball and similar team competition, match play or skins.

Activities

Many features of the software have multiple ways to get things accom-
plished. Here are some shortcuts for performing key activities quickly:

Activity

Shortcut

Open a window to edit infor-
mation about a club.

In the main window club list, double-
click the club's name, or with the club
selected, type &0.

Open a window to edit or
review information about a
player.

In the main window player list, double-
click the player's name, or with the
player selected, type 0.

Open a window to edit or
review information on a
scorecard.

In the main window scorecard list,
double-click the scorecard's descrip-
tion, or with the scorecard selected,
type #£0.

Open a window to edit or
review information about an
event.

In the main window event list,
double-click the event's name, or with
the event selected, type #0.

Open a new scorecard for
a player at their preferred
course.

In the main window player list, OPTION-
double-click the player's name, or
with the player selected, type S or
CcLICK the Add Scorecard button in the
main window.

Open new scorecards for
multiple players.

In the main window player list, select
the players, then type #S or click the
Add Scorecard button in the main win-
dow to put them all on one scorecard,
or type +3S or OPTION-CLICK the Add
Scorecard button to put each on a
separate scorecard.

Add a player to an existing
scorecard.

Drag the player from the main win-
dow player list to the open scorecard
window.

Add an already-constructed
player's scorecard to an
event.

Drag the player's round (their name)
from the scorecard into the Results
panel of the open event window.




182

Special Startup Actions

Activity

Shortcut

Install a competitor's round
as the 'A' or 'B' side ina
match window.

Drag the competitor's name from their
scorecard entry into the 'A' or 'B' posi-
tion in the Match window.

Open the Competition
Scoring sheet for a player's
round on a scorecard.

OPTION-CLICK the Putts button.

Open a Competition
Summary sheet on a
scorecard.

SHIFT-OPTION-click any Putts button
on the scorecard, or type 3D.

Hide (or show) the "guest"
players in lists of players.

Type L#G (OPTION-COMMAND-G).

Extend the trial period
when using the software in
demonstration mode.

Hold down the C (OPTION) key while
clicking the Continue (or Quit) but-
ton in the demonstration mode startup
dialog.

This option is only available twice.

Activity

Special Startup Actions

You may perform special activities while starting up the application:

Action

Change Eagle's default Data
Store.

Hold down the C (OPTION) and

¥ (COMMAND) keys when starting the
application. (See "Changing the Data
Store" on page 188)

Completely reset the Eagle
application's settings and
preferences.

Hold down the & (SHIFT),

” (CONTROL), X (OPTION), and

3 (COMMAND) keys when start-

ing the application. (See "Resetting
Application Preferences" on page
188)
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Chapter 10

Help & Troubleshooting

'There are lots of features in Mulligan’s Eagle, and lots of ways to play golf
and keep track of scores. If you're having difficulty with something, check
the index of this Users’ Guide for help. In this chapter, we discuss some
commonly encountered questions and problems and how to solve them, and
some not-so-commonly encountered questions too.

In this Chapter...
Selecting Things. .. ... i i i i 184
The Help Menu 184
Mulligan’s Eagle Users’Guide . ..................ooooa... 185
Checking for Updates . ..., 186
Mac App Store. . .o vttt 187
Data Protection & Storage 187
Locking Lists. ... ..ottt 187
Changing the Data Store. . ............... .. ... ... ... 188
Resetting Application Preferences..................... ... 188
Clubs 189
Entering Yardages, Pars and Hole Handicaps . .............. 189
Same Gender, but Difterent Pars or Hole Handicaps ......... 189
9-Hole Ratings ......... ... ... . i, 190
Duplication . ....... ... 191
Tees . oo 191
Players 191
Calculating Handicaps. .. ... 191
Repairing Links . .. ... o o i 194
Assigning Rounds to Another Player. ..................... 195
Printing 196
Printing Margins . ....... ... ... . o i i 196
Scoring 196
9-HoleRounds ......... ... ... . . i i 196
Entering Hole-by-Hole Scores and Putts . ................. 196
Scoring Shorthand Keys ............ ... ... ... .. ... 197
Special Requirements 198
Reference Tees . ... ..o 198
Different Par from Different Tees . .......... ... ... .. ... 199

Different Handicap Strokes from Different Tees. . ........... 199
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The Help Menu

Mac Conventions

Selecting Things

You know how to select or highlight something by clicking on it. There are
many times while using Mulligan’s Eagle that you need to select multiple
items (rounds, players, scorecards, files, etc.), so it’s worth reviewing how to
select multiple items from a group or list:

To select a single item, click it.

To select a group of items that are next to each other, click one; then
hold down the SHIFT key (<) and repeatedly click other items to include
them in the selection. When selecting from a list, all the items between
the two selections are also selected.

To select a group of items in a list that are 7o next to one another, hold
down the COMMAND key (88) and click the items you want.

To deselect one item from a group of selected items, hold down the
COMMAND key (38) and click it.

To select all of the items in a list, click somewhere in the list and choose
Select All from the Edit menu or type $A (COMMAND-A). To deselect
all the items in a list, hold down the opTION key and choose Deselect
All from the Edit menu or type \_38A (OPTION-COMMAND-A).

Note: These selection techniques aren’t unique to Mulligan’s Eagle. All good Mac
applications and the Finder follow these conventions.

The Help Menu

You can get assistance from the Help menu:

s\ Help

Eagle Help
Read Me
Eagle Users' Guide

Check for Update

Help Menu

Search —Type a word or phrase to search the Mac help system for assistance
on that topic. You'll see a list of help topics to choose from.
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Eagle Help — Choose this item to show the online help information for
Mulligan’s Eagle, which starts with an introductory window:

eCe Eagle Help
th Q fearch

Index

/ Eagle Help

Eagle overview QUICK ANSWERS

Learn what you can do with Eagle. Frequently asked questions

Creating and using clubs Getting the most out of Eagle
Learn how to create, use, and share information

Troubleshooting
about golf clubs.

Solving problems
Creating and using players
Learn about creating players, and how they're

used in Eagle. Index

) ) www.mulli frware.
Creating and using scorecards mieansgTsre.com

Learn about scorecards and how they're used
for scoring.

Creating and using events
Learn about creating events and managing a
competition.

Eagle Help

Click on a link to navigate to the appropriate page of information, or type a
word or phrase in the search field at the upper right to find help about a par-

ticular topic.

Read Me — Choose this item to read the “Read Me” file that accompanied
the software when it was installed or updated. The file will open in your
preferred text editing application. The Read Me file includes last-minute
information about the software as it was released.

Mulligan’s Eagle Users” Guide

Eagle Users’ Guide — Choose this item or type $U (COMMAND-U). to open
the Mulligan’s Eagle Users’ Guide if it’s installed on your computer. The
Users’ Guide will be opened with Adobe’s Acrobat Reader or whatever appli-
cation you have designated for reading .pdf files. If the file can't be found
or if you type .U (OPTION-COMMAND-U), you'll have the opportunity

| to locate it on your disk drive or download a current copy from Mulligan
Software’s web site:
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[ X Mulligan’s Eagle Users’ Guide

Users' Guide found
~/[Library/Application Support/Eagle

Download the most recent version of the Users' Guide from
Mulligan Software's web site

Locate a copy of the Users’ Guide that is already on
your computer

(in English)

Don't ask me about this again. Cancel m

Users’ Guide Download

Eagle will install the Users’ Guide in the /Library/Application Support/
Eagle/ folder in your home (personal) directory, which may be located in dif-
ferent places depending on which version of the Mac system software you're
using.

Checking for Updates

Check For Update — Choose this item to query the Mulligan Software
web site to determine if your copy of the software is up-to-date. You must
have an active connection to the internet to make this check. No informa-
tion about you or your system is transmitted during the connection. If your
software is current, you'll see a dialog like:

You are running version 3.0 of
Mulligan’s Eagle™, which is the
most current version available.

Please check again later.

Check for Update
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If an update (free) or an upgrade (for a charge) is available, you'll have the
opportunity to download and install it.

Note — If you purchased your copy of Mulligans Eagle from the Mac App Store,
the Check for Update item does not appear in the Help menu. When updates
are available, you'll be notified automatically about them in the App Store
software on your Mac.

Mac App Store

If you purchased Mulligan’s Eagle from Apple’s Mac App Store, all of the
authorization for use and updates of your software is handled by the App
Store software on your Mac. If you overwrite your software with a copy
from anywhere else - a demo version, an update intended for other users, or
any other source, you will damage your copy of the software and it may become
unusable.

If you are using a demonstration copy of Mulligan’s Eagle on your computer
obtained from Mulligan Software or elsewhere, you may safely purchase and
install an authorized version of Eagle from the Mac App Store, which will
replace the installed demo copy and preserve any data you may have previ-
ously entered.

Installing Mulligan’s Eagle from the Mac App Store will install (or move, if
it already exists) all of the data required by the application into its “sandbox,’
protected from access or damage by other applications.

4

Data Protection & Storage

Locking Lists

If you ever need to turn your computer over to someone who may not have a
tull appreciation of the value of the data you've accumulated, you may wish to
protect the data somewhat by prohibiting the addition or deletion of clubs,
players, scorecards or events. You need to lock a list.

You can lock a list by displaying the list in Eagle’s main window, then choos-
ing Lock List from the Golf menu or typing 3L (OPTION-COMMAND-L).
'The list will be locked and identified as locked by a small lock icon in Eagle’s

main window.

To unlock a list, display the list in Eagle’s main window, then choose Unlock
List from the Golf menu or type XL (OPTION-COMMAND-L).

You may also lock any or all of the lists from the Authorization panel of the
Preferences window (see page 10).
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Changing the Data Store

Mulligan’s Eagle keeps data about players, their scorecards and events in a
database. By default, the database is called “Data.EAGD” and is stored in your
user directory at ~/Library/Application Support/Eagle/. You may wish to
create a new data store or re-use a different one.

To change the data store, quit Mulligan’s Eagle if it’s running. Restart the
application, holding down both the \C (OPTION) and $ (COMMAND) keys
until you see the dialog:

S RN
Data Store Selection

Available Data Store Files

New Data Store Name:

(" Make a New Data Store )

Data Store Selection

All of the available databases are shown - with the current database selected.
To use an existing database, select it, and click the Select button. To con-
tinue starting up without changing the database, click Cancel.

To create a new, empty database (without players, scorecards or events), type
a name in the available text field (with or without the .EAGD extension),
then click the Make a New Data Store button.

Note: Eagle only uses one data store at a time, and the data in the two stores can-
not be combined. "The database in which Eagle maintains club information is a
separate store located in the same user directory and cannot be changed.

Resetting Application Preferences

At some times when application preferences may become corrupted or
obsolete and must be reset, you can do so by holding down the {* (SHIFT),

~ (CONTROL), \C (OPTION), and 3 (COMMAND) keys simultaneously while
starting the application. This will reset a// of the application’s settings, which
also includes all the options available in Eagle Preferences. You should
rarely, if ever, need this capability and would normally perform this reset only
upon direction of Mulligan Software customer support.

Application preferences are kept in a file in your user directory at ~/Library/
Preferences/com.mulligansoftware.Eagle.plist. You should not modify
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this file directly in any way. You may move the file to the trash if you are
uninstalling the software.

Clubs

Entering Yardages, Pars and Hole Handicaps

When you are entering club data, particularly yardages, pars and hole handi-
caps for a course, it may seem like Eagle is helping. It is, and here’s how:

While you're entering a hole length and the number you've entered is
between 70 and 999, the software automatically “tabs” to the next hole as
if you had hit the TAB or RETURN key. This “automatic tabbing” means you
can type all the yardages continuously, without ever typing a TAB, ENTER or
RETURN key.

When entering pars, the TAB is automatic when you've entered a valid par of
3,4 or 5. You must confirm pars of 6 or above by typing the TAB key. When
entering hole handicaps, automatic tabbing occurs after any numeric value
except the first “1”you type. To enter the “1” for the first handicap hole, you
must type the TAB key yourself because the software can't tell that you aren’t
about to finish typing “10” or “18.”

When entering pars and hole handicaps, Eagle will also fill the same infor-
mation into the pars and hole handicaps for other tees if they haven't
previously been entered for those tees. For example, if you enter a women’s
par of 4 for the Red Tees and there is no par entered yet for the White and
Blue Tees for women, Eagle will insert a 4 as par for that same hole on those
other tees. Generally this means that you need to enter pars and hole handi-
caps only once for each gender. Of course, you still need to enter yardages
for each tee, because those values almost always difter between tees.

Same Gender, but Different Pars or Hole Handicaps

As described above, when you enter a hole’s par or handicap for men or
women from a particular tee, Eagle will, for speed and convenience. fill

that hole for that gender on any other tees that don't contain data. If you're
changing the par or handicap from a previously entered value (for example,
from 4 to 5), Eagle will also change the values for the other tees if they con-
tain the same previous value (4). Thus changing a par or handicap from one
tee usually changes the hole on all the other tees used by the same gender.

But, to change the par or hole handicap on just one of the tees (for example,
the seniors tee) without altering the hole from the other tees, first remove
(blank) the old par or hole handicap, then enter the unique value for that tee.
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Clubs

9-Hole Ratings

When you need a 9-hole Course Rating or 9-hole Slope Rating for the tees
on a golf course, they can be difficult to find. When a golf course is rated
for difficulty, the ratings are calculated for the tees on each nine, then com-
bined to make 18-hole ratings. Generally, the Course Rating for a tee on an
18-hole course is the sum of the 9-hole Course Ratings from that tee, and
the Slope Rating for a tee on an 18-hole course is the average of the 9-hole
Slope Ratings from that tee. The golf professional or handicap chairman at
the club might be a good source for the original rating documentation.

The USGA maintains a course rating database for golf courses in the United
States with you can find at http://ncrdb.usga.org/NCRDB/ on the internet.
That database includes 9-hole ratings for most courses.

If you can’t find the 9-hole ratings, you may be able to compute or estimate
them. Noting that an 18-hole Course Rating is the sum of its 9-hole
components, you can estimate the 9-hole ratings to be close to half of the
18-hole value. Course Ratings are usually calculated to a tenth of a stroke
(unless you use a Standard Scratch Score, which is a whole number), so you
should estimate the 9-hole ratings similarly. Noting that an 18-hole Slope
Rating is the average of its 9-hole components, you can estimate the 9-hole
ratings to be about equal to the 18-hole value. Lacking better information,
note that the Slope Rating for a course of “standard playing difficulty”is 113.

If the course has three nines and all you have are the ratings for the various
combinations of those nines (A & B, A& C, B & C), Eagle’s Golf Calculator
can estimate the 9-hole ratings for you. Choose Golf Calculator from the
Golf menu or type 3G (COMMAND-G) to open the calculator. Select the
9-Hole Ratings tab:

8.00 Golf Calculator

[ Course Handicap  Quick Handicap | 9-Hole Ratings | Length Ratings }

Nines

Names Rating Slope
Ocean Nine 35.4 122
Hillside Nine 35.8 126
Marshside Nine 36.2 130

18-Hole Combinations

Rating Slope

Ocean Nine & Hillside Nine 71.2 124
Hillside Nine & Marshside Nine 72.0 128
Ocean Nine & Marshside Nine 716 126

Golf Calculator - 9-Hole Ratings


http://ncrdb.usga.org/NCRDB/
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Names — For ease of reading the results, enter the name of the 3 nines for
which you're calculating 9-hole ratings.

Rating — For each of the 18-hole combinations of the 3 nines, enter the pub-
lished Course Rating for a specific tee.

Slope — For each of the 18-hole combinations of the 3 nines, enter the pub-
lished Slope Rating for the same tee.

'The estimates you need are listed in the Rating and Slope columns of the
Nines section of the dialog. Repeat this calculation for each of the tees for
which you need 9-hole ratings.

Duplication

Whether you import player, club or other information from another appli-
cation or via the internet, you may import data for the same item more
than once. If you've imported duplicate information about a player or club,
just use Eagle to decide which of the items you wish to keep and delete the
extras.

Tees

If imported club information includes data for two tees with the same tee
color and yardage, but different pars, hole handicaps, course ratings and/or
slope ratings, Mulligan’s Eagle will try to determine if the distinction is that
the same tees are played by men and women. If so, during import, Eagle will
construct just one tee, with separate pars, hole handicaps and ratings for men
and women. If you find that this consolidation is not correct, you may have
to resolve the problem yourself by entering correct data - including another
tee, if necessary. You're discouraged from allowing two different tees to have
the same color, and prohibited from giving them the same name.

Players

Calculating Handicaps

To calculate handicaps according to a particular handicapping method or
system, you must:
* select that method for all players whose handicap will be computed
with the method (see “Handicapping” on page 53),
+ certify (for official handicapping systems) your authority to use the
selected method for those players (see discussion on page 10), and
* select that method or players using that method when calculating
handicaps (see “Calculating Handicaps” on page 144) according to
your schedule.
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Players

If you cannot select the appropriate handicap system when calculating hand-

icaps

as shown here:
[ ) Handicap Calculation
Calculate New Handicaps Schedule Handicap Calculations Remove Handicap Records
With rounds through: ‘ Wednesday, January 1, 2020] <
For: All Players
Members of = Bushwood Country Club

Ol ' handicaps

Mulligan Handicapping

@ NOTE: At least one player (Carl Spackler) selected for  Personal Handicapping Calculate
Handicap System) that s not certified for use by Ea¢  Second-Best Score System 3

Uncertified Handicapping Systems

you have not certified your use of the software for that purpose.

Failure to Calculate Handicaps

'The primary reasons for not successfully computing a handicap for one or
more players:

You have not certified your authority to calculate handicaps using the
handicap system you need. See “Authorization” on page 10.

You have not designated your handicap method of choice as the
method for computing those players’ handicaps. See “Handicapping”
on page 53.

You have indicated that a handicap shouldn't be calculated for those
players. See “Handicapping”on page 53.

You have designated the player for whom you expect a handicap as

a “guest” - for whom Eagle never calculates a handicap. See “Player
Preferences” on page 52.

Rounds you expect to be included in handicap calculations have

been designated as “ignored for handicapping.” See “Player Round
Options” on page 86.

'The entry of scores for rounds you expect to be included in handicap
calculations are not complete (there is no @ shown on the scorecard
adjacent to the player’s scores). See “Entering Scores” on page 92.

Be sure you enter a total score, scores for all the sides played, or all the
hole-by-hole scores for the round. You can enter “X” or “M” for holes
not played or not completed. When recording a 9-hole round on a
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scorecard, be sure you enter scores on the front (left) side and choose
“none” for the back side. See “Configuring a Scorecard” on page
79.

* You have not run or scheduled a handicap calculation. See
“Calculating Handicaps” on page 144.

* 'The date through which you elect to calculate handicaps precedes the
date of the rounds you expect to be included in the calculation. See
page 145.

* Your selection of players for a handicap calculation does not include
the players you expect. Be sure to choose “All Players” or the appro-
priate handicap method. See page 145.

* 'The player for whom you expect a handicap does not have enough
rounds recorded to determine a handicap. For example, if the selected
handicap method requires three 18-hole rounds to calculate a handi-
cap and fewer than 3 rounds or six 9-hole rounds have been recorded,
no handicap will be forthcoming.
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Players

Repairing Links

If information on a scorecard associated with a player’s round is “linked” to
information on file about a club or course, and that club or course is subse-
quently deleted, the round is no longer properly “linked,” and certain changes
(the tee, the course, the nines played, etc.) can’t be made on the scorecard
until the link is repaired. To repair the broken links, the club and course data
must first be restored. The link to the restored data will be made by name - if
the name found on the scorecard matches the name of a club and course on
file, the link between the scorecard and the club will be reconstructed. If you
restore club information with a name other than that found on the score-
cards, this repair facility will not restore the links. In that case, you'll need

to open each scorecard of interest and select a club from the available list of

clubs on file.

With a player’s window open and the Scores tab visible, select the rounds in
the player’s list of rounds for which links are to be restored. Open the con-
textual service menu for the list of rounds by holding down the ~ (CONTROL)
key and clicking somewhere in the list. The menu is displayed:

| Course | Tee | Score| Hep| Ne

“ountry Clubr Bushwood Golf Course [ @] a3 21 7
! — =

“ountry Club z 21 ¥i
~ountry club | # Edit Scorecards for Selected Rounds 30 37
“ountry Club | “& Match HEM 18
“ountry Club | Print Scorecards for Selected Rounds 19 7
“ountry Club | |_19 7
“ountry Club | Tournament Scorecards 4 #ET 21 7
0L E:”: | Penalty Rounds |1§ 3
“ountry Clu : = E
Country Clubl| Ignore for Handicapping | 19 -
“ountry Club . 19 7
Country Clubl| Recalculate Course Handicaps 19 -
'_““nz“' E:"': Assign Selected Rounds to Another Player ;[l) !
“ountry Clu i ;
“ountry Club Repair Links 20 ;
—ountry Club 20 £
ountry Club Delete Selected Rounds a5, 5
“nuntrv Clih Rushwnnd Colf Cnnrse a1 n

Player’s Rounds Contextual Service Menu

Choose Repair Links from this menu. The scorecards for each of the selected
rounds will be examined and any links to clubs and courses will be restored if
possible. There is no confirmation of these repairs.



Assigning Rounds to Another Player

There may be a situation in which a round is recorded incorrectly for the
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wrong player, or a player has 2 scoring records that need to be combined. If
this occurs, select the rounds in the list of rounds for the player incorrectly
assigned to them. Using the contextual menu (as described in the previous
section) choose Assign Selected Rounds to Another Player to open a sheet

to select the correct player:

Date

p
2008  Assign rounds to... (Qall Y h
1

- . | WA 3

i shwood Country Club West Bushwood, NJ 8

2008 '. Al Czervik Bushwood Country Club Mutley, NJ g
2008 5 Mary Czervik Bushwood Country Club Mutley, NJ g
2008 B Earl Havercamp Bushwood Country Club Garden City, NJ 1
2008 5 Frieda Havercamp Bushwood Country Club Garden City, NJ 9
2008 5 Agnes Smails Bushwood Country Club 9
2008 'Y Judge Smails Bushwood Country Club 9
;gg: BTy Webb Bushwood Country Club Chicago, IL ;
2008 1
2008 0
2008 ]
2008 /O
2008 y — =
2008 Bushwood Country Club (8] a0 20

Bushwood Golf Course

21 rounds on file

Reassigning Rounds

Select the player to whom the rounds are to be assigned and click the Assign

button.

Note: If the Assign Selected Rounds to Another Player menu item is dim
and unavailable, the players list or the scorecards list may be locked, prohibiting

changes (see ” on page 11).
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Printing

Pana 1 af1

Page 1of 1

Printing

If you have general printing problems, be sure the printer is plugged in, has
paper and ink or toner, and that you can print something from some applica-
tion on your computer.

Printing Margins

If report titles or page numbers seem to be cut off when printing (as shown
at the left), it may be because the Mac system does not know that your
printer has a larger print area than it has been told about, or your printer
needs to be instructed to print with narrower margins. Choosing Page
Setup in the File menu, be sure to specify the widest print area (borderless, if
available) for the proper paper size (US Letter or similar).

Scoring

9-Hole Rounds

When setting up a scorecard for entering scores you must designate the front
and back “sides” that were played. Usually, that means indicating the front
nine and back nine. When only nine holes are played, the back side should
be set to “none,” the front side set to the particular nine holes played, and

the score entered hole-by-hole or in total in the space provided for the front
side. Without configuring the scorecard for nine holes, Eagle cannot tell
when you have completed your entry of the player’s score and will not use the
round for handicapping or statistical analysis. Rounds for which scoring is
incomplete are shown in a player’s list of scores as dimmed entries.

Entering Hole-by-Hole Scores and Putts

Wohen you are entering hole-by-hole scores and putts, Eagle automatically
“tabs” to the next hole when you've entered a valid score (from 2 through

19) or number of putts (from O through 9). You can thus very quickly key
the hole-by-hole scores or putts for a round with as few as one keystroke per
hole.

Eagle is not smart enough, however, to know whether a “1” you enter for a
hole score is because the player scored a 1 (yeah!) or it is the first digit of “10”
or more. Since the latter is a bit more common, you'll have to type the TAB
key after entering a hole score of 1 to get to the next hole.

Automatic tabbing does occur, however, from both 0 (zero) and 1 when enter-
ing putts.
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Scoring Shorthand Keys

To use the scoring shorthand keys (see “Scoring Shorthand” on page 180)
while entering hole-by-hole scores or putts, type the shorthand keys (or key
combinations) before typing the hole score or putts. Shorthand keys (with
the exception of the “handicap maximum”key, which inserts a score) don’t
automatically TAB to the next hole.

For example, suppose you wrote 5, 2, F; S on your paper scorecard on the
course indicating you scored 5 with 2 putts, hit the fairway, and were in a
greenside bunker. You can, while entering your hole-by-hole scores, type
“FS5”while entering your score (or “FS2” while entering your putts) to set
the appropriate flags for keeping stats. If you didn't finish a hole, but wanted

to record a 7, you would type “X7” to enter the score.
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Special Requirements

Reference Tees

In most handicap competitions in which handicaps are adjusted for the dif-
ficulty of the tees played by the competitors, that adjustment is calculated
based on the gender-neutral determination of the lowest rated tee — players
from higher rated tees receive a handicap adjustment (usually an increase)
for the difference in the rating of the tee they play and the lowest rated tee.
When the competition includes players whose handicaps are calculated
under different handicapping systems, it may be useful to identify the partic-
ular tee, gender-specific, to be used to calculate this handicap adjustment, as
the “baseline” tee from which adjustments are calculated. These tees (poten-
tially one for each gender) are called “reference” tees.

Eagle can accommodate reference tees, when enabled in the application’s
preferences (see “” on page 19).

[ ] Event - British Four-Ball
= / - sl » =
Setup Registration Results Fast Scoring New Player Print
\& Duplicate...
n Adjustment for Course Ratings
Event Name  Bri [
S " Reference Tees E
Date Sa L <
Starting Tee | i @ Regular Tees B ap z
Club Mg - scorecard
1 & @ Ladies' Tees B |
Course  Ma L <
Sides | Fr Course Handicap adjustments for men and women based on their
7 Course Ratings from the Regular Tees and Ladies’ Tees, respectively.
Regular Tees 711126
Par [ §
Handicap | 3 il

] Limit Handicap Indexes® Limit Course Handicaps
Maximum ~) Maximum: 6 36

Limit Course Handicaps te a maximum value when computing handicap
allowances {strokes). The limit may be differant for men and women

Adjust allowances for differences in Course Ratings © Teammate Difference: 4 10/ strokes

If tzammate handicaps ditfer by more than the indicated strokes...
| Record as Tournament scores ° Reduce the higher handicap(s)
] Ignore individual scores for stats & handicapping ”) Reduce all teammates’ handicaps by 5%

| Show Registration Status & Notes

Reference Tees

If the feature is enabled, when you configure an event and check “Adjust
allowances for differences in Course Ratings”, Eagle will display a drop-
down sheet for you to specify the Reference Tees for men, women, both or
neither. Handicap adjustment calculations will be based on the course rat-
ings of the reference tees, and those adjustments for players from other tees
may increase or decrease their handicap allowance.
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NOTE - The need for automatically or manually selecting tees to serve as

the basis of adjustments to handicap allowances is disappearing. The World
Handicap System (WHS), implemented first in 2020, includes par and the
course rating of the players tees in the standard calculation of a playing handi-
cap, thus adjusting handicaps so two players, regardless of gender, who “play to
their handicap”from different tees record net scores equal to par.

Different Par from Different Tees

Eagle supports different values for par at a hole - by gender. And, as a con-
venience, if you have defined or create a second tee, it will fill in the par at
the same hole on that tee for the same gender. The result is that par on all
the holes from the men’s tees are the same, and par for ladies at each hole is
the same on every tee. But, your course may have a tee at which par at one or
more holes differs from the value entered, for the same gender, on the other
tees.

First proceed to enter par on all the tees for men and women - the standard
value. 'Then, on the tee at the hole that should have a different value, select
its par and remove it, confirming it’s removed by tabbing to the next hole.
Go back to the hole where par was just removed, click in the empty field and
enter the correct par for the hole. Continue by completely deleting the pre-
viously entered par and re-entering a new value at holes that require a special
value for par.

Different Handicap Strokes from Different Tees

Eagle supports different values for handicap stroke allocations (hole handi-
caps) at a hole - by gender. And, as a convenience, if you have defined or
create a second tee, it will fill in the handicap stroke allocation at the same
hole on that tee for the same gender. The result is that stroke allocations on
all the holes from the men’s tees are the same, and the handicap stroke allo-
cation for ladies at each hole is the same on every tee. But, your course may
have a tee at which the handicap stroke allocation at one or more holes dif-
ters from the value entered, for the same gender, on the other tees.

First proceed to enter hole handicaps on all the tees for men and women -
the standard or most common value. Then, on the tee at the hole that should
have a different value, select its stroke allocation value and remove it, con-
firming it’s removed by tabbing to the next hole. Go back to the hole where
the allocation was just removed, click in the empty field and enter the correct
handicap stroke allocation for the hole. Continue by completely deleting the
previously entered stroke allocation and re-entering a new value at holes that
require a new value for hole handicap.
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Chapter 11

Glossary

1-2-3 Best Ball
see “Cha-Cha-Cha”

A-Player

A team’s “A-player” is the teammate with the lowest handicap, regardless
of gender or the tees from which they play — the most skilled player. The
“B-player” is the second-most skilled team member, etc. The A-player typi-

cally serves as the representative or “captain’ of the team.

Many forms of team competition use handicapping methods that compute
team handicap allowances as some portion of the handicap of the A-player
and perhaps some portion of the handicaps of the other team members.

Adjusted Gross Score

A player’s Adjusted Gross Score is the player’s gross score adjusted under
their handicapping system procedures for unfinished holes, conceded strokes
and holes not played, or not played under the principles of the Rules of Golf,
or adjusted under stroke control rules. A player’s handicap is computed from
recent adjusted gross scores.

Allowance
see “Handicap Allowance”

Ambrose
see “Scramble”

American Foursomes
see “Chapman”

Banker’s System
see “Peoria”

Best-Ball

A “best-ball” competition consists of teams of 3 or more players, each playing
their own ball at every hole. There are many variations, like Waltz, Cha-
Cha-Cha, and others. A competition of the best ball of 2 players against the
best ball of 2 opponents is called “four-ball” (see page 206).
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When playing one best-ball of four, a handicap allowance of 80% of Course
Handicap for men and 90% of Course Handicap for women is recom-
mended. When playing two best-balls of four, a handicap allowance of 90%
of Course Handicap for men and 95% of Course Handicap for women is
recommended.

Best-ball scores can be determined as Stableford (page 215) or other point
systems, rather than strokes. The team score remains the better of the part-
ners’scores (in Stableford scoring, for example, the higher point score is
better).

Bramble
see “Scramble”

C-Score

Some handicapping systems allow the combination of 9-hole rounds to be
used in computing an 18-hole handicap. Rounds used for handicapping
purposes that are constructed by Combining two 9-hole rounds are labeled
with the letter “C”, thus, C-scores.

In the World Handicap System, scores for handicapping by combining
9-hole rounds are identified with the letter “N”. “C”scores in the WHS

identify rounds played in an official “organized Competition”.

Callaway System

'The Callaway (or “Official Callaway”) handicapping system was devised by
Lionel F. Callaway to compute a handicap from hole-by-hole scores of a sin-
gle 18-hole round, ignoring some number of a player’s “worst holes” based on
the player’s total gross score for the round. It is useful for computing handi-
caps for a group of unhandicapped players or for players with no playing
history on which to base a handicap. The objective of the Callaway System is
to produce net scores in a range from par to the mid-70%s. Occasionally, a net
score below par is produced.

Calculated Course Rating

A calculated course rating (CCR) is the measure of the difficulty of a golf
course from a particular set of tees under event-specific weather and playing
conditions. The rating is calculated from the scores of the contestants rela-

tive to their handicaps and the Standard Course Rating. In parts of Europe,
the rating is called a “Calculated Scratch Score” (CSS).

Canadian Foursomes
see “Greensomes”

Cart Sign
The printed card or placard affixed to a motorized golf cart identifying the
participants assigned to that cart, their tee time and starting tee. Usually
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produced in a standard 5 %" x 8 %" size. Mulligan’s Eagle can produce cart
signs for your event.

Cha-Cha-Cha

A Cha-Cha-Cha, also known as a “1-2-3 Best-Ball,” is a form of best-ball
competition for 3 or more competitors, in which the number of balls to be
scored begins with one ball on the first hole, two balls on the second hole,
three balls on the third hole, then repeats for the remainder of the round:

Cha-Cha-Cha
first hole (no. 1) 1 best ball
second hole (no. 2) 2 best balls
third hole (no. 3) 3 best balls
fourth hole (no. 4) 1 best ball
etc.

Similarly, a Cha-Cha alternates between one ball on the first hole, two balls
on the second hole, then repeating:

Cha-Cha
first hole (no. 1) 1 best ball
second hole (no. 2) 2 best balls
third hole (no. 3) 1 best ball
etc.

Chapman

'The Chapman System (also called “Pinehurst Foursomes” or “American
Foursomes”) is a competition for teams of 2 players. It is frequently played
with teams of couples. The format is named for Richard R. “Dick” Chapman
(1911 - 1978), the 1940 U. S. Amateur Champion and 1951 British Amateur
Champion, who collaborated in the 1950’s with the USGA to develop a
handicapping method for this form of play.

In a Chapman, both partners play a tee shot at every hole from their desig-
nated tee. Each player then plays their partner’s ball for the second shot. The
team selects the ball they wish to continue with and they play it alternately
until it is holed.

The USGA recommends, for Chapman stroke play, a handicap allowance of
60% of the A-Player’s Course Handicap plus 40% of the B-Player’s Course
Handicap. The Australian Golf Union recommends a handicap allowance
of 3/8 (37.5%) of the aggregate (combined) handicaps of the partners. In
Chapman match play, the team with the lower handicap allowance should
play at scratch and their opponents play with the difference between the
team handicap allowances.
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Chicago

Chicago is a form of Stableford scoring, typically used in point-quota events,
in which each player’s quota is calculated as 39 less their Course Handicap.
A team’s quota is the sum of the quotas of its members. The competition is
then conducted at scratch (without handicaps), using Chicago scoring:

Chicago Scoring
2 or more over par no points
1 over par (bogey) 1 point
par 2 points
1 under par (birdie) 4 points
2 under par (eagle) 8 points

'The competitor’s score is then determined as the difference between the
points they have earned and their quota - negative values are allowed. A team
or individual with the highest result is the winner.

Club

A club is a golf facility, like a country club or golf club which has one or
more golf courses. Regardless of how many golf courses it has, the “club”
is the whole facility. Mulligan’s Eagle refers to a golf club by its name, and

allows you to keep address and telephone information about the club.

CONGU

'The Council of National Golf Unions is an association of national governing
bodies for golf in the United Kingdom including The English Golf Union,
'The English Women’s Golf Association, The Golfing Union of Ireland, The
Irish Ladies’ Golf Union, The Scottish Golf Union, The Scottish Ladies’
Golfing Association, The Golf Union of Wales, The Royal and Ancient Golf
Club of St. Andrews, and The Ladies’ Golf Union. In 2004, CONGU estab-
lished the Unified Handicapping System (UHS) for use by members of all

its associated organizations.

Course

A course is a 9-hole or 18-hole golf course or links, with its own unique
name and characteristic sets of tees. A golf “club” might have one or more 9
and/or 18-hole golf “courses” available for play. Mulligan’s Eagle refers to a
golf course by its name (and the name of its club), and allows you to create an
appropriate scorecard for the course.

Course Handicap

A Course Handicap is the USGA’s mark for the number of handicap strokes
a player receives from a specific set of tees at the course being played to adjust
his scoring ability to a common level of scratch or 0-handicap golf.
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Course Rating

In general terms, a course rating is a numeric measure of the difficulty of
a golf course according to the governing body responsible for rating that
course. In the United States, it’s called a “USGA Course Rating™,” the
United States Golf Association’s trademark for the measure of the diffi-
culty of the course for scratch (expert) players. In other parts of the world,
the governing body may specify rating values calculated or named differ-
ently. Course Ratings for 18-hole courses are typically between 55.0 and
80.0. 9-hole Course Ratings are about half of that. The Course Rating of
an 18-hole course is the sum of the ratings of its nines. See also “Standard
Scratch Score” and “Standard Course Rating.”

Danish
'The great philosopher Basho once wrote “A flute with no holes is not a flute.
A donut with no hole is a danish.”

Devil Ball

Devil Ball (also called “Yellow Ball,” “Lone Ranger,” “Pink Ball,” “Money
Ball,”“Pink Lady,” or “Pumpkin Ball”) is a team game in which teammates
take turns playing a single ball at each hole while the rest of the team plays
another ball (Best-Ball, Scramble, etc.). The team’s score at each hole is the
total of the individually-played ball (the “Devil” ball) plus the team’s multi-
player ball.

If the team ball is determined by several players playing one ball (Scramble,
Chapman, Foursomes), the team ball is handicapped as if all of the team-
mates participated at each hole, and the allowance is applied against the total
score. If the team ball is determined from a best-ball or similar format, the
net score for the team ball should be determined by the low net score of the
teammates at each hole. The net score for the “Devil” ball is determined

by the net score of the individual at each hole, based on their handicap
allowance.

Variations include a special golf ball (pink, yellow, orange or specially
marked) that must be shared by the individual players at each hole or a pen-
alty for losing (or a bonus for not losing) the original “devil” ball is imposed.

Differential

A differential is the difference between a player’s score and some standard
measurement of course difficulty. The determination of a differential may
vary in different handicapping systems. See also “Handicap Differential”

Eclectic
see “Ringer”

European Golf Association
'The European Golf Association (EGA) is the governing body for golf in
Europe, except the United Kingdom (see CONGU). The EGA publishes
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the EGA Handicap System, a golf handicapping system used by authorized
golf clubs and golf associations to compute an Exact Handicap and playing
handicap for each of their members.

Equitable Stroke Control (ESC)

Equitable Stroke Control was the USGA’s mark for their method used to
limit changes to handicaps based on unusually high individual hole scores.
ESC set a maximum number that a player can post for handicapping on
any hole based on the player’s Course Handicap. See also “Adjusted Gross
Score”.

'The World Handicap System adjusts hole scores recorded for handicapping
to be limited to net double-bogey.

Four-Ball

Four-Ball consists of two competitors playing as partners, each playing their
own ball. The lower of the partners’scores (gross or net) is the team’s score
for the hole. In medal (stroke) play form, the team’s total score is the total
of their better-ball scores at each hole. In match play, which is where “four-
ball” gets its name, the winner of the hole is the team whose better ball is less
than the better ball of the opponents. Four-Ball is well known as one form
of competition played in the Ryder Cup. When teams consist of 3 or more

players, the competition is usually called a “Best-Ball,” and may have many
variations, like Waltz, Cha-Cha-Cha, and others.

In stroke play, a handicap allowance of 90% of their Course Handicap for
men, and 95% of their Course Handicap for women is recommended. In
addition, the USGA recommends that the Course Handicaps of partners
not differ by more than 8 strokes, and a competitor’s Course Handicap be
reduced to 8 strokes greater than their lower-handicapped partner. If that is
not feasible, the Course Handicaps of both team members should be reduced
an additional 10%. In match play, the USGA recommends that the Course
Handicap of all four players be reduced by the Course Handicap of the
A-Player, who then plays from scratch. The other players are allowed 100%
of the difference.

Four-Ball scores can be based on Stableford (page 215) or other point sys-
tems, rather than strokes. The team score remains the better of the partners’
scores (in Stableford scoring, for example, the higher point score is better).
In combined gross and net events, a player’s score at a hole may serve as both
the better gross score for the team and the better net score for the team. In
some forms of play (see The Ritz), the better gross and better net score must
be from different players. In four-ball net events, the conditions of the com-
petition should require that the gross scores of both partners be recorded to
identify the source of a team’s net score. Generally, a team whose net score
for a hole cannot be clearly determined from the partners’ gross scores is

disqualified.
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Foursomes

Foursomes is one of the oldest forms of team golf, consisting of two play-
ers as partners alternately playing a single ball. Foursomes can be played in
medal (stroke) play form, where it is commonly called “Alternate Shot” or
“Scotch Twosomes,” but is more commonly played as match play between
two teams (hence the name “foursomes”). Foursomes is well known as

one form of competition played in the Ryder Cup. For foursomes with
selected drive or “Canadian Foursomes,” see “Greensomes”. For “Pinehurst
Foursomes” or “American Foursomes,” see “Chapman’”.

The USGA recommends, for stroke play, a handicap allowance of 50% of the
total Course Handicaps of the partners (ie: the average of their handicaps).
In match play, the team with the lower handicap allowance should play at
scratch and their opponents play with the difference between the team hand-
icap allowances.

Foursomes with selected drive
see “Greensomes”

GHIN
Golf Handicap and Information Network — a service of the USGA used
by authorized golf clubs and associations to periodically calculate USGA

Handicap Indexes, provide for online posting of scores and search.

Golf Australia

Golf Australia is the governing body for golf in Australia. Originally
tfounded as the Australian Golf Union (AGU), Golf Australia specifies and
publishes the Australian Handicap System, which allows Australian golf
clubs and associations to produce Exact Handicaps and playing handicaps
for their members. Golf Australia also maintains a nation-wide computer-
ized handicap system called GOLFLink, which allows scores to be posted

and retrieved at golf clubs across Australia.

Golf Canada

Golf Canada — an association governed by the Royal Canadian Golf
Association (RCGA) — is the governing body of golf in Canada, responsible
for promoting participation in and a passion for the game of golf in Canada.
Golf Canada actively conducts championships, programs and services
throughout the country, and as the authority for golf in Canada, administers
the Rules of Golf, amateur status, handicapping and course rating under the

RCGA brand.

Green-in-Regulation
A player has a green-in-regulation when he reaches the putting surface in
the regulation strokes (par less 2 strokes) or less.
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Greensomes

Greensomes (also called “Foursomes with selected drive,” or “Canadian
Foursomes”) is a variation of foursomes in which a team of two players play a
single ball alternately after selecting a preferred tee shot of the team.

Both partners play a tee shot at each hole from their designated tee, then the
team selects a single ball to continue, and the partner of the player whose ball

is chosen plays the next shot. The partners then alternate playing that single
ball until it is holed.

The USGA recommends, for stroke play, a handicap allowance of 40% of
the total Course Handicaps of the partners (ie: 80% of the average of their
handicaps). CONGU recommends a handicap allowance of 60% of the
A-player’s handicap plus 40% of the B-player’s handicap. In match play, the
team with the lower handicap allowance should play at scratch and their
opponents play with the difference between the team handicap allowances.

Gross Score
A player’s gross score is the unadjusted number of total strokes, including
penalty strokes, taken on a hole or during a round.

Handicap (hole)

'The handicap of a golf hole, or “handicap stroke allocation,”is a number
assigned to a hole reflecting its relative difficulty (1 being most difficult, 18
being least difficult) or the scoring differential between low and high handi-
capped players (1 being the largest differential, 18 being the smallest). Hole
handicaps are used to determine at which holes players receive strokes in a
handicap competition.

Handicap (your)

see “Course Handicap”

Handicap Allowance

A “handicap allowance” is the percentage of the Course Handicap recom-
mended for a handicap competition. Allowances vary for different forms of
competition and are designed to produce equitable competition.

Handicap Differential

A Handicap Differential is the difference between a player’s adjusted gross
score and the Course Rating of the course on which the score was made. less
any PCC (playing condition calculation), multiplied by 113, then divided

by the Slope Rating from the tees played and rounded to the nearest tenth.
Handicap Differentials are expressed as a number of strokes rounded to one
decimal place. They are used to calculate a Handicap Index.

International
'The International system, a form of Stableford scoring, was introduced into
common use in 1986 at the PGA Tour’s “The INTERNATIONAL” at Castle
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Pines Golf Club in Colorado. The system uses points for scoring with a
bonus for sub-par play. Points are awarded based on the player’s score at

each hole:
International Scoring

2 or more over par -3 points

1 over par (bogey) -1 point

par no points

1 under par (birdie) 2 points

2 under par (eagle) 5 points

3 under par 8 points

A player’s competition score is the sum of their International points awarded
at each hole. The result may be negative. For amateur competition using the
International scoring system, handicap allowances are typically full handi-
cap, but may be adjusted for mixed competitions or play from different tees
(which might have different pars).

Irish Four-Ball

An Irish Four-Ball is a form of best-ball competition for 4 competitors, in
which the number of balls to be scored increases from 1 best-ball of the team
to every ball of the team:

Irish Four-Ball
holes 1 -6 1 best ball
holes 7 -11 2 best balls
holes 12 - 15 3 best balls
holes 16 - 18 4 balls

'The Irish Four-Ball is almost always scored as a Stableford (and is frequently
called an “Irish Stableford”) and can be handicapped in any fashion typically
used for four-ball or Stableford competition.

Junior Par

Junior par is an adjustment to par under the USGA Handicap System for
junior golfers of various ability levels. Junior par provides a realistic stan-
dard against which a junior can measure improvement in his (or her) game
until he (or she) is capable of measuring his (or her) game against par. Junior
par is calculated based on hole yardages for golfers of different skill levels for
both boys and girls.



210

Net Score
A net score is a player’s score after his handicap strokes have been subtracted
from his gross score. A plus handicap player adds his handicap strokes to his

gross score to determine his net score.

Nine

A nine is 9 related golf holes. An 18-hole golf course usually has two “nines.”
A 9-hole golf course usually has one nine. Nines sometimes have names, but,
if not, we give them names like “Front Nine” or “Back Nine.”

9-Point Game

The 9-Point game is a betting game for 3 players which can be contested
with net or gross scores. At every hole, 9 points are available and a player
earns points based on their standing vs. the opponents:

9-Point Game Scoring
1st place 5 points
2nd place 3 points
3rd (last) place 1 point

Ties are shared at each hole. Thus, 2 players who tie for the low score earn
half of the total 1st and 2nd place points (4 points each). Or, if all the com-
petitors tie, each earns 3 points. There are 162 (9 x 18 holes) points available
to the 3 players in an 18-hole game. Each player’s points are totaled at the
end of the round, and payoft determined by the value of each point and the
difference between the points of the players.

Penalty Round

Some handicapping systems allow for posting of a penalty score for a player
who fails to return a score or for other reasons. The USGA recommends,

if player fails to post their score in a timely manner, that the Handicap
Committee post a penalty score equivalent to the lowest differential in the
player’s scoring record. Eagle identifies penalty rounds on their scorecards
and may report penalty rounds in handicapping reports.

Peoria

'The Peoria System, also called the “Banker’s System,” computes a handicap
for a single 18-hole round based on the scores of six holes, selected secretly
by the tournament committee. Following play, each player’s handicap is cal-
culated and their net score for the event is determined. The Peoria System is
commonly used to compute handicaps for a group of unhandicapped players
or for players with no playing history on which to base a handicap.

In a Peoria competition, two par-3, two par-4 and two par-5 holes are
selected at random or from each nine. For calculating the handicap, the
players scores on the selected holes are limited to double par (6, 8 or 10). The
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handicap is calculated as the limited total of the selected holes times 3, less
par for the entire round, multiplied by 0.8 and rounded.

In a Modified Peoria, one par-3, one par-5 and four par-4 holes - two from
each nine are selected. For calculating the handicap, the scores on the
selected holes are limited to three over par on the par-3 and par-4 holes (6 or
7), four over par on the par-5 hole (9). The handicap is calculated as the lim-
ited total of the selected holes, less par on those holes, multiplied by 2.8 and
rounded.

Pinehurst Foursomes
see “Chapman”

Player
A player is a golfer — someone for whom you'll use Mulligan’s Eagle to keep
track of scores and statistics — like you and your club members.

Playing Conditions Calculation (PCC)

'The playing conditions calculation determines whether playing conditions on
the day of play differed from normal conditions of play. It is a daily statistical
procedure to compare submitted scores on a day to expected scoring patterns.

Playing Handicap

A playing handicap is the general term for the number of strokes a player
receives based on his official handicap, the difficulty of the tees he plays,
and the handicapping system under which his handicap is computed. In
the United States, a player whose handicap is computed under the USGA
Handicap System has a playing handicap called a Course Handicap.

Point-Quota

A Point-Quota competition is an event for individual golfers or teams in
which some form of Stableford scoring is used to reflect the competitor’s
performance relative to their established handicap. Prior to play, a player’s
(or team’s) “quota”is established. Each player’s quota is computed as 36 (39
in a Chicago event) less their handicap (with a minimum quota of zero or
some other agreed value). A team’s quota is the sum of the quotas of its
members. The competition is then conducted at scratch (without handicaps),
using Stableford, Modified Stableford or Chicago scoring.

'The player’s competition score is determined as the difference between the
points they have earned and their quota — negative values are allowed. A
team or individual with the highest numerical result is the winner.

Multi-round Point-Quota competitions for amateurs frequently have quota
“adjustments” after each round. A common adjustment is to raise a team’s
quota for the next round by half of the amount by which they exceeded their
quota in their previous round (or conversely, reduce their quota by half the
amount by which they failed to meet their quota). Fractional quotas, bigger
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or smaller adjustments, and upper or lower quota limits are common varia-
tions in Point-Quota events.

Press

A press is a wager or bet made at some point in a match that begins as an
even match at the point of the press and has the same value as the match

or bet that was “pressed.” So, if a player decides to press when 2 down in a
match after the 2nd hole, an additional bet or match begins at the 3rd hole
with the competitors all square. Should the competitor who pressed win the
3rd hole, he is 1 down on the original bet, and 1 up on the press. The pur-
pose of a press is to allow a player to “get even” by winning the press bet. The
risk, of course, is also losing the new bet.

Traditionally, a competitor may only “press” when they are down in a match.
Other conditions may require the competitor to be 2 down, or 1 down with
just one hole to play, or allow the opponent to decline the press. Generally, a
match or bet can only be pressed once, although a press bet itself can also be
pressed. Mulligan’s Eagle wi// allow multiple manual presses of a bet unless
it is prohibited in the application’s preferences.

R&A

'The Royal & Ancient Golf Club (the “R&A”) is the governing body for golf
in the United Kingdom and elsewhere in the world. The R&A publishes,
in conjunction with the USGA, the The Rules of Handicapping, based on
the World Handicap System used under license by authorized golf clubs and

golf associations to compute a Handicap Index® for their members.

RCGA

'The Royal Canadian Golf Association (“RCGA”) or Association Royale de
Golf du Canada is the governing body for golf in Canada. The RCGA pub-
lishes the RCGA Handicap System, a golf handicapping system used, under
license, by authorized golf clubs and provincial golf associations to compute a
Handicap Factor® for their members.

The RCGA is also the provider of RCGA Network, Canada’s national,
centralized web-enabled handicap and communication network service for
RCGA members and member clubs.

Ringer

A ringer round (also known as an “eclectic” score) is a scorecard that records
the best score previously recorded by a player on each hole of a course.
Mulligan’s Eagle can determine a ringer round for all recorded rounds on a
particular course, rounds between two dates or rounds from a particular tee.

The Ritz

'The Ritz is a form of best-ball competition for 2 or more competitors,

in which both a gross and net score are returned for each hole, but the
scores cannot be from the same ball. First, the gross score for the team is
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determined as the best gross result of a teammate on the hole. Second, the
team’s net score for the hole is determined as the best net result of another
teammate. If two or more teammates tie for the lowest gross result, the team
will use the score from the player with a higher net result, preserving the
best possible net score for the team. The “Ritz in Reverse”is the same game,
except at each hole the best net result is determined before the best gross
result.

Round

A round is what you play when you play golf. Your “round” might be 18
holes or it might be a 9-hole “round.” When you play more than 18 holes
(i.e.: more than two “sides”), you're playing more than one round.

Sand Save

A “sand save” is the successful completion of a “sand try” - an opportunity to
make par from a greenside bunker. If the player hits a greenside bunker with
the opportunity to make par (indicated while entering scores), then scores
par or better, they have a sand save.

Scheid System

'The Scheid System computes a handicap based on the hole-by-hole scores
of a single 18-hole round. It is useful for computing handicaps for a group
of unhandicapped players or for players with no playing history on which
to base a handicap. The Scheid System produces approximately equal net
scores.

Scorecard

A scorecard is where you enter and keep information about a round of golf.
Your golf club has a scorecard for its golf courses and information on that
card is used by Mulligan’s Eagle on its scorecards to provide handicapping,
scoring and analysis of your play.

Scramble

A Scramble (also called an “Ambrose,” “Bramble,” “Florida Scramble,” “Texas
Scramble” or “Ft. Lauderdale”) is a team competition for teams of 2 or more
players. It is commonly played in golf events with participants of widely
varying skill levels. Typically, the most skilled team member, the A-player, is
designated as the team’s captain.

Every team member plays a tee shot at each hole from their designated tee.
The team or its captain selects the best result and that stroke is added to the
team score. Each player on the team plays a shot from the location of the
selected ball. The process is repeated until a ball is holed.
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Common methods of determining team handicaps for a Scramble include:

Scramble Handicapping Variations

A-B-C-D teams No handicap. Teams play scratch.

Teams of any size 50% of A-Player’s handicap, or
50% of the teammates’ average
handicap, or

Zig-Zag (see page 218)

Teams of 2 or more players 35% of A-Player’s handicap, plus
15% of B-Players’s handicap
Teams of 3 or more players 25% of A-Player’s handicap, plus

15% of B-Player’s handicap, plus
10% of C-Player’s handicap

Teams of 4 or more players 20% of A-Player’s handicap, plus
15% of B-Player’s handicap, plus
10% of C-Player’s handicap, plus
5% of D-Player’s handicap

For large events, the requirement to break ties can be reduced by computing
the team handicap allowances to a tenth of a stroke.

“Step-Back” or “Elimination” Scramble — The team member whose shot is
selected may not play from that location, but resumes play with the next
selected shot.

“Las Vegas” Scramble — A die, rolled after all the tee shots at each hole, indi-
cates either the number of the player whose drive is to be used (ie: 1,2, 3, 4)
or that the team may select the drive (5 or 6).

“Hit & Giggle” Scramble — Large mixed teams (6-somes, 8-somes or larger)
in which men and women play from alternate tees, and play the selected ball
alternately. For example, after the men all play from the tee, the women all

play from the location of the selected ball, then the men, etc., until a ball is
holed.

Second-Best Score System

The Second-Best Score system is a method of handicapping players who
play infrequently, or have recorded few scores from which to determine a
handicap. It bases a player’s handicap on a formula which uses the player’s
second-best reported score.

Side

A side is the particular nine from a particular tee that you play during a
round of golf. “The Front Side”is meaningful only if you know what tee is
being played.
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6-Point Game

'The 6-Point game is a betting game for 3 players which can be contested
with net or gross scores. At every hole, 6 points are available and a player
earns points based on their standing vs. the opponents:

6-Point Game Scoring
1st place 4 points
2nd place 2 points
3rd (last) place no points

Ties are shared at each hole. Thus, 2 players who tie for the low score earn
half of the total 1st and 2nd place points (3 points each). Or, if all the com-
petitors tie, each earns 2 points. There are 108 (6 x 18 holes) points available
to the 3 players in an 18-hole game. Each player’s points are totaled at the
end of the round, and payoft determined by the value of each point and the
difference between the points of the players

Skins

Skins is a multi-player game in which the winner of a hole is the player who
has the lowest score on the hole and is untied. If the low score is tied, there
is no winner on that hole. Skins might be computed between a few players
on a scorecard, or between all the players in a large tournament. Eagle can
determine skins in both circumstances.

Slope Rating

A Slope Rating is the USGA’s mark for the measure of the relative difficulty
of a course for players who are not scratch golfers. Slope ratings range from
55 through 155 for 18-hole or 9-hole courses. A golf course of standard
playing difficulty has a Slope Rating of 113. The Slope Rating of an 18-hole

course is the average of the ratings of its nines.

Stableford

'The Stableford system of scoring was introduced by Dr. Frank Stableford, of
Liverpool, England, in 1932. 'The system uses points for scoring rounds or
competitions. The player’s score at each hole is determined, gross or net, and
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points are awarded based on that score compared to a target score - usually
par:

Stableford Scoring
2 or more over par no points
1 over par (bogey) 1 point
par 2 points
1 under par (birdie) 3 points
2 under par (eagle) 4 points
3 under par 5 points
etc.

Modified Stableford Scoring

2 or more over par no points
1 over par (bogey) 1 point
par 2 points
1 under par (birdie) 4 points
2 under par (eagle) 6 points
3 under par 8 points
etc.
Half-Stableford Scoring
1 or more over par no points
par 1 point
1 under par (birdie) 2 points
2 under par (eagle) 3 points
3 under par 4 points
etc.

A player’s competition score is the sum of their Stableford points awarded
at each hole. Handicap allowances for Stableford scoring are typically full
handicap, but may be adjusted for mixed competitions or play from different
tees (which might have different pars). In match play, handicap allowances
are usually reduced by the handicap of the lowest handicapped competitor,
who plays at scratch.

Standard Course Rating

A standard course rating (SCR) is a measure of the difficulty of a golf course
from a particular set of tees under normal weather and playing conditions.
See also “Course Rating” and “Standard Scratch Score.”
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Standard Scratch Score

A standard scratch score (SSS) is a measure of the difficulty of a golf course
from a particular set of tees under normal weather and playing conditions for
an expert (scratch) player. See also “Course Rating” and “Standard Course
Rating.”

Stroke Allocation
see “Handicap (hole)”

System 36

System 36 is a method of computing a one-round handicap for events in
which un-handicapped players participate. The player’s handicap allowance
is derived from “points” which are earned by adding 1 point for every bogey,
plus 2 points for every par. The player’s handicap allowance, used to compute
his net score, is 36 less his points.

T-Score

Some handicapping systems require special computations for rounds played
in a tournament (see Tournament Score). These rounds are usually labeled
with the letter “T”, thus, T-scores.

Tee

Most golf courses have several different teeing areas or “tees” from which dif-
ferent categories of golfers play during a round of golf. Tees frequently have
names based on who plays from them, like “Ladies’ Tees” or “Championship
Tees.” If they don't, they are almost always known by the color of the tee
markers used to identify them, like blue, white or red. Mulligan’s Eagle iden-
tifies a tee by both its name and its color.

Tournament Score

In the USGA and RCGA Handicap Systems, “A tournament score is a score
made in a competition organized and conducted by a committee in charge of
the competition. The competition must identify a winner(s) based on a stip-
ulated round(s), and should be played under the Rules of Golf.” Regardless
of how the player is handicapped, Mulligan’s Eagle allows you to identify

rounds as tournament scores.

Up-and-Down
An “up-and-down” is the name for holing out at a hole in two strokes from a
greenside bunker or anywhere off the green, usually with 1 putt.

USGA

'The United States Golf Association (the “USGA”) is the governing body for
golf in the United States and elsewhere in the world. The USGA, in con-
junction with the R&A, publishes the The Rules of Handicapping, based on
the World Handicap System used under license by authorized golf clubs and

golf associations to compute a Handicap Index® for their members.
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Waltz
A Waltz is a form of best-ball competition for 3 or more competitors, in
which the number of balls to be scored is based on par:

Waltz
par-5 holes 1 best ball
par-4 holes 2 best balls
par-3 holes 3 best balls

A Modified Waltz is sometimes used for 3-person teams or high handicap
players:

Modified Waltz
par-5 holes 1 best ball
par-4 holes 2 best balls
par-3 holes 2 best balls

World Handicap System

A world-wide unified golf handicapping system, the WHS was implemented
in 2020 as a standard method of calculating handicaps for players and teams
around the world. Supported by most of the major golf handicapping
authorities, like the USGA, European Golf Association, CONGU and oth-
ers. The WHS purports to preserve the best features of each existing system.

Zig-Zag

Zig-Zag handicapping is a method of calculating a handicap in a Scramble
or other team event. It generates net results of a somewhat random nature,
with almost all results under par.

'The tournament committee secretly selects 3 holes at random during or after
the competition to be used in the calculation, and a team allowance is calcu-
lated as a percentage of the team’s score on those 3 holes, based on their total
gross score:

Total Gross Score Percentage
59 or lower 30%
60 - 64 70%
65 - 69 90%
70 or higher 120%

The team’s net score is their total gross score less the percentage of their total
on the 3 selected holes.
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